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ABOUT OCTET SYSTEMS

Octet systems enable real-time quantitation or kinetic characterization of biomolecular
interactions. Each system includes:

+ Octetinstrument

«  Computer

« Hardware accessories

«  Octet software modules—Data Acquisition and Data Analysis

For more details on the Data Acquisition software, see the Octet System Data Acquisition
User Guide.

Table 1-1: Octet System Software Functions

Octet Software Functions

Data Acquisition  « Define quantitation or kinetic experiments and save them for

future use.

« Define custom assays.
« Run experiments and acquire binding data.

« View and save binding data.

Data Analysis « Analyze binding data and view analysis results.
+ Export or copy analysis results.

« Generate reports of quantitation or kinetic results.

For information on preparing samples for quantitation or kinetics experiments, please see
the appropriate ForteBio biosensor product instructions.

Octet System Data Analysis User Guide
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WHAT'S NEW IN OCTET DATA ANALYSIS SOFTWARE, RELEASE 9.0

1. Our New Data Analysis HT 9.0 software is now available as part of the Octet Analysis
software suite, and installs with Octet System Data Analysis software. You can use it for
advanced epitope binning analysis on multiple plates, multiple sensor trays and multi-
ple experiments.

2. Support for the Octet K2 system.

3. The new Mask Data feature lets you make a copy of your data folder with all proprietary
info such as sample ID, sample info, sensor type and sensor info hidden, or ‘masked; in
both the .fmf and .frd files. For more information, see page 75 for quantitative analysis
or page 145 for kinetics analysis.

NOTE: The Mask Data feature is not available in Octet Data Analysis 21 CFR
Part 11 software.

4. You can now assign % Kp1 and Kp2 contributions to interactions in the 2:1 (HL) model
for kinetic analysis curve fitting (see page 116).

5. The Order Columns dialog is now available again in the Data Table on the Results Tab
for quantitative analysis (see page page 62).

6. Values in data tables can now be edited directly by clicking on a table cell and typing
into the cell. See page 42 for quantitative analysis or page 87 for kinetics analysis.

7. For kinetic experiments, all reference wells and sensors assigned in the Octet Data
Acquisition Software now also display as reference wells and sensors in the Octet Data
Analysis Software. They no longer need to be reassigned.

WHAT'S NEW IN OCTET DATA ANALYSIS SOFTWARE, RELEASE 8.2

NOTE: The new features listed below are applicable to version 8.2 of Octet
Data Analysis 21 CFR Part 11 software only.

1. Now whenever a raw data or results report is exported, the contents of the xIs file are
locked and cannot be changed.

2. New Audit Trail options:

+ The Audit Trail now includes the option to display experiment-specific events in
addition to the existing project- and machine-specific events (see page 32). To
view audit logs for a specific experiment, click on the Experiment drop-down
list and select an entry:

Octet System Data Analysis User Guide
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ol Audit Trail [E=EER™
‘ Project: [ (al) ~| Experiment: [(al) ] Machine: [WIN-S3NNJUKME. ~
(all

Date/Time Machine Project Type Aplate 1 on REDSE CFR L

9/25/2014 10:11:4D AM WIN-53NN... Open Sion off on QKe CFR . n RED36 CFR

9/25/2014 10:11:39 AM WIN-G3NN... Close experiment  C:\TestData\Octet\SA on off on QKe CFR

9/25/2014 10:11:38 AM WIN-G3NN... Open experiment  C:\TestData\Octet\SA on off on QKe CFR

9/25/2014 10:11:35 AM WIN-G3NN... Userlogin tae

Figure 1-1: Selecting an Experiment in the Audit Trail

+ You can now print the Audit Trail (see page 33).

« All actions related to data analysis, processing and inclusion or exclusion of data
are now also logged in the Audit Trail.

3. Thefile extension for the data analysis settings file, Settings_DataAnalysis.ini, was
changed from .ini to .fsd. The full file name will now be Settings_DataAnalysis.fsd.

4. Electronic signatures are now also added to the data analysis settings file,
Settings_DataAnalysis.fsd, and non-CFR standards data (.fsc) files (see page 28).

5. Changes made to data analysis settings are now logged in a Settings Change History
which is archived within the experiment folder (see page page 30).

6. Exported raw data and results reports now include the software name, version and
export date and time on the Summary tab of the report.

For Software Administrators:

7. Octet Data Acquisition 21 CFR 11 software version 8.2 requires version 8.2 of the GxP
Server module. Administrators should also install this with version 8.2 software.

8. Octet Data Acquisition 21 CFR 11 software version 8.2 uses a new database schema
which is automatically installed and configured during software installation.

of the existing database before installing and upgrading to GxP
FBServer Module v8.2. Please see page 182 for instructions.

0 IMPORTANT: It is strongly recommended that you make a backup copy

9. The same GxP Server module can now be used both for Octet and BLItz® systems. This
is available for GxP Server module versions 8.2 and higher only, which will now also log
events in BLItz Pro software for BLItz instruments.

10. New Event Log options (see page 204):

+ Machine names logged will also include BLItz instrument names when these
instruments use the same GxP Server module as other Octet instruments. This is
available when using GxP Server module version 8.2 and higher only.

Octet System Data Analysis User Guide
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+ A new Software field is available that displays which software the event was
logged in. This is available for GxP Server module version 8.2 and higher only,
and includes logging of Octet Data Acquisition, Octet Data Analysis and BLItz
Pro software events.

i h
1%/ ForteBio GxP Server Configuration - 8.2.0.1 [
Connection to dients:
e [T Localhost Port: 20002 5 foplyfiest

Support UDP ping for discovery Default

| Users I Groups I Projects I Constants | Events |

User: [(any} v] Project: [(any} v] Machine: [(any} v]

Date/Time Login Mame Project Machine Software Type Info
2014/09/25 10:11:35 tae WIN-S3NMIUKMEIN  Octet Analysis  User login tae
2014/09/25 10:11:38 tae WIN-S3NMIUKMEIN  Octet Analysis  Open experiment  C:iTestD!
2014/09/25 10:11:39 tae WIN-S3NMIUKMEIN  Octet Analysis  Close experiment  C:iTestD!

2014/09/25 10:11:40 tae WIN-53NNIJUKMEIN ~ Octet Analysis

Figure 1-2: Events Tab

WHAT'S NEW IN OCTET SYSTEM DATA ANALYSIS SOFTWARE,
RELEASE 8.1

1. Octet System Data Analysis software version 8.1 and higher are now compatible with
64-bit versions of Windows 7.

2. The new High Precision Streptavidin (SAX) Biosensor is available in the Sensor Type list
for both quantitation and kinetics.

3. Cursors in the Analysis tab (Tab 3). You can now move two cursors (1 and 2) anywhere
along the x-axis to get the time (in seconds) and nm response on the y-axis.

View — Y fods Scaling Report Points
® Stacked ® Gop e @ AuoScale | Timefesc); 100 Addto Table Save
> Individual iy ey Refresh © Full Seale Use 20 | Point Average
Fitting View 485.354, 0.657
F
e
————s frm0:208
T T T T T T T T
100 200 300 400 500 00 ™ B 900 1000 1100 1200
Time (s)

+ Each cursor can be dragged along the x-axis by clicking on the arrow next to the
cursor number (1 or 2) and then dragging it to the desired x-axis location.

Octet System Data Analysis User Guide
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View 7 Y fis Scalng Report Fairts
@ Stacked i B @ Auto Scale  Time (sec) 100 Addto Table Save
© Individual Options Rsfresh Refresh © Full Scale Use 20 Point Average
Fitting View

=0.308

T T T T T T T T T
100 200 300 400 500 600 700 80 500 1000 1100 1200

+  You can also add the time and response data from the cursors to the data table.
To do this, right click on the graph and select Add Report Point at Cursor #.

View - ¥ s Scaling Report Foirls
© Stacksd Bitnp iy © AuoScde  Timesec) 100 Addto Table Save
% Individual ity i Fefresh © Full Seale Use 20 Point Average
Fitting View 371.963, 1.061
& 2
\Q Zoom In (CTRL+Click)
s Zoom Out (z)
~ g
= Graph Options ..
Show Cursors
h-——‘—.._,—m_
'| Hide Cursors s
'=0.316
Bring Cursors Into View — w
‘| Add Report Point at Cursor 1
T T T T T T T
100 200 300 | Add Report Point at Cursor 2 700 200 900 1000 1100 1200

WHAT'S NEW IN OCTET SYSTEM DATA ANALYSIS SOFTWARE,
RELEASE 8.0

The following features are new for the Octet System Data Analysis software, Release 8.0:

1. The Sample plate and the Reagent plate are now referred to as “Plate 1” and “Plate 2" in
the software.

2. Support for the Octet HTX system. See “What you should know about the New Octet
HTX System” on page 212 for more details on our newest system.

3. Data analysis options for the Octet HTX system:

a. Kinetics analysis is the same on the Octet HTX system as it is on other Octet systems.
See “Basic Kinetics Analysis” on page 79 for more information.

b. Quantitative analysis is the same on the Octet HTX system as it is on other Octet sys-
tems. See “Quantitative Analysis” on page 37 for more information.

¢. For Multi-Step Advanced Quantitation experiments, see page 75.
d. For Epitope Binning experiments, see page 153.

4. New data analysis options for Octet RED96, RED384, QK384 and QK€ systems:
a. Multi-Step Advanced Quantitation experiments on page 75.

b. Epitope Binning experiments on page 153.

Octet System Data Analysis User Guide
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CONVENTIONS AND SYMBOLS USED IN THIS GUIDE

@ NOTE: Presents pertinent details on a topic. For example, general information,
tips or alternate options.

o IMPORTANT: Indicates the assay or procedure will not work if the guidelines
provided are not properly followed.

o WARNING: Informs the user that specific actions could cause irreversible con-
sequences or damage.

Table 3: Octet Instrument Labels

Symbol Definition

./_\ Electrical hazard
/{ E\ Heat/hot

= e

Octet System Data Analysis User Guide
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PALL FORTEBIO TECHNICAL SUPPORT

You can contact Pall ForteBio technical support at:

Pall ForteBio LLC

1360 Willow Road, Suite 201

Menlo Park, CA 94025

USA

Tel: +1-650-322-1360

Fax: +1-650-322-1370

E-mail: fortebio_support@pall.com

Octet System Data Analysis User Guide
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LAUNCHING THE OCTET SYSTEM DATA ANALYSIS SOFTWARE

a NOTE: The installation shall be performed by Pall ForteBio LLC personnel only.

WARNING: Ifthe Octet system is not used as specified, injury to the user and/or
damage to the instrument may result.

nect the power.

NOTE: For information about how to connect the Octet instrument to the

e NOTE: Do not position the Octet instrument such that it is difficult to discon-
s computer, refer to the insert sheet that is provided with the Octet instrument.

To launch the system and the Octet Data Analysis software:

1. Turn the Octet instrument on using the power switch located on the external electrical
box.

@ NOTE: The instrument requires a minimum of one-hour warm-up time. It is
recommended that you leave the instrument on for a minimum of eight hours
prior to use.

2. Launch the Data Analysis software by double-clicking the Data Analysis desktop icon.

a NOTE: When using the CFR 11 version of the Octet System Data Analysis soft-
ware, you are required to log in and start a user session before the software
launches. For more information, refer to “Starting a User Session” on page 25.

Launching the Octet System Data Analysis software application displays the main
screen (Figure 2-1).

Octet System Data Analsyis User Guide
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Main Menu

. ForteBio Data Analysig 7.0 = | B |

File  Security@-Hetd
Data Selection

Bl Loaded Data
B Kinetics
-2 Quantitation

-l Desktop

Figure 2-1: Main Screen for Data Analysis

Main Menu

The main menu is located in the upper left corner of the main screen (Figure 2-1). Menu
options are described in this section.

Figure 2-1 displays the non-21 CFR Part 11 main menu; Figure 2-2 displays the main menu
forthe 21 CFR Part 11.

| File  Security Help

Figure 2-2: Main Menu—21 CFR Part 11 Version of the Data Analysis Software

Octet System Data Analsyis User Guide
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File Menu

The File menu (Figure 2-3) allows users to open and save re-analyze, work with experiments
in different modes, save reports, and set port options.

File | Security Help

Load a Folder ...
Quantitation Batch Mode ...
Kinetics Batch Mode ...

Save Report ...

Options ...

Exit

Figure 2-3: File Menu

Table 2-1: File Menu Commands

Menu Command Function

Load a Folder Loads an experiment method file (.frd).

Quantitation Batch Opens the Quantitation Batch Mode dialog

Mode box.

Kinetics Batch Mode Opens the Kinetics Batch Mode dialog box.

Save Report Saves all open report files.

Options Allows you to determine the port automa-
tion options:

«  TCP-IP with a localhost option
+ Serial (RS-232)

Exit Closes the application after prompting to
save any changes.

NOTE: When using the 21 CFR Part 11 version of the Octet System Data Analy-

e sis software, only 21 CFR Part 11-compliant experiments and re-analyze gen-
erated using the 21 CFR Part 11 version of the software can be opened. Files
generated using the non-compliant version of the software or with a non-
compliant system cannot be opened, and a message indicating this will be
presented.

Octet System Data Analsyis User Guide
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Security Menu

The Security menu is only available in the 21 CFR Part 11 version of the Octet System Data
Analysis software.

NOTE: The Security menu is only available in the CFR 11 version of the Octet
System Data Analysis software. For complete details on menu options, refer to
“Compliance Features” on page 27.

Security | Help

Verify Document ...
View Audit Trail

Change Password ...
Change Project 3

Server Administration

Lock Application ...
Log Off ...

Figure 2-4: Security Menu

Table 2-2: Security Menu Commands

Menu Command Function

Verify Document Utility that tests if a method (.fmf) or data
(.frd) file was created using a CFR version of
the ForteBio software.

View Audit Trail Displays the recorded events for CFR docu-
mentation. Events may be viewed by project
or machine.

Change Project Switches active projects or run experiment

without a project title (“"none”).

Change Password Edits password for active user

Server Administration Modifies settings for users, groups, projects
and constants.

Lock Application Disabled the Octet System Data Analysis
software with a screen lock. A password is
required to unlock the program.

Logoff Exits the program. A password is required to
log in again.

Octet System Data Analsyis User Guide
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Help Menu

The Help menu provides access to software and instrument support information.

Help |
Data Analysis User Guide
ForteBio Web Site

About ForteBio Data Analysis

Figure 2-5: Help Menu

Table 2-3: Help Menu Commands

Menu Command Function

Data Analysis User Opens the online Octet System Data Analysis Software User

Guide Guide.

ForteBio Web Site Opens a web browser and displays the Pall ForteBio web
page (www.fortebio.com).

About ForteBio Data Displays software, user, and instrument information.

Analysis

e NOTE: Clicking the Pall ForteBio logo (in the upper right corner of the main
screen) also displays the About window.

Octet System Data Analsyis User Guide
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OCTET SYSTEM 21 CFR PART 11 SOFTWARE OVERVIEW

The Data Acquisition and Data Analysis software for Octet systems is available in an
optional 21 CFR Part 11 version that enables users in GMP and GLP laboratories to comply
with 21 CFR Part 11 regulations. This version of the software includes features such as user
account management, audit trails and electronic signatures. In addition, the 21 CFR Part 11
version utilizes the Pall ForteBio GxP Server module to manage the information recorded
during user sessions. This chapter explains how to use the Pall ForteBio GxP Server module,
compliance features and administrative functions specific to the 21 CFR Part 11 versions of
the Data Acquisition and Data Analysis software.

e NOTE: The 21 CFR Part 11 Data Analysis software only opens data files gener-
ated in CFR data acquisition. 21 CFR Part 11 files from software version 6.X and
up are fully compatible with the 8.X 21 CFR Part 11 software.

a NOTE: For details on how to install the Octet System Data Acquisition or Data
Analysis software, see Appendix B, 21 CFR Part 11 Software Administrator
Options on page 171.

Octet System Data Analsyis User Guide



ForteBio GxP Server Module page 21

FORTEBIO GXP SERVER MODULE

NOTE: It is highly recommended that the ForteBio GxP Server Module not be

e installed on the computer connected to the Octet instrument. Instead, it
should be configured on the administrator's computer that is connected to the
server. This allows the administrator to control the users who have accounts
and specific privileges in the 21 CFR Part 11 Data Acquisition software. Both
the Octet system computer and the computer with the ForteBio GxP Server
Module should be connected to the server.

When the Data Acquisition or Data Analysis 21 CFR Part 11 software is launched, users are
prompted to logon to the Pall ForteBio GxP Server module. This initiates a user session
where all system, software and user events are recorded. During user sessions, the GxP
Server module manages and stores this recorded information.User sessions are closed
when the user logs out or a set period of inactivity is reached. A new user session is initiated
each time a user accesses the software.

NOTES:

Version 8.2 of Data Acquisition and Data Analysis 21 CFR Part 11 software
require version 8.2 of the GxP Server module. The software will automatically
check the version of the GxP Server module in use and display a message if it is
incompatible with version 8.2 software. Please contact your administrator to
install version8.2 of the GxP Server module if this happens.

For details on how to install the ForteBio GxP Server module, see Appendix B,
21 CFR Part 11 Software Administrator Options on page 171.

The ForteBio GxP Server is required for 21 CFR Part 11.

The GxP Server can be installed in multiple locations with user selection of the
employed copy at the launch of the Acquisition or Analysis software, although
a single copy per network is recommended by ForteBio to ensure that all
records are saved to one location.

Octet System Data Analsyis User Guide
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SELECTING A SERVER LOCATION

e NOTES:
Please contact your administrator to determine best location to use for the
GxP Server module.

Once the GxP Server module host location is selected, this location should be
used as the default selection for the user account. It does not need to be rese-
lected each time a new user session is initiated.

Users must select the host location of the GxP Server module during the login process. The
GxP server can be run on the local host computer where the Data Acquisition or Data Anal-
ysis software is installed or from a network location.

To select a server location:

e NOTE: You must select the host location of the GxP Server module during the
login process. You can use the GxP Server on the local host computer where
the Data Acquisition or Data Analysis software is installed, or from a network
location.

1. Launch the Data Analysis software by double-clicking the Data Analysis desktop icon.

The Login dialog box displays (Figure 3-1).

o N
fortésio
—_——

server:

User:

Password:

Project: ’ (none)

Figure 3-1: Login Dialog Box

Octet System Data Analsyis User Guide
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2. (Click... (browse) to select a Server location.

The Authentication Server dialog box displays (Figure 3-2).

|

Connection to server:

Server address: localhost
[¥] Localhost
Port: 20002 [= | Fnd | | Defaut |

Figure 3-2: Authentication Server Dialog Box

3. Click Default to recall the default server settings of localhost and Port 2002.

+ Local host—If the local computer is to be used as the GxP Server module host,
click the Localhost check box. Change the Port number if necessary.

«  Remote host on same subnet—If the GxP Server module is hosted on the same
subnet, deselect the Localhost check box and click Find. A list of potential GxP
Server module addresses will be listed. Choose the desired location from the list
and click OK.

Choose Server Address a M

More than one server was found.
Please choose one.

192.168.1.78 (JRICHARDS
192.168.1.78 (JRICHARDS)

Figure 3-3: Choose Server Address

- Remote host on another subnet—If the GxP Server module is hosted on a differ-
ent subnet, deselect the Localhost check box. Enter the IP address of the com-
puter hosting the GxP Server module.

Octet System Data Analsyis User Guide
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Connection to server:

Server address: 192.168.1.78
["] Localhost
Port: 20002 [ | Fnd | | Defaut |

Figure 3-4: Authentication Server Dialog Box

4. When the GxP Server module host location has been selected or entered, click OK to
save changes and exit the Authentication Server dialog box.

The GxP Server module location is listed as the Server in the Login dialog box
(Figure 3-5).

o N
fortésio

Jﬁ

Server: localhost: 20002

User:

Password:

Project: ’ (none)

Figure 3-5: Login Dialog Box—GxP Server Information
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STARTING A USER SESSION

NOTE: Before starting your first user session, contact your administrator to
determine the GxP Server module host location to use.

To start a user session:

1. Launch the Data Acquisition or Data Analysis software by double-clicking the respec-
tive desktop icon.

The Login dialog box displays:

o N
fortésio
—_——

Server: localhost: 20002

User:

Password:

Project: ’ (none)

Figure 3-6: Login Dialog Box

2. Confirm that the Server location is correct. If not, see “Selecting a Server Location” on
page 22.

+ If the local machine is to be used as the GxP server, ensure that Localhost is
selected.

+ If a remote machine is to be used and it is located on the same subnet, deselect
Localhost and click Find to display a list of potential GxP server addresses.
Choose the desired GxP server from this list and click OK. Click OK in the Authen-
tication Server dialog to finish. The new GxP server should be listed in the Login
dialog box (next to Server).

- If aremote machine is to be used and it is located on a different subnet, deselect
Localhost and enter the IP address of the machine running the GxP server. Click
OK to close the authentication server.

3. Selectyourlogin name from the User drop-down list (Figure 3-7). (For the first time log-
ging in, select Administrator.)
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NOTE: To start an administrator session, select Administrator in the User
drop-down list.

fortésio

Server: localhost: 20002 E
User: u
passord
Project:  PSmith

RBrown

| OK | l Cancel ]

Figure 3-7: Selecting Login Username

4. Enter your password in the Password field. Click ? for a password reminder if needed
(Figure 3-8). (For the first time logging in, leave the Password field blank.)

fortésio

localhost: 20002

JBlack

@ Reminder:

Employee number
oK I

Figure 3-8: Password Reminder Option

5. Optional. Select a project from the Project drop-down list (Figure 3-9). (For the first
time logging in, leave as (none).)
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o . &
fortésio
—_——

Server: localhost: 20002 E
User: JBlack v
Password: eesssssss
Project: [(none) = J

Cell Culture screen
Receptor: Ligand screen

Figure 3-9: Project Selection

6. Click OK.

The Data Acquisition or Data Analysis software launches and starts the user session.
During the session, the user account and project selected at login are displayed in the
Data Acquisition software status bar.

s NOTES:
Software operation may be restricted based on your user privileges. For more
information on user privileges, please contact your administrator.

User sessions are automatically locked after a period of inactivity which is set
by the administrator. The Login box will display and a message indicating the
session has been locked will be shown. You can choose to log back into the
session or log off at this time. User sessions will not be locked during experi-
mental data acquisition.

To create and edit new users, groups, and projects, see “User Account Adminis-
tration” on page 192, “Group Administration” on page 197, and “Project
Administration” on page 200.

COMPLIANCE FEATURES

You can access the 21 CFR Part 11 compliant features provided in the 21 CFR Part 11 ver-
sions of the Data Acquisition and Data Analysis software by selecting the Security menu
from the main menu (Figure 3-10).
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Security | Help

Verify Document ...
View Audit Trail

Change Password ...
Change Project 3

Server Administration

Lock Application ...
Log Off ...

Figure 3-10: Security Menu

@ NOTES:
The Server Administration option in the Security menu can be accessed
only if you have administrator or review privileges.

Security menu options in the Data Acquisition and Data Analysis software
applications are identical.

Experiment and Method File Compliance

When using the 21 CFR Part 11 version of the Octet System Data Acquisition and Data Anal-
ysis software, only 21 CFR Part 11 compliant experiments and method files generated using
the 21 CFR Part 11 version of the software can be opened. Files generated using the non-
compliant version of the software cannot be opened, and a message indicating this will be
presented.

Verifying Digital Signatures

Electronic signatures are added to method (fmf) and data (frd) files which ensure they
were generated with 21 CFR Part 11-compliant software. In Octet Data Analysis software
version 8.2 and higher, electronic signatures are also added to data analysis settings files
(Settings_DataAnalysis.fsd) and non-CFR standards data (.fsc) files.

The electronic signature of files can be verified. To do this:
1. Click Security > Verify Document.

The Verify Digital Signature dialog box displays (Figure 3-11).
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Fie:

Figure 3-11: Verify Digital Signature

2. Click... to browse for the desired file (.fmf, .frd, .ini, .fsd or .fsc).

@ NOTE: When verifying digital signatures, both method (.fmf) and data (.frd,
.fsc) files can be selected in the Data Acquisition and Data Analysis software.

Open
e e | =« Forte Bio » example files » Quantitation - CFR H Search Quantitation -.. 2

Organize ~ New folder =- 0 @

© Favorites — Documents ||b|'ary
I Desktop Quantitation

4 Downloads

=4 Recent Places

Arrange by:

Name Date modified Type

LABUSER090811_072.frd 2/14/2011 12:08 PM  FRD File
5§ Libraries LABUSER090811_071.frd 2/14/2011 12:08 PM  FRD File
B, Documents LABUSER090811_070.frd 2/14/2011 12:08 PM  FRD File
& Music LABUSER090811_069.frd 2/14/2011 12:08 PM  FRD File
& Pictures LABUSER090811_068.frd 2/14/2011 12:08 PM  FRD File
B videos LABUSERQ90811_067.frd 2/14/2011 12:08 PM  FRD File
LABUSER090811_066.frd 2/14/201112:08 PM  FRD File

& Homegroup LABUSER090811_065 frd 2/14/201112:08 PM  FRD File
LABUSER090811_064.frd 2/14/2011 12:08 PM  FRD File

- ] i |

A& Computer

File name: ‘ - [Data Files (* frd) File Type

| Open |V|| Cancel

Figure 3-12: File Selection

To change the file type available for selection, click the file type box and select a differ-
ent format (Figure 3-13).
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File name: ¥ |Data Files {*.frd) v

Method File (*.fmf)
Data Files (*.frd)
0 XMLFiles (*xml)

—A" Files {wIW)
Figure 3-13: Changing File Type

3. Select the desired file and click OK.

A message displays in the Verify Digital Signature dialog box, indicating file compli-
ance status (Compliant or Non-Compliant) (Figure 3-14).

Verify Digital Signature M

Fie: Documents\Contracting\Forte Bio\User_Guides\Data and m...\Basic Quantitation Experiment cfr.fmi B
This file is valid and has not been edited outside Fortebio software.

Fle: Documents\ForteBio\Quantitation - non-CFR\LABUSER090811_072.frd [Z]

This file is not 21 CFR. Part 11 compliant
or was generated on a non-21 CFR Part 11 compliant system.

Figure 3-14: File Compliant (top), File Not Compliant (bottom)

Viewing the Data Settings Change History

In Octet Data Analysis 21 CFR Part 11 software versions 8.2 and higher, a history of changes
made to analysis settings are also archived within the experiment folder. To view the set-
tings change history for the experiment currently open, select Security from the main
menu and click View Data Settings Change History.
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-
ol Settings Change History

Change History:

Date/Time User ID
2014-09-23 09:42:59 tae

Event Type
Save settings - O Analysis Parameters

2014-05-23 09:45:25 Administrator  Save settings - Q Analysis Parameters

Settings Parameters:

Parameter New Value Old Value Il
KData False False

StepUsedFromK -1 -1

Align¥Time 0 0

Reference Subtraction 0 0 E
lgnore Errors False False

FlipData False False

SamplePlateStandards False False

StandardCurve Equation 0 0 e
UseStandardFiles 0 0

BindingRate Equation 0 -1

ReadTime 120.01 -1

ZeroConcentration Threshold  0.0001 0.0001 i

[

Figure 3-15: Data Settings Change History

The change history includes the old and new values for each setting whenever they are:

« Changed from the default setting

« Changed from a previous setting

Viewing the Audit Trail

The Audit Trail displays a historical log of user, system and software events recorded during
user sessions. To view and display the Audit Trail, click Security > View Audit Trail
(Figure 3-16).

ol Audit Trail (=[=] = ]
Project: [ (al) ~| Experiment: [(al) ~| Machine: [WIN-S3NNJUKME. ~
Date/Time Machine Project Type Infa
5/29/2014 2.08:22 PM  WIN-S3NN. .. Calculate binding rate
5/29/2014 220815 PM  WIN-S3NN. .. Open experiment C\TestData"\Octet'Pro A plate 1 on REDSE CFR
5/29/2014 2.08:18 PM  WIN-S3NN. .. Close experiment C:A\TestData \Octet'\CrashSA on off on QKe CFR
9/25/2014 2:08:13 PM  WIN-53NN... Fit curves
5/29/2014 2.08:13 PM  WIN-S3NN. .. Save settings K Analysis Parameters
9/29/2014 2:08:10 PM WIN-S3NN... Process data
5/29/2014 2:08:07 PM  WIN-S3NN. .. Open experiment C:A\TestData \Octet'\CrashSA on off on QKe CFR
5/29/2014 220741 PM WIN-S3NN. .. User login Tester

h 4

Figure 3-16: Audit Trail

Octet System Data Analsyis User Guide



page 32 Chapter 3:21 CFRPart 11 Compliance

e NOTE: Events displayed in the Audit Trail are those associated with the user
account that is currently logged in and active only.

Sorting Events in the Audit Trail

Events in the Audit Trail can be sorted by clicking any of the column headers (Figure 3-17).

Date/Time Project Machine Action Description
2011/02/14 13:00:53 Antigen:Antibody screen  JRICHARDS User login

2011/02/14 13:18:01 Antigen:Antibody screen  JRICHARDS User login

2011/02/14 13:42:07 Antigen:Antibody screen  JRICHARDS User logout
2011/02/14 13:42:45 Antigen:Antibody screen  JRICHARDS User login

2011/02/14 13:43:30 Antigen:Antibody screen  JRICHARDS User logout

Figure 3-17: Events Listed in the Audit Trail

By default, the events initially displayed in the Audit Trail are those associated with the proj-
ect selected at login and the machine (computer) currently being used. To view events for a
specific project, experiment or computer, click the Project, Experiment or Machine drop-
down list and select an entry (Figure 3-18).

-
a2l Audit Trail b o
‘ Project: [ (al) ~| Experiment: [(al) ] Machine: [WIN-S3NNJUKME. ~
Il

Date/Time Machine Project Type ro Aplate 1 on REDSE CFR L

9/25/2014 10:11:40 AM WIN-53NN... Open Sf.on.off on QKe CFR - n RED96 CFR

5/25/2014 10:11:35 AM - WIN-S3NN. .. Close experiment  C:\TestData“Octet'.SA on off on QKe CFR

5/25/2014 10:11:38 AM - WIN-S3NN. .. Open experiment  C:\TestData“Octet'SA on off on QKe CFR

5/25/2014 10:11:35 AM - WIN-S3NN. .. User login tae

Figure 3-18: Selecting an Experiment in the Audit Trail

NOTE: Selections can be made in either one or both of the Project or Machine
drop down lists.

The list only displays events for the selected entries (Figure 3-19).

ol Audit Trail [E=EER
‘ Project: [ (al) ~| Experimet: [Fro Aplate 10n RED35 CFR ~| Machine: [WIN-S3NNJUKME. ~
Date/Time Machine Project Type Infa
5/25/2014 10:11:40 AM - WIN-S3NN. .. Open experiment  C:\TestData“Octet'Pro A plate 1 on REDS6 CFR

Figure 3-19: Experiment-Based Audit Trail Events
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In addition to the specific project and machine selections, the following list options are also
available:

+ (any)—Displays all project and/or machine events for the user account.

+ (none)—Displays all project or machine events not associated with a specific project
(Project list only).

Printing the Audit Trail

To print the Audit Trail, from the main menu click the Print button in the window. The Audit
Trail will print in tabular format based on the current selection of project, experiment and
machine events:

OctetAnalysis(8.2.0.1) Audit Trail[Machine:CAMP-KANGT, Project: Test Project, Experiment:(all) ]

Date/Time Machine Project Type Info
8/27/2014 9:31:15 AM | CAMP-KANGT Test Project Save settings Q Std Curve View Options
8/27/2014 9:31:10 AM = CAMP-KANGT | Test Project | Calculate binding rate
8/27/2014 9:30:59 AM = CAMP-KANGT | Test Project Save standard data  C:\TestData\Octet QKe_Quantitation_CFR_FB-40334\StandardCurve...
8/27/2014 9:30:48 AM = CAMP-KANGT Test Project | Calculate binding rate
8/27/2014 9:30:44 AM = CAMP-KANGT | Test Project Open experiment C\TestData\Octet QKe_Quantitation_CFR_FB-40334
8/27/2014 9:30:26 AM = CAMP-KANGT | Test Project User login tae

Figure 3-20: Printed Audit Trail

Changing Projects During a User Session

During an active session, you can switch to another project in the Data Acquisition or Data
Analysis software without having to log out.

To change projects during a user session:
1. Click Security > Change Projects.

A list of projects assigned to your user account displays with the active project high-
lighted (Figure 3-21).

[Security] Window Help

Verify Document...

View Audit Trail

Change Project > (none)

Change Password... Receptor: Ligand screen
Server Administration © Antigen:Antibody screen
Lock Application... Cell Culture screen

Logoff... I

Figure 3-21: Changing Projects

2. Select the desired project from the list.

The selected project becomes the active project for the user session.
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Changing the User Password

To change the user password:

1. Initiate a new user session with your existing password.

2. When the software launches, click Security > Change Password.

The Change Password dialog box displays (Figure 3-22).

Current password:

New password:
Confirm new password:

Password reminder:

Figure 3-22: Change Password

3. Enter the Current password for your user account. Click ? for a password reminder.

4. Enter the New Password, confirm the new password, and optionally enter a Password
reminder.

5. Click OK to save the changes and exit.

Locking the Application

The Data Acquisition or Data Analysis software can be locked during a user session to pre-
vent another user from interrupting a session or experiment. When the application is
locked, any experiments started will continue to run.

To lock the Octet System Data Acquisition software application, click Security > Lock
Application.

The Octet System Data Acquisition software is placed in locked mode immediately and the
Application Locked window displays (Figure 3-23).
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Application LCE_ M
fortésio
—_——

User: JBlack (John Black)

Password: |

Figure 3-23: Application Locked

The application will remain locked until it is unlocked or the active user logs off.
+ Unlock—To resume the user session, enter your password and click Unlock.

+ Log off—To discontinue the user session, click Logoff.

Ending a User Session

To end a user session:

1. Click Security > Log Off.

2. Click OKin the dialog box displayed.

NOTE: You will be logged out of your user session automatically if there is no

e user interaction with the software after a specified period of time. This time is
set by the administrator, and allows the ForteBio GXP Server Module to proved
added security.
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WORKING WITH EXPERIMENTS

A quantitation experiment enables you to determine sample concentration using a refer-
ence set of standards. After an experiment is run, start a data analysis session (double-click
the icon on the desktop); see “Analyzing Binding Data” on page 52.

Loading an Experiment for Analysis
A data analysis session can be used to:
+ Load and analyze an experiment.

+ Re-analyze an experiment.

e NOTE: More than one experiment can be opened during a session. If multiple
quantitation experiments are open, the analysis includes the data from all of
the biosensors that are check marked in the Results tab.

NOTE: When using the 21 CFR Part 11 version of the Octet System Data Acqui-

a sition software, only 21 CFR Part 11-compliant experiments and re-analyze
generated using the 21 CFR Part 11 version of the software can be opened.
Files generated using the non-compliant version of the software or with a
non-compliant system cannot be opened, and a message indicating this will
be presented.

To load an experiment:

1. On the desktop, click the .2 icon, or click the Windows Start button and select All Pro-
grams > ForteBio > Data Analysis 7.0.

The Data Selection tab displays (Figure 4-1).

File  Help
Data Selection

Bl Loaded Data
D Kinetics
{55 Quartitation

Figure 4-1: Data Selection Tab

2. Load an experiment: right-click the experiment folder in the workstation directory tree
and select Load Folder, or on the menu bar, click File > Load a Folder.

3. Inthe Loading Files dialog box, enter the folder name or click the Browse button (-],
select the desired folder, and click Load.

The experiment is added to the Loaded Data directory tree (see Figure 4-2 example).
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Data Selection |
B & Loaded Data
(2 Kinetics
(23 Quantitation
Data Selection Results
Bl Loaded Data
D Kinetics
() Documents and 5 & [=RF ] Quantitation
) ForteFio {1 2011_03_01 _mutti- analyte - 1
D {2 2011_03_01 _ muti- anate - 2
3 Acauisition !
152 BHG1908-4 £ {2 2011_03_01 _mutti- analyte - 3
1) hlga ProA kin— {21 proAproGproL muttianalyte 2
=0 i {2 EX1021-2430-002-002
{5 netic] | Load Foldsr --{Z0 EXB130-2409-037
. = Q|384 pen Explorer {21 Pro A Quart from QC
— Mew Folder » i | E:q)eﬁment_?.ﬁ
Rename Foldsr g Exper!ment_ig
Delete Folder Loaded Data Directory Tree CI 2::;:2:_”
{7 testReferenceSubtraction
Refresh {17 04-27-11 384 Q hlgG
{27 04-27-2011 384 higG Q
{27 hlgG ProG G

Figure 4-2: Data Selection Window—Loading an Experiment

4. Inthe Loaded Data directory, click the experiment name to open.

The binding curves, sample plate, and sample plate table appear (Figure 4-3).

% ForteBio Data Analysis 7.0 - Quantitation - higG ProG Q e

File  Help

Data Selection Results

(5 Loaded Data hlgG ProG @ \
8 2;‘:‘*";‘0” [T AignX  [[] Reference Subtrsction Aversge o ] Fip Data | Snow All Trmose ] Group View
{10 2011_03_01 _ muki- analyte - 1 10 | Se @ A Ro Cal Ignere emors in files when loading
{3 2011_03_01 _ multi- analyte - 2
{3 2011_03_01 _ multi- analyte - 3 Binding Curve Graph
{1 proAproGprol. muttianalyte 2
{3 EX1021-2490-002-002
(] EX8120-2403-037 400
{3 Pro AGuant from GC 350
{1 Bxperiment_36
{1 Bperiment_37 2.00 o psens
{1 Bxperiment_40 - S I
{1 Bxperiment_44 o = = s
(] testReference Subtraction £
{1 042711384 Q higG
{0 04272011 384 higG @

=25 PG ]

nsinment Type: OcteREDS | Eat
Legends

i) 80 %0 100 10 120 130
Time (sec)

70 B
[l 04-27-11 384 K ProA hlgG
1 04-27-11 384 Q hlgG

[ 04-27-2011 384 hlgG Q Proi 2 3 4 5 6 1 89 10 11 12 [\ ooy Sesor.. Sample Sample. Type Replicat. .. Known Con *

‘§§4 OOOO..... oAl =Pm\enG Al gGSe. @ Sa. 200 200 >|
181 Protein G B1 gGSta.. @ Sa. 100 100 i
OOOO’.... 2c -PZ::E c1 |§Es: @ s: 50 50 L

Select samples from the table or Plate below to display the data

A
. Acquisition B
COO000000008 i Sr=c: zx s o o
(I higG ProA Kinetics. = 01010 4Bl ProtenG  E1 G Sta.. @ Sa.. 10 10
B oo PEOOCO0COOOO® 7 _mmch Enei s -
| Screen Shots 6 Gl B FrotenG  G1 G Sia.. @ Sta.. 25 25
Software v6.3 data files E OOOO.. .. . 7 H1 || PotenG H1 oG Sta. : Sta.. 1 1
| Webinars 8 M ProtenG A2 196 Sta. Sta.. 200 200
| Webpage _ FO@@OOOO..... 962 [ Poenc B2 WG Sta.. @ Sta.. 100 100
| Wikipedia = @@@OOOO. 1c2 I ProtenG  C2 IGSta. @ Sta. 50 50
) Music G . .. . 102 ProteinG D2 GSta. @ Sa. 25 25
] Pictures H . .. . 1e2 [l FoenG E2 G 3ta.. @ Sa.. 10 10
- Videos i1 ‘1 F2 ProtenG  F2 IgesT ® s 5 5 -
[ — r

< i ] b

Figure 4-3: Data Selection Window—Opening an Experiment

5. Repeat steps 2-3 to load and open another experiment.
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Q NOTE: When multiple experiments are loaded, select an experiment by click-
ing its tab above the binding chart (in the Data Selection window), or click the
experiment name in the Loaded Data directory tree.

Editing Experiments

The Octet System Data Acquisition software enables you to change sample designations,
standard concentrations, or exclude samples from analysis. For example, you can exclude a
standard that does not meet the sample r? or residual threshold, then re-analyze the data.
You can also modify some processing parameters.

NOTE: If you are using the 21 CFR Part 11 version of the Octet System Data
Acquisition software, editing options are disabled.

Changing Sample Designations

To change sample designations:
1. Click the Data Selection tab, then perform one of the following tasks:
+ In the sample plate map, select the well(s), right-click, and select one of the fol-
lowing options (see left image in Figure 4-4):
« Change to Standard
« Change to Unknown
+ Change to Control
« Change to Reference
« Edit Sample Information

« Inthe results table, right-click a table cell and make a selection from the drop-
down menu (see right image in Figure 4-4).

Table Columr: K Cone. 0]
Jrownone. | Include Selected Rows
poo123456738 9101112 4
P =T 7| Exclude Selected Rows 4
E
11 12 c Set Calor ...
Change to Standard o 4
Set Color By Grouy
Change to Unknown E v i 4
G f Set Color By r F4
Change to Contral " 4
a
hange to Reference Size Columns by Title m
Edit Sample Infarmation .. Size Columns by Data 5
Size Columns by Bath 3
Select All Rows |
Invert Selection
Order Columns ...
Edit Sample Information ...

Selecting wells in the sample plate map

Selecting a cell in the Well Type column of the results table

Figure 4-4: Changing Sample Designations
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Excluding/Including Samples from Analysis

To toggle sample analysis in the Results window, perform one of the following tasks:

+ Inthe sample plate map, select the well(s), right-click and select Exclude Wells. If the
selection is already excluded from analysis, select Include Wells to return (include)
the samples to the analysis.

+ Inthe results table, to exclude wells, deselect the check box in the first column, or
right-click the selected rows and select Exclude Selected Wells. If the selection is
already excluded from analysis, click the check box for the desired rows, or right-click
the desired rows, and select Include Selected Wells.

3% ForteBio Data Analys L0 O AR lation HinG Prorikn et oo | Diution - | - | Sample | Senisar
File Help Include Selected Rows .
Results 1 Exclude Selected Rows
Standard Curve Equation Group View Set Color ...
[Linear Paint to Point v] ’7 Optiors ... 1d Set Color By Group
5 Set Color By 4
’ Load Standards... ] ’Sa\re Standards... ] 2. =
1 Size Columns by Title
[ Use standards from loaded fils Size Columns by Data
Calibrate within piate 1 Size Columns by Both
Processing Parameters Select All Rows
Binding Rat ation:
inding Rste Equation 10 Invert Selection
R equilibrium - 5
2. Order Columns ...
Read Time: 5598 secs X R -
1 Edit Sample Information ... No Data Available
Zero Conc. Threshold: | 0.0001) BR [ ;
Low Conc. Threshold: 0.003| BR

Figure 4-5: Excluding Samples from Analysis

Octet System Data Analsyis User Guide



page 42

Chapter 4: Quantitative Analysis

Editing Table Information

The following information in the table can be edited directly. Just click in the cell, then type
to make changes (Figure 4-6):

Sample ID
Replicate Group
Known Conc

Dilution Factor

Index

Plate Sensar Color Sensor Type

Al Protein A

Protein A
Protein A
Protein A
Protein A
Protein A
Protein A
Protein A
Protein A
Protein A
Protein A
Protein A
Protein A
Protein A
Protein A
Protein A
Protein A
Protein A

=

EA

Sample

Al

L] 1
--*-__

ci

Sample ID Type Replicate Group Known Conc. (ug/ml) Diltion Factor ~ *
2000 @s... N/A 2000
[ L L S ]
1000 @5 N/A T
700 @s... N/A 700
500 @s... N/A 500
00 @S N/ 300 3
100 @s... N/A 100
330 @s... N/A k)
10 @5 N/A 0
3 @s... N/A 3
1 @s... N/A 1
05 @5 N/A 05
05 @s... N/A 05
1 @s... N/A 1
3 @5 N/A 3
10 @s... N/A i
2000 @s... N/A 2000
1500 @5 N/A 1500
1000 @s... N/A 1000 L
| 2

Figure 4-6: Editing Cells in Data Table

Editing Standard Concentration or Well Information

To edit standard concentration or well information:

1.
2.

Click the Data Selection tab.

In the results table, click a Conc. or Well Info cell, and enter the desired information. (To
access a shortcut menu of editing commands, right-click the cell.)
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i3 ForteBio Data Analysis 7.0 - Quantitation - higG ProA Kinetics = | E )
File  Help
| ) Data Selection | ) Resuts|
E Loaded Data hlgG ProA Kinetics | 16 Sensors frem #1
=-E Kinstics
£ 042711 384 K FroAhigG [T Aign X [ Reference Subiraction Average of ] Fip Data | Show All Traces [T Group View R — —
{2 higG ProA Kinetics 10 @ Ignore emors in files when loading @ Legends
=2 Quartitation

{20 042711 384 Q higG Binding Curve Graph
{21 04272011 384 hlgG Q

0 30 6 90 120 150 180 210 240 270 300 330 360 330 420 450 480 510 540 570 600
Time (sec)

B Desktop

Select samples from the table or Plate below to display the data

P12 3 4 5 6 7 8 5 1 11 2 [ . smge. Tye Replicat . Known Conc. . Dilution . Informatic *
A4 hssocia.. @ Sta. 1 = L
B4 fssocia.. @ Sta.. 2 10 Lise
C4  Assova. Standerd 3 5 T
ut
D4 Associa... @ Sta.. 4 25
E4 Associa.. Standerd 5 1 Copy
F4 hssocia... Referen.. 6 N/A Paste
Ga hssocia.. Referen.. 6 N/A Delete
He  Associa. Referen.. 6 A
A5 Associa.. Unknown 1 /A Select Al
B5  Associa. Unknown 2 N/A
cs Associa.. Urknown 3 NAA Right to left Reading order
D5 Associa...  Unknown 4 /A Show Unicode control characters
ES | Associa... | Unkmown | § 1A Insert Unicode control character ,
P Beenrie e nis
i 0 i
OpenIME
Reconversion

Figure 4-7: Data Selection Window—Editing Sample Information

Editing Processing Parameters

To edit processing parameters:
1. Modify the following parameters as appropriate:

+ Read time—The amount of data that is analyzed.
+ Zero concentration threshold—Binding rates that are less than the zero con-
centration threshold are considered zero.

+ Low concentration threshold—Clicking Calculate binding rate! causes the
initial rate to be calculated using both a linear and exponential equation. The
low concentration threshold determines which value is reported in the results
table. Changing this threshold can improve the precision of low concentration
samples.

« Iftheresultfrom alinear fit is below the low concentration threshold, then the
value from the linear fit is reported in the analysis table.
« If the result from a linear fit is greater than the low concentration threshold,
then the value from the exponential fit is reported in the analysis table.
2. In the Results window, select the cell to edit and enter a new value. Or, right-click the
cell to access a shortcut menu of edit commands.

The modified parameters are saved in the Settings_DataAnalysis.ini or Settings_Data-
Analysis.fsd file when you click Calculate Binding Datal.
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e NOTE: In Octet Data Analysis 21 CFR Part 11 software versions 8.2 and higher,
the Settings_DataAnalysis.ini file name extension is Settings_DataAnaly-
sis.fsd. Electronic signatures are also added to data analysis settings (.fsd) files.

Data Selection Resuls
Standard Curve Equation
[ Lingar Puint to Point v @ Standads —— Fitting Curve @ Unknowns & Controls
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Binding Rate Equation 0800
2
Initial Slope v 5
| | & 0600
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189 83 @ Urnknown 1.29901 3
Standards Sampls Alerts A........O OOO 1c9 =) @ Unkrown 125149
Type Threshold .. .. 109 Dpa @ Unkrown 1.25400
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Figure 4-8: Editing Processing Parameters in the Results Window

Defining Replicate Groups

The Replicate Group feature enables data to be organized into custom groups during anal-
ysis (see Figure 4-9). Replicates can be defined during acquisition (or analysis) as a group.
For each group, the average binding rate, average concentration, and corresponding stan-
dard deviation, CV% are calculated.

To define replicate groups:

1. Enter replicate grouping information in the Results table: right-click and select Edit
Sample Information (Figure 4-9).
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Index Include Color SensorlLocation Sensor Type Sensorinfo  Replicate Group Baseline Loc. #
20 x e e SA (Streptavidin) 3 c3
21 x e SA (Streptavidin) 3 c3
2 x [ o2 SA (Streptavidin) 4 D3
23 x [ o2 SA (Streptavidin) 4 D3
24 X E2 SA (Streptavidin) 5 E3
25 X E2 SA (Streptavidin) 5 E3
26 X F2 SA (Streptavidin) 6 F3
27 X F2 SA (Streptavidin) 6 F3
28 X G2 SA (Streptavidin) 6 G3
29 X G2 SA (Streptavidin) 6 G3
30 X H2 SA (Streptavidin) 6 H3
3 X H2 SA (Streptavidin) 6 H3 =
2 x B - SA (Streptavidin) 1 A3

Figure 4-9: Edit Sample Information

NOTE: Replicate Group information can also be entered in the Octet System
Data Acquisition software.

Assigning Replicate Groups in the Sample Plate Map
To assign Replicate Groups in the Sample Plate Map:
1. Select the samples to group, right-click and select Set Well Data.

2. Inthe Set Well Data dialog box (see Figure 4-10), enter a name in the Replicate Group
box and click OK.

Set Well Data ﬁ

‘Wel Information Dilution Factor - Unknown only ]
Sample 1D: 0 @) By value: 2
Association
Dilution series
RTpﬁcate SIELE Starting walLie: 1
1]
Series aperator: / -
Wel Information: [l
13 Kinetics Buffer Series operand; 2
Dilution orientation
2382 Right 2323 Left
[ 1] ) 0
26 @ Down oo Up
[sle ) *5
0K ] l Cancel

[

Figure 4-10: Set Well Data Dialog Box—Add Replicate Group from the Sample Plate Map
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3. Repeat the previous steps to assign new samples to the existing Replicate Group, or to
designate another set of samples to a new Replicate Group. Multiple groups can be
used in an experiment.

IMPORTANT: The Octet System Data Analysis software will only recognize and

o group samples that use the same Replicate Group names—spacing and capi-
talization must be identical. For example, samples assigned to Group 2 and
group? are treated as two groups.

NOTE: When performing a Multiple Analyte experiment in Data Acquisition, if

@ the same Replicate Group name is used with different biosensor types, they
will be treated as separate groups. Statistics for these groups will be calculated
separately for each biosensor type.

Wells in the Sample Plate Map will show color-coded outlines as a visual indication of
which wells are in the same group (see Figure 4-11).

Zample Flate

©000000OOO®
@000V OVOVOO®
©O00000OVLOO®
@000V VOOVOO®
©OEO0000O0OOME®
0l0l0] | 1 l@0I®/e0]0)
OJ0l0] | 1 1G0I®Ie0]0
OICI0L 1 I IGIeIeel0]0)

Figure 4-11: Replicate Groups Displayed in Sample Plate Map
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The Sample Plate Table updates with the Replicate Group names entered (see
Figure 4-12).
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Sample Plate Table

Concentration units: gl -

Malar concentration units: nhd -
Well | Sample ID Replicate Group | Type Conc (pg/ml)| MW (kD) | Molar Conc (nM) | Information -
O A4 Assodiation 1 Sample 10 150 BEEB? 13 Kinetics Buffer
() B4 Association 2 Sample 5 150 3333 1 Kinetics Buffer
) C4  Association 3 Sarnple 25 150 16.67 1 Kinetics Buffer
(D4 Ageociation 4 Sample 1.25 150 8.333 1X Kinetice Buffar
I E4 Association 5 Sample 0.625 150 4167 1 Kinetics Buffer
@ F4  Association [ Refarance 1 Kinetics Buffar
@ G4  Association i Fieference 1¥ Kinetics Buffer
@ H1  Association [ Reference 1 Kinetics Buffer
(3 AR Assodiation 1 Sample 10 150 EEE7 1% Kinetics Buffar
() BS  Association 2 Sample 5 150 3333 1 Kinetics Buffer
{1 C5  Assaociation 3 Sample 25 150 16.67 14 Kinetics Buffer
(D5 Agsociation 4 Sample 1.25 150 8.333 1 Kinetics Buffer
{1 EE  Assaociation 5 Sarmple 0.625 150 4.167 1 Kinetics Buffar
@ F5  Association 1] Reference 1 Kinetics Buffer
@ G5 Association f Reference 1% Kinetics Buffer
@ H5  Assaciation b Reference 14 Kinetics Buffer

Figure 4-12: Replicate Groups Displayed in Sample Plate Table

Assigning Replicate Groups in the Sample Plate Table
To assign Replicate Groups in the Sample Plate Table:
1. Double-click the desired cell in the Replicate Group table column.

2. Enter a group name (see Figure 4-13).

Sample Plate Table

Concentration units ol -

Molar concentration units: nid -
Well | Sample ID Replicate Group | Type Conc (pg/ml) | MW (kD) | Molar Conc (nM) | Information -
1 A4 Assaciation ﬂ Sarmple 10 150 BB.67 1 Kinetics Buffer
() B4 Association 2 Sample 1 150 3333 1 Kinetics Buffer
) C4  Association 3 Sarnple 25 150 16.67 1 Kinetics Buffer
(3 D4 Association 4 Sample 1.25 180 B.333 1 Kinetics Buffer
{1 B4 Association 5 Sample 0625 150 4167 1 Kinetics Buffer
@ F4  Association [ Refarance 1 Kinetics Buffer
@ G4 Association 6 Feference 1 Kinetics Buffer
@ H1  Assaociation [ Reference 1 Kinetics Buffer

Figure 4-13: Add Replicate Group from the Sample Plate Table

Edit commands (Cut, Copy, Paste, Delete) and shortcut keys (Cut [Ctrl+x], Copy
[Ctrl+c], Paste [Ctrl+v], Undo [Ctrl+z]) are available in the Sample Plate Table. To view
edit commands, double-click the cell. This highlights the value and allows it to be
edited. Next, right-click to view the edit menu.

e NOTE: The right-click menu is context-dependent. Right-clicking on a cell
where the value is not highlighted and in edit mode opens the Sample Plate
Map menu used to designate sample types.
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3. Repeat the previous steps to assign new samples to the existing Replicate Group, or to
designate another set of samples to a new Replicate Group. Multiple groups can be
used in an experiment.

IMPORTANT: The Octet System Data Analysis software only recognizes and

o groups samples that use the same Replicate Group names where spacing and
capitalization must be identical. For example, samples assigned to Group 2
and group? are treated as two groups.

Viewing Binding Curves

To view binding curves, in the sample plate, select a well(s), or in the sample plate table,
select a row(s).

To select non-adjacent rows or wells, press and hold the Ctrl key while clicking the wells or

File  Help
Data Selection Resuts
E-{ Loaded Data hlgG FroG Q |
-2 Kinetics =
S G o [T AignX [ Reference Sublraction Average of (] Fip Data | Show Al Traces [T Group View — neumert Type- OiRED% [ G
(1] 042711382 Q higG 10 |Sec || @ A R Ilgnore ermors i files when loading ons . | @ A = Legends
{1 hlgG ProG Q
Binding Curve Graph
440
400
360
320
280
L 240
200
180
120
020
040 fﬂ
dEEE———— e e T T T
0 10 2 0 40 50 &0 70 80 %0 100 110 120 130
Time (sec)
Select samples from the table or Plate below to display the data
In.. Sensor C.. Sensor.. Sample Sample.. Type Repiicat... Known Con *
0 Al B FroienG A1 GSta. @ Sta. 200 200 L
1 B1 B ProteinG B I6G Sta.. @ Sta.. 100 100 3
2¢cl [ ProteinG  C1 GSta.. @ Sta. 50 50 L
70 & 301 | PoenG DI igGSta. @ Sta. 25 2
b 04-27-11 384 K ProA hlgG 4 El ProtenG  E1 igG Sta.. @ Sta.. 10 10
(i 04-27-11 384 Q hlgG 5 Fi Protein G F1 Gz @ S 5 5
(b 04-27-2011 384 hlgG Q 6 G1 B FotenG  G1 IGSta.. @ Sta.. 25 25
9% 7H [ ProienG  H1 oG Sta.. @ Sta.. 1 1
384 8 A2 Protein G A2 oG Sta.. @ Sta.. 200 200
Acquisition 3 B2 B Froi=nG B2 GSta. @ Sta. 100 100
Analysis 1c2 M PrienG  C2 16G Sta.. @ Sta.. 50 50
B hlg6 ProA Kinetics El 102 ProteinG D2 oG Sta.. @ Sta. 25 2
B hig6 ProG Q = 1E2 B Froi=nG E2 Gt @ Sta. 10 10
Screen Shots 172 Protein G F2 I0G Stz.. @ Sta.. 5 5
Softwarev6.3 data files o 162 Protein G G2 oG Sta.. @ Sta.. 25 25 =
4] i ] » < I ] 3

Figure 4-14: Selecting Sample Wells or Rows to Display in the Binding Curve Graph
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Viewing Options

Table 4-1: Viewing Options in the Data Selection Window

Option Description

Align X Select this option if there is an artifact at the beginning of the
binding step to remove. Enter a time (seconds) at which to start
the alignment.

Reference Subtrac- If the experiment includes reference biosensors, select the Ref-
tion Average of erence Subtraction option and select one of the following:
« All—Computes the average binding curve from the ref-
erence wells and subtracts this average from each sam-
ple curve.

+  Row—If arow includes both samples and references, the
Octet System Data Acquisition software computes the
average reference curve for the row and subtracts this
curve from the samples in the same row.

« Column—Ifa column includes both samples and refer-
ences, the Octet System Data Acquisition software com-
putes the average reference curve for the column and
subtracts this curve from the samples in the same col-
umn.

Ignore errors in files  If this option is selected, the Octet System Data Acquisition
when loading software ignores errors in data files. All data files, regardless of
errors or runtime issues, will be loaded for analysis.

Show All Traces Displays all binding curves.

Flip Data The Flip Data function inverts signals from positive to negative
or from negative to positive. This is used most often when the
observed nm shift is negative due to the presence of large ana-
lytes, such as phage, cells, and lipoparticles on the biosensor
surface. For examples of flipping data, see Figure 4-15 and
Figure 4-16.

Grouped View Displays graphs in custom groupings. Choose this option to dis-
play graphs organized into groups according to sample attri-
bute or results category. This is a highly useful feature when
working with large data sets.

« Options—Click to show the Grouped View Options dia-
log box.

+ Refresh—Updates the graph display.
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Table 4-1: Viewing Options in the Data Selection Window (Continued)

Option Description

Edit Legends Select the sample information displayed in the legend. Options
include Sensor, Sample, Sample ID, Group, and Concentra-
tion.

hlgG ProG @
[ Aign X [ Reference Subtraction Average of ] Fip Daia [ Show Ml Tmoss ] L O View nstrument Typs: OctstRED36

10 | Sec @ A lgnore emors in files when loading Options =
Binding Curve Graph
400 e ot
350 et T
P .
3.00 g _ _
250 s (It B - e

Figure 4-15: Flip Data—Example of Flipping Data to Example in Figure 4-16

hlgG ProG Q
7] Mign ¥ [ Reference Subtraction Average of Flip Data Show All Traces ]

10 | Sec @ A Row Column Ignore emors in files when loading L

nstrument Type: OctetREDS6

Binding Curve Graph

nm

-4.00 T

Figure 4-16: New Flip Data from Figure 4-15
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Opening Binding Curve in Separate Window
To open the binding curve chart in a separate window, double-click the graph.
Customizing Appearance of Graph or Binding Curve

To customize the appearance of the graph or a binding curve; see Figure 4-17. Right-click
the graph or a curve for a shortcut menu of display options.

«  Hover over a binding curve to display a tooltip of the X-Y coordinates.
+ Right-click the graph to view a shortcut menu of display options.
+ Right-click a curve to view a shortcut menu of display options.

» Right-click the graph and select Toolbar. Toolbar buttons enable you to save, copy,
or print the graph.

£ ForteBio Data Analysis 7.0 - Quantitation - higG ProA Kinetics = | B [
File  Help
| ) Cota Selection [ ) Reuts]
£ 3 Loaded Data hlgG ProA Kinetics | 16 Sensors from #1
¥a ge;;-szm 34 K Pof g Dl X [ Releerce Sbtecion Aveage 7] Py Dt [CshomiTioss | [ G0 Ve nsrument Type: OtRED%S | Edg
B T15G ProA et I Colurr Ionors smors infles whenloading | 00 5 Legends

{21 Quartitation

Binding Curve Graph

0 0 €0 9% 120 150 180 210 240 270 300 330 360 30 420 450 480 510 540 510 600
Time (sec)
s M Desktop

Select samples from the table or Plate below to display the data

PPt 2 3 4 5 6 1 8 3 M M 1 [\ o  Sewor. Sample Saple.. Type  Replcal.. KnownConc~
00000000000 v mis v = on 1w
. .O .. .. 161 Bl GAGre. B4 Asoc. @ Sm. 2 00
201 D sAGte. C4 Associz.. @ S 3 00
3Dl | SA(Sre. D4 Associa.. @ Sa.. 4 00

4B SA(Ste.. E4  Asoda. @ Sa. 5 00 L

5 F1 SAlSte. F4 Associa. @ Ref. 6 N/A r
s I G4 Associa. @ Ref 6 N/A
7w B He Associa. @ Ref. 6 N/A
8 A2 A5 Associa. (D Unk. 1 N/A
sz W B5 fssociz.. O Unk.. 2 N/A

1z 1N c5 Associz.. O Unk.. 3 N/A I
102 D5 Associa... (O Unk.. 4 N/A
12 W £5 fssocia. (D) Unk. 5 N/A

‘1 F2 F5 ﬂﬂou‘a‘ @ Ref. & N/A 2

« i '

Figure 4-17: Viewing Binding Curves
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Closing Experiments

To close an experiment, in the Loaded Data directory tree, right-click the experiment name
and select Remove Run (see left side of Figure 4-18).

To close all experiments in the Kinetics or Quantitation folder, right-click the folder and
select Remove All (see right side of Figure 4-18).

File  Help Data Selection | Result5|
[rata Selection | Fesults B-Zr Loaded Data
- Kinetics
= |7 Loaded Data E|1_D"

{1 Kinetics

{23 201] Remove All
D 201 TosmoT— - =
-7 2011_03_01 _ mutti- analyte - 3
(] proAproGprol muttianatyte 2
(I3 EX1021-2450-002-002

--{Z0 EXB130-2409-037

({1 Pro A Guant from QC

(1] Experiment_36

{1 Experiment_37

(] Experiment_40

(] Experiment_44

{7 testReferenceSubtraction
{10 04-27-11 384 Q hlgG

{10 04-27-2011 384 hlgG Q
{23 hlgG ProG Q

|“*| Remove Run
[x

Figure 4-18: Closing a Selected Experiment (left) or All Experiments (right) in the Quantitation or Kinetics
Folder

ANALYZING DATA

More than one experiment can be opened during a session. If multiple quantitation experi-
ments are open, the analysis includes the data from all of the biosensors that are selected in
the Results tab.

NOTES:

Q When analyzing a large number of experiments, batch mode may be more
convenient. For more details on batch analysis, see “Processing Batch Quanti-
tation Analysis” on page 68.

In Octet Data Analysis 21 CFR Part 11 software versions 8.2 and higher, a his-
tory of changes made to analysis settings are also archived within the experi-
ment folder.

Analyzing Binding Data
To analyze the binding data:
1. Start an analysis session and select the experiment(s) to use.

2. Select a standard curve equation.
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3. If the sample plate does not include standards, load a standards file (.fsc).
4. Confirm or set new values for the processing parameters.

5. Calculate the binding rate.

a NOTE: For information on preparing biosensors, see the product insert packed
with the biosensors. For information on data acquisition, see the Data Acquisi-
tion User Guide.

Specifying Analysis Settings

@ NOTE: In Octet Data Analysis 21 CFR Part 11 software versions 8.2 and higher,
whenever you exclude/include wells in the Binding Rate Calculation or
exclude/include selected rows, these actions are now logged in the Audit Trail.

To specify analysis settings:
1. If the experiment includes reference biosensors, click the Reference Subtraction Aver-
age of check box (Figure 4-19) and select to average the data by one of the following:
« All—Computes the average binding curve from the reference wells and sub-
tracts this average from each sample curve.

«  Row—If a row includes both samples and references, the Octet System Data
Acquisition software computes the average reference curve for the row and sub-
tracts this curve from the samples in the same row.

+  Column—If a column includes both samples and references, the Octet System
Data Acquisition software computes the average reference curve for the column
and subtracts this curve from the samples in the same column.
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Figure 4-19: Reference Subtraction Average of Methods

Confirm the sample designations (for details, see “Changing Sample Designations” on

Confirm the standard concentrations (for details on changing standard concentration,

2.

page 40).
3.

see “Editing Standard Concentration or Well Information” on page 42).
4.

Click the Results tab and select samples to include in the analysis (for details, see

“Excluding/Including Samples from Analysis” on page 41).
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Figure 4-20: Results Window

5. Select a standard curve equation from the drop-down list:
+ Linear Point to Point—The Octet System Data Acquisition software connects
the points of the standard curve with straight line segments.

« Dose Response-4PL (Default; Unweighted)—A symmetrical dose response
curve. No points are weighted during the curve fitting.

+ Dose Response-4PL (Weighted Y2)—Anon-symmetrical dose response curve
with weighting applied as 1/Y2.

+ Dose Response-4PL (Weighted Y)—A non-symmetrical dose response curve
with weighting applied as 1/Y (as Y increases, weighting decreases).

+ Dose Response-5PL (Default; Weighted Y2)—A non-symmetrical dose
response curve with weighting applied as 1/Y2.

+ Dose Response-5PL (Unweighted)—A symmetrical dose response curve. No
points are weighted during the curve fitting.

+ Dose Response-5PL (Weighted Y)—A non-symmetrical dose response curve
with weighting applied as 1/Y.

NOTE: The Octet System Data Acquisition software uses the data from the
e standards in all of the open experiment(s) to generate one standard curve.

Standards with the same concentration are treated as replicates. Remove any

standards or samples that you do not want to include in the analysis. (For
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more details on excluding samples, see “Excluding/Including Samples from Analysis”
on page 41. Alternatively, an experiment can be analyzed using only the standards
from the same experiment plate or from a user-selected experiment).

6. Optional. If multiple experiments are open and you want to analyze an experiment
using the standards from the same experiment plate, click the Calibrate within plate
check box.

NOTE: When two quantitation datasets are opened, you have the option to

s merge data across plates. This happens, by default, if the Calibrate within
plate check box is not checked. Further to this, replicate groups of standards
will be merged and the statistics will be calculated across the entire new repli-
cate group, BUT replicate groups of unknowns will not be merged.

a NOTE: You can navigate between multiple experiments using the tabs above
the sample plate map.

7. Optional. Analyze the data using standards from another experiment:

Standard Curve Within Plate: use this when multiple data sets are loaded. Binding
rates and concentrations are calculated according to the standards in the individual
plate.

Standard Curve by Sensor Type: when you select this option, standard curves are
generated based on sensor types, and sample binding rates and concentrations are cal-
culated according to the standards with the same sensor type.

To select a standard curve:

a. Select either Standard Curve Within Plate or Standard Curve by Sensor Type
(Figure 4-21).
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Standard Curve Equation
[Linear Paint to Point v]
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[ R equilibrium -
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Calculate Binding Rate!

Data Export

Figure 4-21: Selecting a Standard Curve

b. Click Load Standards to load previously saved standard curves (for example Stan-
dard 1, Standard 2, and Standard 3, see Figure 4-22), and click Select Standards.
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Figure 4-22: Previously Saved Standard Curves Generated by Sensor Type

The Select Standards dialog box (Figure 4-23) displays with all of the standard
curves, including the one in the plate.
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o-! Select Standards ﬂ

File Name

[ Standard 1fsc
[ Standard 2fsc
Standard 3fsc

4 [ | +

| [ ok | [ cancel |

Figure 4-23: Select Standards Dialog Box

¢. Click to select the standards you want to use, then click OK.
d. In the Standard Curve Equation box (Figure 4-21), click Calculate Binding Rate!.

Binding rates/concentrations are calculated based on the selected standard curves.
The binding rates of the loaded standard curve will display in the results table, and
the Plate column will display the standard curve file name (Figure 4-24).

C.. Plate Sensor  Sample  Sample .. Type Binding ...
o a3 a3 N/A @ stz 160895
B o B3 B3 N/A @ stz 103574

B o1 Lloaded (3 c3 N/A @ Sta.. 052679
B v standard D3 D3 N/A @ stz 031084
B o curve  E3 E3 N/A @ stz 018615

B o @ F3 F3 N/A @ st 010902

G3 G3 NAA @ st 008135

01 H3 H3 NAA
StandardCurve fsc
StandardCurve fsc

B standardCurve fsc @ st 054122
B standardCurve fsc @ stz 031733
B standardCurve fsc @ stz 01835
I standardCurve fsc @ s 011116
[ standardCurve fsc @ stz 007166

StandardCurve fsc @ 5= 005539

StandardCurve fsc @ 5. 159669..
B standardCurve fsc @ stz 100993

\! StandardCurve fsc @ sia.. u.532u?./

Figure 4-24: Loaded Standard Curve

8. Confirm or edit the processing parameter settings (for details, see “Editing Processing
Parameters” on page 43)

- Binding Rate Equation—The curve-fitting equation that models the binding
data.

- Initial Slope—Calculates the initial slope of the acquired quantitation data
(nm/second). Choose this equation for a basic quantitation or basic quantita-
tion with regeneration experiment.
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+ Requilibrium—This equation is recommended for an advanced quantitation
experiment that includes amplification. This equation uses the calculated
equilibrium, not the initial slope, to model the data.

+ Read Time—The length of acquired data analyzed (seconds).

+ Zero Conc. Threshold—Calculated binding rates less than the zero concentra-
tion threshold are reported as zero in the results table.

+ Low Conc. Threshold—Clicking Calculate Binding rate! causes the initial rate
to be calculated using both a linear and exponential equation. The low concen-
tration threshold determines which value is reported in the results table. If the
result from a linear fit is below the low concentration threshold, then the value
from the linear fit is reported in the analysis table. If the result from a linear fit is
greater than the low concentration threshold, then the value from the exponen-
tial fit is reported in the analysis table. Changing this threshold can improve the
precision of low concentration samples.

9. C(lick Calculate Binding Rate!
The standard curve and results table display (Figure 4-25).

Standard Curve ——

i.* ForteBio Data Analysis 7.0 - Quantitation - higG ProG Q

File  Help
=

Standard Curve Equation Group View

[Linear Point to Point - Fj Options ©® Ago © Rl Refresh ‘

Load Standards... || Save Standards
‘ @ Stendard — Fitting Curve @ Unknown & Control
[] Use standards from loaded fie T
Calibrate within plate
0.360
Frocessing Parameters 0320
Binding Rate Equation.
Intial Slope - 0280
£ p240
Read Time: 12000 secs || =
2 0200
Zero Conc. Threshold: 00001 BR 5
Low Conc. Threshold: ~ 0.003 BR = 0.150
0.120
0.080
Calouiate Binding Rate! 0040
0.000
Data Export 0 22 30 4 50 6 0 [ & 0 10 10 120 120 140 150 160 170 180 10 200 210 220
Concentration (ug/mi]
[ save Faw Data...] [ Save Report.._|
hlgG ProG @1 |
Standard Sampls Alerts
Type Threshold Table Column: Known Cone. Index Known .. Dition .. C.. Sample Sensor Flate Sample. Type Binc* | X [ Log
© [MnSample 0888 ] 1 23456 789010 38 WA Ml G 1 Sample. @ Ref. 0D
o 3
© [MxResdgg [0 | |A[@@@OO00 3 NA B e H3 1 Sample .. @ Ref.. 001
- S B | 40 200 M~ Al 1 G Sa. @ Sa. 03 Binding Rate -
ieady C@O® 41 100 | K Bl 1 IgG Sta.. @ Sa.. 01
Sample Alstt D 2 50 | = c1 1 oG Sta.. @ Sta.. 0.1
@ Do not oss dlerts E a5 B o D 1 gGSa. @ Sa. 00 =
F 4 10 M = El 1 GSta. @ S 00
Save Analysis Settings g 45 5 B A Fi 1 GG Sa.. @ Sa. 0O ||§ .
4 25 G1 G1 1 a6 Sta. @ Sm. 00— L
47 1 I H1 1 IgG Sta.. @ Sw.. 00_|[|2
48 200 M 2 1 oGSta. @ Sa. 03] 15
43 100 | B2 1 oG Sta.. @ Sa. 01
50 50 B c2 1 GSta. @ Sa. 0
51 25 o2 D2 1 IgG Sta.. @ S 00 10
52 10 E2 E2 1 10G Sta.. @ Sta.. 00 _
= — 1 _ _— _— - . - - 002 003 00
< i | r Binding

Figure 4-25: Results Window for a Quantitation Experiment
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Working with Analyzed Data
On the Results window, the following parameters (see columns) define the analyzed data:

« Check boxes toggle the corresponding well’s data between inclusion and exclusion
from the data analysis:

+ To exclude a sample from subsequent analyses, deselect the corresponding bio-
sensor number in the results table and click Calculate Binding Rate! to re-ana-
lyze. Or, select one or more wells in the results table, right-click and select
Exclude Wells.

« Toinclude a sample in subsequent analyses, checkmark the corresponding bio-
sensor number in the results table and click Calculate Binding Rate! to re-ana-
lyze. Or, select one or more wells in the results table, right-click and select
Include Wells.

« Plate—A unique number assigned to individual sample plates. If a standard curve
was loaded from another experiment, the plate column will display the file name
used for the standard curve.

+ Sensor—The biosensor number.
» Index—A unique number assigned to each data point during data analysis.

- Dilution factor—The dilution factor used to prepare the assay sample. The dilution
factor is multiplied by the well concentration to determine the calculated concentra-
tion.

«  Well concentration—The concentration of the analyte determined from the stan-
dard curve. The well concentration is multiplied by the dilution factor to determine
the calculated concentration.

«  Flip—Inverts the magnitude of all data. Used during analysis of large particles where
negative signals can be observed.

+ Information—Annotations about the sample.

+ Replicate Group—A set of replicate values organized as a set to facilitate calculation
of statistics.

«  BRAVG—The average binding rate of the replicate group

«  BRSD—The standard deviation of the binding rate of the replicate group

«  BR CV—The coefficient of variance of the binding rate of the replicate group

- Concentration avg—The average concentration of the replicate group

« Concentration SD—The standard deviation of the concentration of the replicate
group

« Concentration CV—The coefficient of variance of the concentration of the repli-
cate group

+ Sensor Type—The biosensor chemistry utilized in the assay.
+ Lot Number—The lot number of the biosensor tray used in the assay

+  Sample—The well location in the sample plate.
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Sample ID—The name of the sample entered in the Octet System Data Acquisition
software.

Group Type—The well designation (Standard, Unknown, Reference, or Control).

Binding Rate—The rate of sample binding to the biosensor computed by the Octet
System Data Acquisition software using the binding rate equation specified.

Known Conc.—The user-specified standard concentration that was entered during
sample plate definition.

Calc. Conc.—The sample concentration computed from the standard curve.

Residual (%)-Residual = (Expected standard concentration—Calculated standard
concentration)/Expected standard concentration

r2 (COD)—The r? of the curve fit used to determine the binding rate.

Well Information—User-specified notes about the wells.

Cycle—Number of biosensor regeneration cycles.

Sample Plate Map

The Sample Plate Map displays well data, and can be used to select which type of results to
display. Select the type of results to display in the sample plate map (Show Table Column
drop-down list). For example, select Calc. Conc. to display the computed sample concen-
trations on the map.

Results Table

The Results Table displays detailed results for each well in the plate map. To edit table con-
tents, right click in the table and select a menu item (Figure 4-26).

Plate C.. Sensor Sample Sample.. Type Binding
ol - B4 Include Selected Rows

n e Exclude Selected Rows

01 D4

o1 E4 Set Color ..

01 F4 Set Color By Group

m - G4 Set Color By 4
o1 [ He

o AR Size Columns by Title

m - B5 Size Columns by Data

01 - c5 .

o1 05 Size Columns by Both

m - ES Select All Rows

o F5 Invert Selection

01 G5

m - H5 Order Columns ...

o - A8 Edit Sample Information ...

o [l s

0

! cs | Parallel Sorting .. [ |

Figure 4-26: Right-click Results Table Options.

Analysis results table options:
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+ Include Wells—Removes the “X” in the Include column for the selected biosensors.
Re-run the analysis to include these biosensors in the analysis.

« Exclude Wells—Adds an “X" in the Include column for the selected biosensors. Re-
run the analysis to exclude these biosensors from the analysis.

+ Set Color—Opens the color palette that enables you to choose a color for the
selected results.

+ Set Color By Group—Color-codes the results according to the groups set in the
Grouped View Options dialog box.

« Set Color By—Enables you to color-code results according to a user-selected cate-
gory from the analysis results table.

+ Size Columns by Title—Automatically sets the column width to fit the column title.
+ Size Columns by Data—Automatically sets the column width to fit the data.

+ Size Columns by Both —Automatically sets the column width to fit the data and the
column table.

+ Select All Rows—Selects all biosensors in the table and displays the data in the Fit-
ting view and graphs.

+ Invert Selection—Changes the wells status so that included wells become excluded
wells and excluded wells become included wells. You must re-run the analysis to
apply the inverted settings.

« Set Column Order —Opens a dialog box that enables you to change the order of
the table columns.

« Parallel Sorting—Allows you to sort results in parallel based on specific sorting
parameters.
Sorting Results Table Entries

The information in the results table can be sorted in ascending or descending order or in
parallel based on specific sorting parameters.

1. To sort the entries in ascending, alphanumeric order, click a column header.
2. To sort the entries in descending order, click the column header again.
3. To perform parallel sorting:

a. Right-click the Results Table and select Parallel Sorting (Figure 4-27).
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Plate C.. Sensor Sample Sample.. Type Binding
ol - B4 Include Selected Rows

n e Exclude Selected Rows

n [ b4

o1 E4 Set Color ..

01 F4 Set Color By Group

m - G4 Set Color By 4
o1 [ He

o AR Size Columns by Title

m - B5 Size Columns by Data

0 - c5 .

o1 05 Size Columns by Both

o [l Es Select All Rows

o F5 Invert Selection

0 G5

m - H5 Order Columns ...

o - A8 Edit Sample Information ...

o [l s

00 [ cs | Parallel Sorting .. [

e -

Figure 4-27: Parallel Sorting Menu

b. Inthe Parallel Sorting dialog box, select the desired sorting parameters and click OK
(Figure 4-28).

r Y
ol Parallel Sorting M

Column Name Descending
Oty o
enor :
ety o
enor :

[ OKL}J [ cancel |

A —

Figure 4-28: Parallel Sorting Dialog Box

The Results Table will re-sort based on the parameters and order selected.

Viewing Data
The Interactive Binding Graph and Group View simplify data visualization.

+ Selecting one or multiple data points either in the Binding Graph, Sample Plate Map,
Results Table, X-Y graph, or Group View highlights the corresponding wells in all
views (Figure 4-29).
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Figure 4-29: Interactive Binding Graph and Group View with Multiple Data Points Selected

+ If the data or wells selected were analyzed using different biosensors, separate bind-
ing graphs by sensor type will also display (Figure 4-30).
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Figure 4-30: Binding Graphs by Sensor Type

Octet System Data Analsyis User Guide



Analyzing Data page 65

Applying Alerts

Applying Standard Alerts

In the Results window, you can select threshold(s) that are applied to the standards. You
can also edit the alert threshold value:

. Min Sample r>—The threshold r* value for a standard or unknown binding curve. If
the r value of a standard or unknown binding curve is less than the threshold value,
the standard or unknown sample is highlighted in the results.

« Max Residual—Specifies a threshold residual value for standards. If a calculated
standard concentration deviates +10% or greater from the expected concentration,
the standard is highlighted in the results.

« Sample Alert—Specifies highlights data that fit user specified criteria. Thresholds
can be set for r2, max residual, or both.

« Both Min r2 and Max Residual—Applies both the Min Sample r2 and Max Residual
thresholds to the data.

« Do not use alerts—Select if you do not want to apply any thresholds to the
unknown or standard sample data.

To apply a standards alert:

1. Inthe sample plate map, select the type of data to display data from the drop-down
list.

2. Selectatype of alert.

Samples that do not meet the threshold are highlighted in the sample plate map and
results table.

3. Editan alert threshold value:
a. Select the cell and enter a new value.

a. Right-click the cell to display a shortcut menu of editing commands.
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Figure 4-31: Results Window—Displaying Standards Sample Alerts

Applying Sample Alerts

The Sample Alert highlights data that fit user specified criteria.

To apply sample alerts:
1.

Standard Sample Alerts
Type Threshold
* [Min Sample > [0.899

*) [Max Residual () = [10
Both Min r?and Max Residual
Sample Alert
Do not use alerts |

o

[ Save Analysis Settings ]

Figure 4-32: Sample Alerts

Set the thresholds for r2, max residual, or both (Figure 4-32).

2. Alternatively, set either a positive or negative threshold on the standard deviation of
either the binding rate or the calculated well concentration (Figure 4-33).
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a5l Sample Alert ﬁ

Sensor Type [ Protein G 2 ]

Alert based on:
@ Negative Threshold (> Average +n*SD)
() Positive Threshold (< Average n*SD)
n= 2
5D = Standard Deviation of
@ Binding Rate
() Well Concentration

[ ok | [ cance |

Figure 4-33: Sample Alert Dialog Box

Rows that match criteria specified in the “Sample Alert” are highlighted in the results
table of the quantitation experiment (Figure 4-34).

File  Help

=
Standard Curve Equation Group View —
[Linear Pairt to Paint v] Options .. @ Auto Ful Refresh

’ Load Standards... ] ’Sa\re Standards... ] .
. Standard — Fitting Curve
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Processing Parameters
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Figure 4-34: Sample Alert Results

The highlighted rows are marked in the Alert column in the analysis table (Figure 4-35).

Index -Flip Alert Plate Sensor Sample Sample ID Type
0 X 1 A4 Ad Ab1 Unknown
1 X 1 B4 B4 Ab2 Unknown
2 X 1 C4 Cc4 Ab3 Unknown
3 1 D4 D4 Ab4 Unknown
4 1E4 E4 Abb Unknown
5 1 F4 F4 AbG Unknown
[ 1G4 G4 AbT Unknown
7 X 1 H4 H4 Abd Unknown
8 X 1 A5 A5 Ab1 Unknown
9 X 1 B5 B5 Ab2 Unknown
10 X 1C5s C5 Ab3 Unknown
11 1 D5 D5 Ab4 Unknown
12 1E5 ES Abb Unknown
13 1 F5 F5 Abb Unknown
14 1G5 G5 Ab7 Unknown

Figure 4-35: Alert Column
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SAVING STANDARDS DATA

e NOTE: In Octet Data Analysis 21 CFR Part 11 software versions 8.2 and higher,
electronic signatures are added to standards data (.fsc) files.

After analysis, the standards data can be saved for use with other quantitation experiments;
to do so:

1. In the Results tab (see Figure 4-25: on page 59), click Save Standards.
2. Inthe displayed dialog box, select the file folder and enter a filename (fsc).

3. Click Save.

SAVING ANALYSIS SETTINGS

To save the analysis settings in the Results and Data Selection windows, click Save Analysis
Settings.

A Settings_DataAnalysis file (.ini or .fsd) is saved in the experiment folder. These settings are
displayed the next time the experiment is loaded.

NOTES:

e In Octet Data Analysis 21 CFR Part 11 software versions 8.2 and higher, the
Settings_DataAnalysis.ini file name extension is Settings_DataAnalysis.fsd.
Electronic signatures are also added to data analysis settings (.fsd) files.

In Octet Data Analysis 21 CFR Part 11 software versions 8.2 and higher, a his-
tory of changes made to analysis settings are also archived within the experi-
ment folder.

The Settings_DataAnalysis.ini or. fsd file is also automatically saved when you
click Calculate Binding Rate! The Settings_DataAnalysis.ini or .fsd file may
also be used during batch processing.

PROCESSING BATCH QUANTITATION ANALYSIS

In batch mode, multiple quantitation data sets may be processed without attended opera-
tion. The Octet System Data Acquisition software analyzes experiment data using the data
processing parameters in a designated Settings_DataAnalysis.ini or .fsd file. The experi-
ments in a batch can be analyzed using the same or different .ini or .fsd files. The processed
data can be saved to either the original data folder or an alternative folder.
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Creating a Settings_DataAnalysis.ini File

NOTES:

a In Octet Data Analysis 21 CFR Part 11 software versions 8.2 and higher, the
Settings_DataAnalysis.ini file name extension is Settings_DataAnalysis.fsd.
Electronic signatures are also added to data analysis settings (.fsd) files.

The Settings_DataAnalysis.ini or .fsd file is also automatically saved when you
click Calculate Binding Rate!

To create a Settings_DataAnalysis.ini or Settings_DataAnalysis.fsd file:
1. Load and open an experiment that will be included in the batch.

The Data Selection window displays (Figure 4-36).
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Figure 4-36: Data Selection Window

2. Set the data viewing options (refer to Table 4-1 on page 49).
The Results window displays (Figure 4-37).
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Figure 4-37: Results Window

3. Setthe analysis options (standard curve equation, processing parameters, standards
sample alerts). For more details, see “Analyzing Data” on page 52.

4. C(lick Save Analysis Settings.
The .ini or .fsd file is saved in the experiment folder.

5. Optional. Analyze each experiment using a different .ini or .fsd file; repeat steps1-4 to
create a file for each experiment in the batch.

Selecting Experiments and Running the Batch Analysis

@ NOTE: In Octet Data Analysis 21 CFR Part 11 software versions 8.2 and higher,
the Settings_DataAnalysis.ini file name extension is Settings_DataAnaly-
sis.fsd. Electronic signatures are also added to data analysis settings (.fsd) files.

To select experiments and run the batch analysis:
1. On the menu bar, click File > Quantitation Batch Mode.

The Quantitation Batch Model dialog box displays (Figure 4-38).
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o5l Quantitation Batch Mode ﬁ

Ini File
@ Use the one in each folder

() Use one for all folders:

Qutput Folder
@ Use the original data folder
() Use this folder:

Selected Folders Add Folders .. | | Remove Selected

Status Folder

Processing Status
|

[ Analyze Data ]

Figure 4-38: Quantitation Batch Mode Dialog Box

2. Set the batch mode options as follows:

 .inior .fsd File
+ Use the one in each folder—Analyzes each experiment using the .ini or .fsd
file found in the same experiment folder.

« Use one for all folders—Analyzes all experiments using a user-selected .ini
or .fsd file.

« Well Information—Specifies a path within the experiment folder to the Set-
tings_Wellinfo.xml file. Select only a Well Information file if you modified the
original well information by editing (for more information, see “Editing Exper-
iments” on page 40). The Settings_Wellinfo.xml file can be found in the
experiment folder of an experiment that has been edited in the Octet System
Data Acquisition software. Select a well information file if the Use one for all
folders option is selected.

+  Output Folder

+ Use the original data folder—Analysis results are saved in the experiment
folder.

« Use this folder—Saves the analysis results to a user-selected folder.
3. Click Add Folders to select the experiments for batch analysis.

4. Inthe displayed dialog box, select an experiment folder and click Add. Repeat to select
each experiment in the batch.

5. Optional. Remove experiments from the batch: select the corresponding folders and
click Remove Selected.
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Figure 4-39: Selecting Experiments for Batch Analysis

6. Click Analyze Data.

EXPORTING DATA

Raw data or quantitation result reports can be exported.

NOTE: In Octet Data Analysis 21 CFR Part 11 software versions 8.2 and higher,

s the Summary Worksheet tab of exported reports will now also include the
software name, version and the export date and time, and once a report is
exported it is locked

Saving Raw Data

To save raw data:

1. In the Results window (Figure 4-31), click Save Raw Data.
2. Inthe displayed dialog box, select a destination directory.
3. Enter afilename and click Save.

The raw data are saved as a .csv file that can be opened in a spreadsheet application
such as Microsoft® Excel® software. In Octet Data Analysis software versions 8.2 and
higher, once the report is exported, the contents of the exported xIs file are locked and
cannot be changed.
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Saving a Quantitation Results Report

All information in the results window can be saved to a report. The Octet System Data
Acquisition software generates an Excel spreadsheet (.xls file) that includes the current con-

tents of the results window:

- Calibration curve(s)

a NOTE: An exported standard curve path is displayed on the saved report on
the Standard Curve tab.

« Sample plate map that shows the user-selected type of data

« Results table

e NOTE: If multiple experiments are open, the report will include a separate
worksheet for each experiment.

To save a quantitation results report:
1. Onthe menu bar, click File > Save Report, or click the Save Report button.

The Report Selection dialog box displays; see Figure 4-40.

ol Report Selection =
Fomat: @ xs ) cav
Ini File Experiment Summary

Flate Map Standard Curve
Result Table [ % Graph

[ Select and Order Columns ]

File Name: ExcelReport

Figure 4-40: Report Selection Dialog Box

2. Select the components from the analysis to be exported, enter a file name and click
Save.

The report is saved to the data folder. In Octet Data Analysis software versions 8.2 and
higher, once the report is exported, the contents of the exported xIs file are locked and

cannot be changed.

Octet System Data Analsyis User Guide



page 74 Chapter 4: Quantitative Analysis

Changing the Column Order in a Saved Report
You can customize the columns and their order in a saved report. These customized report
settings are also saved as the default for future reports.

1. Inthe Report Selection dialog box (Figure 4-41), click Save Report > Select and Order
Columns > OK.

ol Report Selection [ = |
Fomat: @ xs ) cav
Ini File Experiment Summary

Flate Map Standard Curve
Result Table [ % Graph

[ Select and Order Columns ]

File Name: ExcelReport

G

L8 S

Figure 4-41: Report Selection Dialog Box

2. The Select And Order Columns dialog box displays (Figure 4-42). Select and order the
columns, then click OK.

ol Select And Order Columns x|

Order Columns Order Columns
Index
Plate
Calor
Sensor
Sample
Cycle
Sample ID
Type Move to Top
Binding Rate
ype Known Conc.
Binding Rate Well Conc.
Known Conc. Dilution Factor
Well Conc. Calc Conc. Move Down
Dilution Factor Residual(%)
R2

Move Up

Calc Conc.
Residual() Information
R2 Sensor Type |

Move to Bottom | |

Figure 4-42: Select And Order Columns Dialog Box

3. Inthe Report Selection dialog box (Figure 4-41), click OK. The Results tab will now dis-
play the selected columns and the desired column order.
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MASKING DATA

The Mask Data feature lets you make a copy of your data folder with all proprietary info
such as sample ID, sample info, sensor type and sensor info hidden, or ‘masked’ in both the
fmf and frd files.

NOTE: The Mask Data feature is not available in Octet Data Analysis 21 CFR
Part 11 software.

To do this:
1. In the Data Selection Tab, right click on an experiment in the folder tree.

2. Select Mask Data (Figure 4-43).

Data Selection Results

Bl Loaded Data 012t

Open Explorer ...
Remove Run

Mask Data...

Figure 4-43: Selecting Mask Data Option.

A copy of your data folder can then be saved in the desired location.

MULTI-STEP ADVANCED QUANTITATION EXPERIMENTS

The multi-step selection interface for Advanced Quantitation methods increases the flexi-
bility to add more assay steps prior to the Sample or Detection steps for all Octet systems.
In addition, all steps in an Advanced Quantitation assay may be viewed and analyzed in the
Octet Data Analysis software.

On Octet HTX systems specifically, the Advanced Quantitation application combines the
flexibility of the user-selectable Read Head with easier visualization of all the steps in a
guantitation assay, including multiple steps preceding the detection or sample step. Users
can configure the initial assay steps with pick up of 8, 16, 32, 48 or 96 biosensors separately
from the later detection steps. Analysis from 8 or 16 biosensors provides the greatest sensi-
tivity and finer signal resolution whereas data acquisition from 32, 48 or 96 biosensors pro-
vides higher throughput.

An Advanced Quantitation experiment enables you to determine sample concentration
using a reference set of standards in assays with multiple steps or dips before the Detection
step or Sample step (Octet HTX systems only). After an experiment is run, start a data analy-
sis session. The steps to analyze the quantitation data include:
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Table 4-2: Octet Data Analysis Steps for Advanced Quantitation Assays

Octet Software Functions

Data Analysis 1. Load and open the experiment data.
2. Select a standard curve equation.

3. If the experiment does not include standards, load a standards
file (fsc).

4. Confirm or set new values for the processing parameters.

5. Calculate the binding rate.

The Advanced Quantitation Analysis feature provides an easier visualization of all the steps
in the assay, including multiple steps preceding the detection or sample step.

Starting a data analysis session and viewing the raw data are explained “Working with
Experiments” on page 38.

1. After loading an Advanced Quantitation data file, open the Data Selection (Tab 1).

2. Click on a step on the right graph to show an enlarged graph for the selected step on
the left:

052213 3step IgM assay _A

[ Mign X [ Reference Subtraction Average of [ Fip Data | Show Al Traces 7] Group View e s TR T =
1.0 @ [] lgnore emors in files when loading @ Legends

Binding Curve Graph

60 —

40

nm

% » M

0 100 200 300 400 500 1] 500 1000 1500 2000 2500
Time (sec) Time (sec)

Figure 4-44: Viewing Step Graph Data

3. Click on individual sample wells from the table or plate to display individual well data:
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Figure 4-45: Viewing Well Data

4. Click on Tab 2 (Results). Analysis will be done on the selected step shown in the left
graph, with the Detection step selected as the default step. The Plate Map shows sam-
ple locations only, the Plate Table shows the selected detection step only, and the
Results Table on Tab 2 will update as a step is selected:
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Figure 4-46: Viewing Analyzed Data
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NOTE: The Sample plate and the Reagent plate are now referred to as “Plate 1”
and “Plate 2” in the software.

5.

Proceed with data analysis as described in “Analyzing Data” on page 52.
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WORKING WITH EXPERIMENTS

Starting a Basic Kinetics Experiment

A basic kinetics experiment enables you to determine the association and dissociation rate
of a molecular interaction. After an experiment is run, start a data analysis session (double-
click the icon on the desktop).

There are several ways to start a basic kinetics experiment:
+ Use the Experiment wizard.

«  Open a method file (fmf). An experiment method file (.fmf) is automatically saved
after you define and run an experiment.

+  On the menu bar, click Experiment > Templates > Kinetics.

NOTE: When using the 21 CFR Part 11 version of the Octet System Data Acqui-

@ sition software, only 21 CFR Part 11-compliant experiments and re-analyze
generated using the 21 CFR Part 11 version of the software can be opened.
Files generated using the non-compliant version of the software or with a
non-compliant system cannot be opened, and a message indicating this will
be presented.

Loading an Experiment for Analysis
A data analysis session can be used to:
+ Load and analyze an experiment.

+ Re-analyze an experiment.

To load an experiment for analysis:

1. On the desktop, click the i.# icon. Or, click the Windows Start button and select All Pro-
grams > ForteBio > ForteBio Data Analysis 7.0.

The Data Selection window displays.
2. Load an experiment:

a. Right-click the experiment folder in the workstation directory tree and select Load
Folder; or, on the menu bar, click File > Load a Folder.

b. In the Load Folder dialog box, enter the folder name or click the Browse button [--]
and select the desired folder, and then click Load.

The experiment is added to the Loaded Data directory tree (Figure 5-1).
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Figure 5-1: Data Selection Window—Loading an Experiment

3. Inthe Loaded Data directory, click an experiment name to open it.

The experiment summary appears (Figure 5-2).

@ NOTE: Multiple kinetics can be loaded, but only one kinetic can be open at a
time. The Tl icon in the Loaded Data directory tree indicates the open experi-

ment.
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Experiment information and data files (.frd)
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Figure 5-2: Data Selection Window—Displaying Experiment Summary Information

4. Optional. If any step types have been incorrectly assigned in the Octet System Data
Acquisition software, change them before beginning analysis. To do so, right-click the
step and select the correct step type from the shortcut menu (Figure 5-3).
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Figure 5-3: Changing a Step Type

5. Inthe Sensor Tray tab, confirm the biosensors to be analyzed.
The first group of biosensors is automatically selected for analysis.

Biosensors that are assigned to the same type of assay step and have the same assay
(step) times are displayed in the same color, providing convenient identification of mul-
tiple types of assays executed in one experiment and using one biosensor tray (red [
in Figure 5-4). Only biosensors of the same color processed simultaneously. This pro-
vides a convenient way to identify multiple experiments on a biosensor tray.

6. Select particular biosensors for the analysis:

a. Click a biosensor. To select non-adjacent biosensors, press and hold the Ctrl key
while you click the biosensors.

b. Select a column(s) or row(s). To select non-adjacent columns or rows, press and hold
the Ctrl key while you click the columns or rows.

¢. Draw a box around the biosensors using the mouse.

The number of biosensors selected for analysis in the current tray will be displayed
in the upper-right corner of the Sensor Tray tab.

7. Choose the Ignore error in files option when loading to load data files regardless of
whether a runtime error was identified. This enables data visualization even if a sensor
error occurred during runtime.

s NOTE: Only the selected biosensors will be available in the Processing window.
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Number of biosensors selected for analysis
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Figure 5-4: Selecting Biosensors for Analysis

Analyzing Binding Data
To analyze the binding data:
1. Start an analysis session and select the experiment(s) to use.
a. Confirm or change the biosensor and sample type selected for the analysis.
b. Process the data (compile binding curves with or without reference subtraction).
2. Analyze the binding data:

+ Curve fitting analysis—Determines the kinetic constants k,, kq and the affinity
constant K from fusing a specified binding model.

+ Steady state analysis—Determines the affinity constant Kp from the calculated
or measured equilibrium response.

3. View the results in graphical and tabular formats.

4. Export the results and generate a report.
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Editing Experiments

The Octet System Data Acquisition software enables you to change sample designations,
standard concentrations, or exclude samples from analysis. For example, you can exclude a
standard that does not meet the sample r? or residual threshold, then re-analyze the data.
You can also modify some processing parameters.

a NOTE: If you are using the 21 CFR Part 11 version of the Octet System Data
Acquisition software, editing options are disabled.

Changing Sample Designations

To change sample designations:
1. Click the Data Selection tab, then do either of the following:

+ Inthe sample plate map, select the well(s), right-click and select an option from
the shortcut menu.

+ Inthe results table, right-click a table cell in the Well Type column, then make a
selection from the drop-down menu.
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Figure 5-5: Changing Sample Designations

Excluding/Including Samples from Analysis

To toggle sample analysis in the Results window, perform one of the following tasks:

+ In the sample plate map, select the well(s), right-click and select Exclude Wells to
remove the samples from the analysis. If the selection is already excluded from anal-
ysis, select Include Wells to return the samples to the analysis.

+ Inthe results table, to exclude wells, deselect the check box in the first column or
right-click selected rows and select Exclude Wells. If the selection is already
excluded from analysis, click the check box for the desired rows or right-click desired
rows and select Include Wells.
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——
- | I
il
ave Repo higG ProA Kinetizs |
Standard Sample Aletts Table Column: Known Conc. = Index Known.. C.. Sample Sensor Plste Sample.. Binding.. WelC.. Fp =| * [C Log : [T Log
Type Threshold
. [Mn Sampler® 058 P12 3456738 9101112 N/A | I F1 1 Associa Cale.Conc. +
g A 5 N/A | kB Gl 1 Associa
Max Residual (%) + [10 B N/A B e H1 1 Associa No Data
Both Min *and Max Residual [T 1 Iole] N/A A5 2 1 Associa
D N/A BS B2 1 Associa
it E0@0(™ = 5 c2 1 Associa L
Do not use dletts FI@@@{  IncludeWells in Binding Rate Calculation Es o h nesocia 3
A1 1 Exclude Wells from Binding Rate Calculation les E2 1 Assacia
Save Analysis Settings H dit Sample Information .. Fs F2 1 Associa
—C5 G2 1 Associa
10 NA H5 H2 1 Associa
125 A Al 1 Associa
12 10 I = B 1 Associa W
135 c4 i 1 Associa
14 25 D4 D1 1 Associa %
m ] 3
Selecting wells in the sample plate map Selecting rows in the results table

Figure 5-6: Excluding Samples from Analysis
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Editing Sample Information

The following information in the table can be edited directly in the table in the Processing
Tab, under sensor selection. Just click in the cell, then type to make changes (Figure 5-7):

«  Sample D

«  Molar Conc

Exclude Well Number Well Location Type Sample 1D Description Molar Conc. nM =
T AT e |
2 B1 Buffer T KB
3 c1 unsst E
_ 4 D1 unset
_ 5 E1 unset
_ 6 F1 unset [ |
_ 7 Gl unset
_ 8 H1 unset
— ] A2 Load BPA
_ 10 B2 Load BPA
_ 1 c2 unset
— 12 D2 unset
_ 13 E2 unset
_ 14 F2 unset
— 15 G2 unset
_ 16 Hz2 unset
_ 17 A3 Buffer 1x KB
— 18 B3 Buffer Tx KB
_ 19 c3 unset
_ 20 D3 unset
_ 21 E3 unset
_ 2z F3 unset
.l 23 G3 unset il

Figure 5-7: Editing Cells in Data Table

Sample information can also be edited by right-clicking the cell in the table, then selecting
Edit Sample Properties in the right-click menu (Figure 5-8).

N EPIEREIEI BB O L
O = 30202016
B8 e %%
; [ Sample 1D @ @ @ O

[ Description:

[ Malar Canc: nM
B = Sample 4 = Reference

[ ok | [ cance |

j— A
Sensor Info || Exclude Well Mumber Well Location Type Sample ID Description Molar Car *

I | | I O ) I I

I | 2 B Buffer
I || 3 a Buffer
I - | 4 D1 Buffer 3

Figure 5-8: Edit Sample Information Dialog Box
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Closing Experiments

To close an experiment, in the Loaded Data directory tree, right-click the experiment name

and select Remove Run (see left side of Figure 5-9).

To close all experiments in the Kinetics or Quantitation folder, right-click the folder and
select Remove All (see right side of Figure 5-9).

4% ForteBio Data Analysis 7.0 - Kinetics - hgG ProA Kinetics

:.EIE

Figure 5-9: Closing a Kinetics Experiment

File  Help
() Data Selection ) Processing | [3) Aﬂﬁﬁﬁ‘
=/ Loaded Data Summary - hlgG ProA Kinetics ‘senng,ayu 1 ‘ 23 Sensors from #1
B3 Kinetics . = =
] 042711 38 K ProAhlgG CAUsers\wms\Documentis\User Guides\7.0\higG ProA Kinetics
i@
H Description: Unassigned =
& £ Quantraon L Open Explorer .. ermentTyme: KINETICS
FQ el e DateTime 412172011 5:14:11 PM
5 Remove Run
B ez chineName: RED-ALPHA-5
UserName: labuser
PlateName: 110420
PlateName2: Unassigned
Instrument Type: OctetREDZ6
* 110420_001.frd (A1) @
Assay Fow StepType  Step Assay Step Sensor -
Wl Al Tme  Rale  Name  Type Number  StepDatzMeme oy
1|  Regenerstion 10 1000 | Custom 7 Equibration 1
2 Equilibration 120 1200 Bassline 2 2 ProA Immobilization 1
3 |ProA Immobilization 600 1200 Loading 3 3 Bassline 1 -
» 4 300 ‘000 Bassline 2 4 Association 1
5 Association 600 1000 | Association ] 5 Dissociation 1
T 70 § | Dissociation 900 | 1000 Dissociaon 1 [ Regeneration 1
- 27 o eviralization stom evtralization I
04-27-11 384 K ProA hlgG 7 N l n 1000 Cu 7 7 N l 1
1. Data ] Regeneration 1
1‘ EEfE’;“E 9 Neutralization 1
| Results .
U 04-27-11 384 Q hlgG o Regeneration 1
..... j 04-27-2011 384 higG Q n Neutralization 1
-0 % 12 Equiibration 1
& 384 12| ProA Immebilization 1
----- . Acquisition T :
. Analysis
Ui higG ProA Kinetics 15 Assaciation 1
| Screen Shots 16 Dissociation 1
|\ Software 6.3 data files 17 Regenerstion |
-1 Webinars 18 E )
| Webpage
| Wikipedia 19 ProA Immoabilization 2 o
gl Music L | D
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7% ForteBio Data Analysis 7.0 - Kinetics - higG ProA Kinetics [ESREE ]
File Help
() Data Selection [ ) Processng | () Analysis|
-7 Loaded Data Summany - hlgG ProA Kinetics | Sensor Tray # 1] 23 Sensors from #1
(C:\Users\wms\Documents\User Guides\7 0\hlgG ProA Kinetics -

7 DC%D Remove All I
-3 hig

i

Figure 5-10: Removing All Kinetics Experiments from Processing

WORKING WITH RAW DATA

Viewing Raw Data

- ExpDescription Unassigned
20 ga"']“g;"]"w G ExperimentType KINETICS
§ o StartDateTime: 421201151411 PM
-~ 04272011 384 higG @ MachineName: RED-ALPHAS
UserName: Iabuser
PlateName: 110420
PlateName2: Unassigned
instrument Type: OcletREDG
= 110420_001.1rd (A1) -
hsszy  Fow  SepType  Step ‘Assay Step Sensor -
N Deta Name Time Rate Name  Type Numper  OteP DataName o Ml
1| Regeneration 10| 1000 | Custom 7 y Equibration 1
2 Equilbration 120 | 1200 | Bassine | 2 2 ProA Immobilzation i
3 |PoAlmmobiization| 600 | 1200 | loadng | 3 3 Baselne 1 L
y |4 00 | 1000 | Basine | 2 4 Association 1
5| Association 600 | 1000 |Associstion | 0 5 Dissociation 1
T 6| Dissociation 900 | 1000 | Dissociation| 1 3 Regeneration i
-1 04-27-11 384 K ProA hlgG 7| Neutslzation 10| 1000 | Custom 7 7 Neuralization | P
- Data 3 Regeneration 1
il Reference 3 Neutralization 1
Ll Results :
B 04-27-11 384 Q g6 0 Regeneration 1
- 04-27-2011 384 hlgG Q 1 Neutralization 1
| 2 Equibraton i
13| ProA Imobilzation |
). Acquisition
14 Baseine i
-y Analysis
1 hlgG ProA Kinetics 5 Association 1
-y Screen Shots 16 Dissociation 1
)\ Software v6.3 data files 7 Regeneration T
- Webinars 18 Equilbration 2
). Webpage
-1l Wikipedia 19 |ProAlmmobiization| 2 i
o) Music g 0, | '

In the Processing window, the Raw Data view enables you to conveniently examine the

binding data.

To view raw data:

1. In the Processing window, the Processing tab and confirm that the Raw Data View

option is selected.
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Selected step
% ForteBio Data Analysis 7.0 - Kinetics - higG ProA Kinetics = | B e
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C1-(F1) EIR K3 I Uicand . SA(Strepta e —
D1-(F1) c1 [ Ligand .. SA(Strepta...
é‘]'_ El) o [ Ligand .. SA(Strepta E S S S
El Ligand .. SA (Strepta. =
Step 2. Subtraction F1 Ligand ... SA (Strepta... f—
@ Reference Wels a1 [ P
O Perale Reference Sensors i [50 Ligand 0 400 80D 1200 1600 2000 2400 2800 3200 3600 4000 4400 4800 5200
Double Reference Az Ligand Time (sec)
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=] L ] ey e
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Step 4. [9] Interstep Comsction () Alanby End Point @) Al Aigned to One Siep l ] l
© Aign to Dissociation All Steps Aligned by step Equilibration (Sensor Location) itep selected: Equilibration (Sensor Location, Well Location

©) Mign to Baseline

Step 5: Process
Savtzky-Golay Fitering

Step B: View Results = -
© Processed Results b 200 400 600 200 1000
© Sensor Summary Time (sec)

© Repott Points

Step 7: Save Results A1 Al e B Bl == G1C1

ek
{

Save Processed Data h i i = D1,01 E1,E1 F1,F1

0 500 1000 1500 2000 2500 3000 3500 4000 4500 5000 -1, C1 I HT A2, A1

Timeees) —s mmcior 0200
— A1 mm B mm= G e D E1 Fl mem G e Hi - E F2,F1 G2, Gi
A2 wmm 57 wmm 2 D2 w=m E2 F2 G2 === H2 - HZ, H1
Raw data from all steps (displays all biosensors Raw data from selected step (displays all bio-
by default) sensor data for the selected step by default)

Figure 5-11: Processing Window—Raw Data View Selected

2. View the step data and align the binding curves (click a step bounded by i i linesin
the Raw Data chart).

e NOTE: The i i lines represent individual assay steps. Populate the step charts
(below) with detailed views of an individual step by clicking inside the step
boundaries.

The “All Steps Aligned by step xx” chart displays all of the assay data aligned by the step
selected in the Raw Data chart (Figure 5-12).
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Selected biosensor Selected step
7% ForteBio Data Analysis 7.0 - Kinetics - hlgG ProA Kirfetics == =
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’B\}: ;; — 1 | Ui e 0 — q o
C1-(F1) (=] § 81 I Ug=nd .. SA (Strepta {
D1-(F1) cl [0 Ligand ... SA (Strepta 1
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D ociation e [ - i —A1 B = C1
Time Range (sec): o o G
From: 02| To- 04 @ Aign by Begin Point (@) Al Steps Aigned () Align All Baseli
@ Aign in Poirt ) eps arec L Algn AlBaseines ) ghow Step Dividers | Export Aligned Step (s files) Quantitate Selected Step
Stop & [3] Interstep Comecton | 0 Mignby End Fort @ Al Aigned to One Step ][ J
@ Algno Dissociation All Steps Aligned by step Equilibration (Sensor Location) itep selected: Equilibration (Sensor Location, Well Location

@ Alignto Baseline

Step 5: Procsss
Savitzky-Golay Fitering

0
0

Step 6: View Resuits

© Processed Resulis £
© Sensor Summary 120
@ Report Poirts

080

Step 7: Save Resuits

Save Processed Data 040 r

om0 H .
0 500 1000 1500 2000 2500 3000 3500 4000 4500 5000 0 200 400 600 800 1.000
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(= = o =
All step data for biosensor C1 Selected step data for biosensor C1

Figure 5-12: Processing Window (Raw Data View)—Displaying Data from a Single-Selected Biosensor
(c1)

3. Select which biosensor data to display:

« To view the data from a selected biosensor, click the biosensor in the table.
The step charts will display all of the binding data for the selected biosensor and the
data from the selected step aligned starting aty = 0.

« Todisplay data from multiple biosensors in the step charts, select the biosensors
in the Sensor location list.

« To select a contiguous block of biosensors from the list, hold down the Shift key
and click the first and last biosensors in the group.

+ To select non-contiguous biosensors, hold down the Ctrl key and click the
desired biosensors.

+ Toinclude all biosensor data in the step charts, click Show All Sensors.
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Sensorlocation  Color  Sensor Sensor Type Sensor Info Sensorlocation  Color  Sensor Sensor Type Sensor Info
Al B o Sensor SR (Streptavidin I ioand Sersor S (Streptavidin)
B - Ligand Sersor  SA (Streptavidin) B1 - Ligand Sensor ~ SA (Streptavidin)
C [ ligand Sensor A (Streptavidin) [ | annd S (Stmmamdf”)
M - Ligand Sensor  5A (Streptavidin) o B Ligand Sersor S (Sreptavidn)
) . Ligand Sensor SA (Streptavidin)
El Ligand Sensor SA (Streptavidin) A )
) N F1 Ligand Sensor SA (Streptavidin)
Fi Ligand Sensor  SA (Streptavidin) )
; G1 - Ligand Sensor
G1 - Pgand Sensor H1 - Ligand Sensor
H1 - Ligand Sensor A2 Ligand Sensor
A2 Ligand Sensor B2 I icand Sensor
B2 - Ligand Sensor c2 - Ligand Sensor
c2 - Ligand Sensor o2 Ligand Sensor
D2 Ligand Sensor E2 I icand Sensor

Figure 5-13: Selecting contiguous (left) and discontiguous (right) biosensors in the Sensor location list.

4. Align the data (select an alignment option):

+ Show All Steps Aligned—Aligns all steps. Aligns baseline steps and association
steps to the start of the step. Aligns all dissociation steps to the end of the step.

- All Aligned to One Step—Enables the following options:

« Align by Begin Point—Aligns the displayed curves to the start of the cur-
rently-selected step.

« Align by End Point—Aligns the displayed curves to the end of the currently-
selected step.

+ Align All Baselines—Aligns all steps according to the baseline step data.

Exporting Raw Data
To export raw data:
1. Click Export Aligned Step (.csv files).

2. Inthe displayed dialog box, navigate to a destination directory, enter a filename, and
click Save.

Quantitating Raw Data
To quantitate raw data from a selected step:

1. In the Raw Data view, select the step to quantitate and click Quantitate Selected Step
(Figure 5-14).
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% ForteBio Data Analysis 7.0 - Kinetics - hlgG ProA Kinetics l=|® B
File  Help
Data Seiection Processing Anatysis |
¥ Scale Report Poirts
Step 1: Data Selection ’ .
: Time Poirts Click on a step below to align traces
® 100 Edit Legends ...
@ Raw Data View Show Al Sensors i ] U= 20 aversce e
Sensor Selection
Sensors to be Analyzed Sensorlocation C.. Sensor  SensorType Sensorinfo * Raw Data (Sensor Location)
Qli Q{ = B B Ugend . SA(Stepta N
C1oF) (=[] &1 B ligond .. SA (Strepta. H
D1-(F1) c1 [ Ligand ... SA (Strepta !
g2-0 o [ lgand .. SA(Strepta i
£l lgand .. SA(Strepta || £ i
Step 2: (7] Subtraction F1 ligand .. SA (Strepta i
@ Reference Wels G1 B Lig=nd !
Parallel Refersnce Sensors H1 B Ligand H
© Double Reference ™ Ligand ! 1 ! L 1 ! ! : :
©) Average Reference Sensors B2 B Ucond L4 o 400 800 1200 1600 2000 2400 2800 3200 3600 4000 4400 4800 5200
Time (sec)
cz Ligand M
Step 3: [7] Align ¥ A 1 L L nformation e
z - —
Time Range (sec). T r——

This will quantitate the currently selected step ‘Equilibration’ and close this file

i
@ D tt 47
= le: E; g‘;‘:‘:‘l’“ 2 ﬁ ©yeuwant o praces: Quantitate Selected Step

From: 0.2 To: 04

Step 4: [7] Interstep Comection
@ Align to Dissociation
Mign to Baseline

(Sensor Location, Well Location

220 060 I

Step 5: Process A7) i
Savitzky-Golay Fitering — | 0.50 i

'

H

i

i

i

i

Step 6: View Resutts

.
|
|

ZDDI

{

|

|

Processed Results g 160 o0
Sensor Summary 120 1
Report Points 020

Step 7: Save Results

Save Processed Data 040§
H

0 500 1000 1500 2000 2500 3000 3500 4000 4500 5000 0 200 400 600 800
Time (sec) Time (sec)
[an —en o

1.000

Figure 5-14: Processing Window—Raw Data View—Quantitating a Selected Step

2. In the system prompt that displays, click Yes to proceed with the quantitation.

The selected step data is displayed in a quantitation window (Figure 5-15). By default,
samples with defined concentration values are designated as standards and samples
without defined concentration values are designated as unknowns.

e NOTE: In quantitation mode, sample information can be modified.

For more details on viewing the quantitation data, see “Viewing Binding Curves” on
page 48.
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Figure 5-15: Quantitation Window—Displaying Selected Step Data from a Kinetic Assay

e NOTE: When step data from a kinetic assay is open, additional quantitation
experiments cannot be opened.

3. Inthe Results window, select a standard curve equation, set the processing parameters,
and then click Calculate Binding Rate!

The binding rates will be calculated and displayed; see Figure 5-16.

For more details on analyzing quantitation data, see “Loading an Experiment for Analy-
sis” on page 80
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Figure 5-16: Results Window with Calculated Binding Rates

>

NOTE: To return to kinetics analysis mode, reload the kinetics experiment data
(in the Loaded Data directory tree, click the experiment).

PROCESSING KINETIC DATA

The Processing window provides tools for correcting binding curves using different refer-
ence subtraction and alignment options.The data processing steps specify how to refer-
ence the data and produce the final binding curves (processed data).

Step 1: Sensor Selection

When a kinetics experiment is opened for the first time, the sensor tray map depicts all
active biosensors as ligand biosensors (biosensors with immobilized ligand). If the experi-
ment included reference biosensors (biosensors without immobilized ligand), you must
specify their location in the sensor tray map. If the experiment included reference buffer
wells (to correct for system drift), you must specify their location in the sample plate map.
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Working with the Sample Tray Map and Sensor Tray Map

To use the sample tray map and the sensor trap map (Figure 5-17):

1. Hover the cursor over a biosensor or sample to display a tooltip with information about
the item.

2. Click a biosensor or sample to highlight the associated row in the corresponding table
at the bottom of the window.

3. Optional. Copy the sensor tray map or sample plate map to the system clipboard, right-
click the map and select Copy to Clipboard.

The clipboard contents can be saved as a graphic file for drawing applications.

Selecting Biosensors

To select biosensors:

1. Inthe Step 1: Data Selection pane, select the Sensor Selection option (Figure 5-17).

Data Selection:
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§
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Figure 5-17: Selecting Biosensors in the Processing Window
2. Specify reference biosensors:

a. Inthe sensor trap map, select the appropriate biosensors.

b. Right-click and select Change Sensor Type > Reference Sensor (Figure 5-18).
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Figure 5-18: Changing the Biosensor Type

@ NOTE: The biosensor designations can also be edited in the sensor tray table
(Figure 5-17: on page 96).

3. Specify reference wells:
a. Inthe sample plate map, select the appropriate wells.

b. Right-click and select Change Well Type > Reference Well (Figure 5-19).
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Figure 5-19: Specifying Reference Wells

4. Exclude wells from analysis:
a. Inthe sample plate map, select the wells.

b. Right-click and select Exclude Wells for Analysis (Figure 5-19).

Step 2: Reference Subtraction

Reference subtraction is optional and is not required for all applications. There are two
types of references used in Octet experiments: reference biosensors and reference wells.

- Reference biosensors—Used as a references throughout the entire assay; for exam-
ple, biosensors without active capture molecules.

+ Reference wells—Contain only assay buffer, and are used to measure system drift.

To apply reference subtraction during data processing:
1. Inthe Step 2:[ | Subtraction pane, select the Subtraction method.

The subtractions that will be executed (based on the subtraction method, biosensor
designation and sample plate well designation) are listed in the Sensors to be Analyzed
box.

If the subtraction method is not compatible with the sensor tray map and the sample
plate map, a question mark is displayed in the Sensors to be Analyzed box.

2. Confirm the biosensor subtraction in the Sensors to be Analyzed box.
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Figure 5-20: Confirming the Reference Well is Subtracted from the Sample Wells

If an experiment includes reference biosensors and reference wells, the Octet System Data
Acquisition software offers multiple reference subtraction methods for data processing:

+ Reference Wells—Corrects binding data for system drift. For example, drift is mea-
sured by the interaction of the immobilized biosensors with the assay buffer. This
method requires at least one row of reference wells in the sample plate. If more than
one row of reference wells is selected (checked), the signals are averaged and the
average signal is subtracted from the samples.
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Figure 5-21: Reference Wells—Subtraction Method where Biosensor H1 is the Reference

« Parallel Reference Sensors—Corrects data for system artifacts or non-specific bind-

ing of the sample to the biosensor surface. This method requires one reference bio-

sensor for each ligand biosensor.
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Figure 5-22: Parallel Reference Sensor—Reference Subtraction Method

+ Double Reference—Corrects the binding data for signal due to system artifacts,
non-specific binding, and system drift. This method requires one reference biosensor
per ligand biosensor and one or more rows of reference buffer in the sample plate.
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Figure 5-23: Double Reference Subtraction Method

NOTE: In Figure 5-23, A1-A3=Target biosensor A1 corrected by reference bio-
e sensor A3, both probing reference wells B1-B3=Target biosensor B1 corrected
by reference biosensor B3 for biosensor and microplate well artifacts, both probing pos-
itive sample. (B1-B3)-(A1-A3)=Double reference subtraction fully corrects for biosen-
sor and microplate well artifacts and the effect of sample media.

+ Average Reference Sensors—Corrects the binding data using either a single refer-
ence biosensor or the average signal of multiple biosensors.
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Figure 5-24: Average Reference Sensors Subtraction Method

% NOTE: In Figure 5-24, AB1-(A1+A2+A3+A4)/4 = Target biosensor B1 corrected for
sample medium interference by the average of all reference biosensors.

Step 3: Align Y Axis

In order to fit curves correctly, they must be aligned to a common reference point upon
both the X and Y axes:

+ Alignment along the X axis is achieved during assay due to the parallel movement of
all biosensors.

« Alignment along the Y axis is achieved using Align Y Axis by specifying both a step
and time with which to execute the alignment.

The time range from the specified step will be used to calculate an average and that aver-
age will then be set to y=0. For example, for alignment to the baseline, select baseline and
specify the time within the baseline step to set to an average y = 0.

To align to association:
1. Select the Align Y Axis option and make a selection from the Step drop-down list.

2. Confirm the time range defaults or enter new start and finish times. If you choose to
align to the association step, set the shortest time range possible at the beginning of
the association step to align Y=0.
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Figure 5-25: Aligning the Y Axis

e NOTE: The time window should be minimized to the beginning of the associa-
tion. The data within this window is set to an average of zero and cannot be
included in the final curve fit.

Step 4: Interstep Correction

The interstep correction feature corrects misalignment between two steps due to system
artifacts.

0 IMPORTANT: For the most effective interstep correction, the baseline and dis-
sociation steps of an assay cycle must be performed in the same microplate
well.

- Align to Association—Moves the baseline step on the Y axis to align the end of the
baseline with the beginning of the adjacent association step.

- Align to Dissociation—Moves the association step on the Y axis to align the end of
the association step with the beginning of the adjacent dissociation step.

- Align to Baseline—Moves the association step on the Y axis to align the beginning
of the association step with the end of the adjacent baseline step.
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e NOTE: Interstep correction is not recommended for very fast kinetics because
some kinetic information may be lost.

Step 5: Process

Savitzky-Golay filtering removes high-frequency noise from the data. Its use is optional, but
is recommended unless the data being analyzed has less than 20 data points in a step.

To process the data (select and confirm the biosensors to analyze):

1. Apply Savitzky-Golay filtering by clicking the Savitzky-Golay Filtering check box; see
Figure 5-26.
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Figure 5-26: Selecting and Confirming the Biosensors to Analyze

2. Click Process Datal.
The processed binding curves are displayed with “Raw”, “Align-Y” and “Align-" windows.

The processing parameters are automatically saved to the Settings_DataAnalysis.ini or
Settings_DataAnalysis.fsd file in the data folder.

@ NOTE: In Octet Data Analysis 21 CFR Part 11 software versions 8.2 and higher,
the Settings_DataAnalysis.ini file name extension is Settings_DataAnaly-
sis.fsd. Electronic signatures are also added to data analysis settings (.fsd) files.

The processing parameters may also be saved by clicking Save Proc. Parameters.
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These processing settings are displayed the next time the experiment is loaded.
The processed results (Figure 5-27) include:

« Raw Data—Binding curves with no reference subtraction.

+ Subtracted Data—Binding curves after the user-specified reference subtraction
method is applied.

« Align Y—Binding curves after user-specified Y alignment.
+ Align X—Binding curve association steps aligned at the same time point.
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Figure 5-27: Processed Results View

3. Click Save Proc. Parameters to save the process settings.

A Settings_DataAnalysis.ini or Settings_DataAnalysis.fsd file is saved in the experiment
folder. These processing settings are displayed the next time the experiment is loaded.

Step 6: Viewing Results

The Octet System Data Acquisition software provides multiple display options (Figure 5-28)
for processed data:

+  “Processed Results” on page 107
+ Sensor Summary

+ Report Points
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Step 6: View Results
@ Processed Results
(71 Sensor Summary
71 Report Points

Figure 5-28: Options for Viewing Results

Processed Results

«  Double-click a graph to display it in a separate window (Figure 5-29).

« Hover the cursor over a curve to highlight the curve and display a tooltip of the time
(X axis) and nmshift (Y axis) at that point (Figure 5-29).

+ Customize the graph by right-clicking the graph for a shortcut menu of display
options (Figure 5-30).

« Customize the curve display, right-click the curve for a shortcut menu of display
options (Figure 5-30).

NOTE: The same display options are also available for binding charts in the
Fitting and Residual views in the Analysis tab.
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Figure 5-29: Double-click a Binding Chart to View it in a Separate Window
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Figure 5-30: Binding Chart—including Toolbar and Data Grid

Sensor Summary

The Sensor Summary view displays the binding charts generated during data processing
(Figure 5-31).

The Sensor Summary view controls enable you to select the sensor data to display:
+ Hover over a binding curve displays a tooltip with sample data.

+ Click a sensor tab or one of the arrow buttons |4 4 » »l inthe Sensorgrams controls
at the bottom of the window to view data for a specific biosensor.

« Set the number of sensorgrams per row and the number of rows to display.

+ Use the Top View check boxes to show or hide the raw data and subtraction graphs
in the top row.
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Figure 5-31: Processed Data in the Sensor Summary View

>

NOTE: In Figure 5-31, the data were processed using the Reference Well sub-
traction method.

Report Points

The Report Points view displays the raw binding data in tabular format (Figure 5-32). Report
point analysis can also be performed in the Analysis window; the data will be added to the
Report Point Analysis table.

>

NOTE: Click a sensor tab at the bottom of the binding chart to view data for a
particular biosensor.
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Figure 5-32: Report Points View of Processed Results

Report Point Analysis Features

Input times after beginning of Association Step—The Octet System Data Acquisi-
tion software measures the sample binding (nm shift) at Time 1 (within the associa-
tion step) and Time 2 (within the dissociation step). Both time points refer to time in
seconds after the beginning of the association step. You can edit Time 1 or Time 2.

Use 20 point average—Each reported nm shift in the table represents an average of
20 data points centered around the time point specified.

Apply—If you modify Time 1 or Time 2, click Apply to re-analyze the sample binding
of the active ligand biosensor at the new time points. Report points can also be
determined in the Analysis window.

Apply All—If you modify Time 1 or Time 2, click Apply All to re-analyze the sample
binding of all ligand biosensors at the new time points.

Export File (.txt)—Opens a Save As dialog box so that you can save the Report Point
Analysis table.

Results Information

Sensor Location—Ligand biosensor location.
Sample Location—The well location of the sample in the sample plate.

Sample ID—User-specified ligand biosensor information.
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+ Concentration (mM)—Sample concentration.

+ Time 1 (sec)—Time at which the first binding measurement is acquired.

« Binding 1 (nm shift)—The binding signal at Time 1.

» Time 2 (sec)—Time at which the second binding measurement is acquired.

+ Binding 2 (nm shift)—The binding signal at Time 2.

Step 7: Saving Results and/or Processing Parameters

@ NOTE: In Octet Data Analysis 21 CFR Part 11 software versions 8.2 and higher,
a history of changes made to analysis settings are also archived within the
experiment folder.

In this step, you can save the following parameters:
- Rawdata

« X,Y data for the curves in the final Processed Results graph to a file format that can be
imported to third party applications like Scrubber2 from BioLogic Software.

+ Processing parameter settings. The processing parameters are set to the saved val-
ues the next time the experiment is loaded.

+ Binding chart

To save the processed data:
1. Click Save Processed Data (Figure 5-33).
2. Inthe displayed dialog box, select a destination folder and click OK.

The Octet System Data Acquisition software generates a separate file (.xls) for each bio-
sensor that includes the time, nm shift and sample concentration for each processed
curve. This file is suitable for import into third party applications.

To save the raw data:
1. Click Save Raw Data (Figure 5-33).
2. Inthe displayed dialog box, select a destination folder and click OK.

The Octet System Data Acquisition software generates one file (.xIs) that includes time
and nm shift data for all of the biosensors.

To save the processing parameters:
1. Click Save Proc. Parameters (Figure 5-33).

The processing parameter values are saved as an .ini file in the experiment folder.
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Step 7: Save Results

[ Save Processed Data

[ Save Raw Data

[ Save Proc. Parameters

Figure 5-33: Save Results Options

To print or copy a binding chart:

1. Right-click the chart and select Toolbar (Figure 5-34) to access the printing and copy-
ing buttons (the buttons will appear at the upper left of the binding chart).
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Figure 5-34: Binding Chart Shortcut Menu

2. Select the desired command:

k+ Opens a dialog box that enables you to save the chart in several different for-

mats ((cfx, txt [data only], xml [properties only], bitmap, or metafile).

. Opens a dialog box that enables you to copy the chart in several different for-
mats (data only, bitmap, or metafile) to the system clipboard.

. f;.u Opens a dialog box that enables you to print the chart.

KINETICS ANALYSIS

In the Analysis window, two types of kinetics analysis are available:
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- Curve fitting—Determines the kinetic constants k,, k4 and the affinity constant Kp
by fitting the data to a specified binding model.

- Steady state analysis—Determines the affinity constant Ky from the calculated or
measured equilibrium response.

@ NOTE: In Octet Data Analysis 21 CFR Part 11 software versions 8.2 and higher,
a history of changes made to analysis settings are also archived within the
experiment folder.

Curve Fitting Analysis

To analyze the processed kinetic data, specify the curve fitting options:
+ Stepsto analyze

+  Curve fitting model

- Type of fitting (local or global) to apply to the data

« Step time to analyze

Curve Fitting Kinetics Analysis Options

+ Steps to Analyze—Select the step(s) to include in the analysis: association, dissocia-
tion, or both.

+ Association only—Generates k.
- Dissociation only—Generates kg;s.
 Association & dissociation—Generates kg, kons Kgiss and Kp,
«  Model—The mathematical model that is used to generated the fitted view.

+ 1:1 Model—Fits one analyte in solution binding to one binding site on the sur-
face

+ 2:1 (HL) Model—Fits the binding of one analyte in solution to two different
binding sites on the surface. Kinetic parameters are calculated for two interac-
tions (Kon1, konar Kdis1- Kgisar K1, Kp2)- You can assign % Kp1 and Kp2 contribu-
tions to interactions in the 1:2 heterogeneous ligand model. For more details see
page 116.

- 1:2 Bivalent Analyte Model—Fits the binding of one bivalent analyte to a
monomeric immobilized ligand. Kinetic parameters are calculated for two inter-
actions (kon1, konar Kdis1- Kdis2 Kp1: Kpz)- The model is available in the Analysis
tab—Model menu—in Kinetics mode.

« Mass Transport—A Heterogeneous Ligand model that fits the binding of the
analyte taking into account two steps: 1) transport of the analyte from the bulk
solution to the surface, and 2) molecular interaction of the analyte with the
ligand.
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- Fitting-Local— If this option is selected, the Octet System Data Acquisition software
computes kinetic constants for each curve. The constants that are calculated depend
on the steps that are analyzed (association only, dissociation only, or association and
dissociation).

+  Full—If this option is selected, the Octet System Data Acquisition software

assumes that the off rate eventually reaches the pre-association baseline and
forces the curve fit to that point.

- Partial—If this option is selected, the Octet System Data Acquisition software
does not assume the dissociation will reach the pre-association baseline.

- Fitting-Global (Full)—If this option is chosen, an analysis includes all of the binding
curve data in the group and the Octet System Data Acquisition software generates
kinetic constants for the entire group. The kinetic constants that are calculated
depend on the model selected.

« By Sensor—Groups all data from one biosensor (for example, Biosensor A1)
together and applies a global fit to the group.

+ By Color—Groups all data that is the same color and applies a global fit to that
group. For more details on defining colors by sample attributes, see “Working
with the Analysis Results Table” on page 133.

«  Rmax Unlinked option for Global Fitting—When fitting data, the theoretical
response maximum (Rmax) can be calculated assuming equivalent surface capacity
between biosensors (Rmax linked) or non-equivalent surface capacity between bio-
sensors (Rmax unlinked).

+  Window of Interest (From Start of Step)

« Association—The time range of the association step data to analyze.
- Dissociation—The time range of the dissociation step data to analyze.

+ Use Entire Step Times—Analyzes the entire time duration of the selected
step(s).
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Figure 5-35: Analysis Window

Assigning Kp1 and Kp2 % to Interactions in the 2:1 Heterogeneous Ligand Model

To assign Kp1 and Kp2 % contributions to interactions in the 2:1 heterogeneous ligand
model (Figure 5-36):

D Cycle Conc. {nM) Response KD (M) @ KD2 @i"D KD Emor KD2 Emor kon({1/Ms) konZ kon Emor kon2 Ermor kedis(1/5)

1 2 0.8469 <1.0E-12 2.014E-10 5813609 1176E0% 2877805  1.100. 4 503E06 3.583E06 <1.0E07

1 500 22963 <1.0E-12 64 8.730E-08 36 4938E-10 1104609 2430805 1077 7697203 1.123E05 <1.0E07

1 250 22932 <1.0E-12 64 1.096E-08 36 <10E-12  6908E-10  3.089E05  1.027 4739E03 4.879E04 <1.0E07

1 139 0.2672 <1.0E-12 58 <1.0E-12 42 400BEDE 5639, <10E07

1 125 21024 <1.0E-12 58 2.385E-08 42 <1012 2478E0S  6524E05 3377 1.732E04 2.285E04 <1.0E07

1 625 19716 <1.0E-12 57 1.544E-08 43 <10E-12  4459E09  6.B06EDS  4.955. B.540E04 1.364E05 <1.0E07

1 313 1701 <1.0E-12 53 B.B41E-08 47 6607E-10 5567E09  7705E05 5335 1.833E05 2.346E05 <10E07

1 279 03723 <1.0E-12 50 <1.0E-12 50 3517E06 3517 <1.0E07

1 223 1.2987 <1.0E-12 50 3.816E-09 50 5466E-09 9542ED9  538BE05  5.066 4 629E05 5.019E05 <1.0E07

1 557 05175 <1.0E-12 50 <1.0E-12 50 1467ED6 1475 <10E07
bl 1 0 0.1596
1 01741

Figure 5-36: Kp1 and Kp2 % contributions

Save the % contribution amount as a separate column in the Data Table in the Analysis tab:
o Kpl%=
« Kp2%=
The interaction that contributes to a higher percentage of the total interaction will be auto-
matically assigned as Kp1.
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Excluding Data from Analysis

@ NOTE: In Octet Data Analysis 21 CFR Part 11 software versions 8.2 and higher,
whenever you exclude/include wells for analysis, this action is now logged in
the Audit Trail.

To exclude data from the analysis:
1. Inthe table:
a. Select the biosensor data (rows) to exclude:

+ To select adjacent rows, hold down the Shift key while you click the first and
last row in the selection.
+ To select non-adjacent rows, hold down the Ctrl key while you click the rows.
b. Right-click the selected row(s), and select Exclude Wells (Figure 5-37) or press the

space bar. Press the space bar again to toggle the include/exclude status of the
curve.

Biosensors that will be included in the analysis have an “X” in the Include column;
excluded biosensors do not (Figure 5-37).
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Figure 5-37: Excluding Wells from the Biosensor Table
2. Click Fit Curves!
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The analysis results are displayed; data from wells marked for exclusion will not be
included (Figure 5-38).
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Figure 5-38: Analysis Results Table

3. Save the settings in the Analysis window: click Save Data Analysis Parameters

(Figure 5-39).

A Settings_DataAnalysis.ini file is saved in the experiment folder. These settings are

displayed the next time the experiment is loaded.

@ NOTE: The Settings_DataAnalysis.ini file is also automatically saved when

you click Fit Curves!
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Figure 5-39: Save Data Analysis Parameters Button—Analysis Window

Steady State Analysis

To analyze the processed kinetic data:

1. Set the analysis options (for more details, see Table 5-1 on page 154).

2. Click Calculate Response! to display the analysis results. For more information on

viewing results, see “Kinetics Analysis Results” on page 124.

Excluding Data from the Analysis

To exclude specific data from the analysis, remove the check mark next to the row in the
analysis results table. Or, right-click the selected row(s) and select Exclude Wells.

Steady State Kinetics Analysis Options

+ Requilibrium—Fits the binding curve to a 1:1 model and uses the calculated Req to
determine the steady state affinity. If this option is selected, you first must perform a
curve fitting kinetic analysis.

+ Response—Takes the average response from the user-specified time window and
uses it to calculated the steady state affinity.
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+ Average from—The of amount of equilibrium state data to analyze, from the
time equilibrium was reached to the time at which the response should be calcu-
lated.

PROCESSING BATCH KINETICS ANALYSIS

In batch mode, multiple kinetic data sets may be processed without attended operation.
The Octet System Data Acquisition software analyzes experiment data using the data pro-
cessing parameters in the Settings_DataAnalysis.ini or .fsd file. Batch mode processing may
be performed using either a single or multiple .ini or .fsd files.

During batch processing, sample well and sensor information may be substituted with new
text, a useful feature if the naming convention requires editing after data acquisition.

« Sample Well information, which includes Well Type, Sample ID, Description and
Molar concentration, can be replaced during batch processing by specifying a Set-
tings_Wellinfo.xml file during batch processing.

« Sensor information as well as some sample information, which includes Sensor Type,
Sensor Info, Sample ID and Molar Concentration can be replaced by specifying a Set-
tings_Tablelnfo.xml file during batch processing.

+ If both Settings_Welllnfo.xml and Settings_Tablelnfo.xml are specified, then the
Sample ID and Molar Concentration values from Settings_Tablelnfo.xml are used
during batch processing while the corresponding information from Set-
tings_Tablelnfo.xml is ignored.

Creating a Kinetic Settings_DataAnalysis.ini File

e NOTE: In Octet Data Analysis 21 CFR Part 11 software versions 8.2 and higher,
the Settings_DataAnalysis.ini file name extension is Settings_DataAnaly-
sis.fsd. Electronic signatures are also added to data analysis settings (.fsd) files.

To create a kinetic Settings_DataAnalysis.ini or Settings_DataAnalysis.fsd file:
1. Load and open a kinetic experiment that will be included in the batch process.
2. Click the Processing tab.

3. Enter processing parameters. (For more details see “Processing Kinetic Data” on
page 95).

4. Click Process Data!.
5. Click the Analysis tab.

This creates a Settings_DataAnalysis.xml file in the experiment folder.
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e NOTE: To batch process data sets with individual .ini or .fsd files, create an .ini
or .fsd file for each experiment in the batch.

Creating a Kinetic Settings_WellInfo.xml File (Optional)

To create a kinetic Settings_Welllnfo.xml file:

1. Load and open a kinetic experiment that will be included in the batch process.
2. Click the Processing tab and select Sensor Selection.

3. Inthe sample plate map, right-click a well and select Edit Sample Properties.
4

Enter the new information for Well Type, Sample ID, Description and Molar Concen-
tration, and then close the dialog box.

5. Click Process Data! or Save Proc. Parameters.

The Settings_Welllnfo.xml file is saved to the experiment folder.

Creating a Kinetic Settings_Tablelnfo.xml File (Optional)

To create a kinetic Settings_Tablelnfo.xml file:

1. Load and open a kinetic experiment that will be included in the batch process.
Click the Processing tab.

Enter processing parameters.

Click Process Data!

vk wN

Click the Analysis tab.

The Settings_Tablelnfo.xml file is saved to the experiment folder.

NOTE: If there is an existing Settings_Tablelnfo.xml file in the experiment
folder, it will be overwritten. The original Settings_Tablelnfo.xml file that
contained information entered during data acquisition is deleted.

6. Right-click the analysis table and select Edit Sample/Sensor Information.

7. Enter the new information for Sensor Type, Sensor Info, Sample Info and Molar Con-
centration, and then close the dialog box.

The Settings_Tablelnfo.xml file is saved to the experiment folder.
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Selecting Experiments and Running the Batch Analysis

@ NOTE: In Octet Data Analysis 21 CFR Part 11 software versions 8.2 and higher,
the Settings_DataAnalysis.ini file name extension is Settings_DataAnaly-
sis.fsd. Electronic signatures are also added to data analysis settings (.fsd) files.

To select experiments and run the batch analysis:
1. Select File > Kinetic Batch Mode.

The Quantitation Batch Mode dialog box displays (Figure 5-40).
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Figure 5-40: Kinetics Batch Mode—Quantitation Batch Mode Dialog Box

2. Setthe batch mode options:
+ Use the one in each folder—Analyzes each experiment using the .ini or .fsd file
found in the same experiment folder.

+ Use one for all folders—Analyzes all experiments using a single .ini or .fsd file
that is selected by the user.

«  Well Information—Specifies a Settings_Wellinfo.xml file in the experiment
folder that contains four types of sample information:

+ Well Type

« Sample D

+ Description

« Molar Concentration
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This feature can be used to edit sample information after data acquisition. It is use-
ful, for example, if naming conventions (within a project) change over time and the
sample information used during data acquisition requires updating.

+ Select a Well Information file only if you edited an experiment in data analysis.
For more information about editing an experiment, see “Editing Experiments”
on page 40. A Settings_Wellinfo.xml file will be put in the experiment folder
of any experiment that has been edited in the Octet System Data Acquisition
software.

- Select a well information file if the Use one for all folders option is selected.
If no .xml file is specified, the well information from the original data acquisition file
will be utilized.
« Table Information—Specifies a Settings_Tablelnfo.xml file in the experiment
folder that contains four types of sensor/sample information:
« Sensor Type
- Sensor Info
« Sample D
« Molar Concentration

This feature can be used to edit sensor/sample information after data acquisition. It
is useful, for example, if naming conventions (within a project) change over time
and the sample information used during data acquisition requires updating or if the
original plate assignment was incorrect. A Settings_Tablelnfo.xml file will be
found in the experiment folder of any experiment after the data has been processed
(in the Processing tab of the Octet System Data Acquisition software) and the Anal-
ysis tab has been activated. The Settings_Tablelnfo.xml file is updated after clos-
ing the Edit Sensor/Sample Information dialog box (of the Analysis tab). If no .xml
file is specified, the well information from the original data acquisition file is used.

3. Select the experiments for batch analysis:
a. Click Add Folders.

b. In the displayed dialog box, select an experiment folder and click Add. Repeat to
select each experiment in the batch.

¢. Optional. To remove an experiment(s) from the batch, select the folder(s) and click
Remove Selected.

4. Click Analyze Data.
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KINETICS ANALYSIS RESULTS

Kinetics analysis results (Figure 5-41) are presented in graphical and tabular formats. Some
viewing options in the Analysis window do not require data fitting (analysis) and are avail-
able for processed data.
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Figure 5-41: Analysis Window with Sample Curve Fitting Results

Fitting View and Residual View

When the analysis is completed, the fitting view displays the processed binding data and
the fitted binding curve (red) for all analyzed biosensors (Figure 5-42). The residual view dis-
plays the difference between the raw binding data and the fitted curve for all analyzed bio-
sensors. For more details on graph options, see “Working with Graphs” on page 142.
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Figure 5-42: Fitting View and Residual View—Stacked Option

NOTE: In Figure 5-42, a local, full fitting analysis was applied to the data. (For
detailed information on graph display options, see “Step 6: Viewing Results”
on page 106.)

Fitting view options:
« Stacked—Displays the binding curves of all ligand biosensors in one graph
(Figure 5-42).

+ Individual—Displays the binding curve from each biosensor in a separate graph
(Figure 5-43).

+ Grouped—Displays graphs organized into groups according to sample attribute or
results category. This is a highly useful feature when working with large data sets.
«  Options—Click to display the Grouped View Options dialog box.
+ Refresh—Updates the graph display.
« Y Axis Scaling

+ Auto Scale—Scales the y axis to the data in each graph.

+ Full Scale—Scales the y axis to in all graphs to the range needed to accommo-
date all of the data.

» Report Points

« Time (sec)—A user-specified time point in the experiment. The Octet System
Data Acquisition software computes the response at that time point.

Octet System Data Analsyis User Guide



page 126 Chapter 5: Basic Kinetics Analysis

+ Use__ Point Average—Each data point represents an average of the number of
data points specified centered around the time point chosen.

« Add to Table—Adds the response computed for the user-specified time point to
the analysis results table. Up to 10 response points can be added to the table.

«  Remove All—Removes all of the response data for user-specified time points
from the analysis results table.
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Figure 5-43: Fitting View and Residual View—Individual Option

NOTE: The data for all biosensors and samples is displayed.
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Individual View

The Individual View option displays the binding curve from each biosensor in a separate
graph. Users can modify the display using the options at the bottom of individual view
graphs (Figure 5-44).
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Figure 5-44: Individual View Display Options

1. To select the fields to display in the individual view, click Select Fields (Figure 5-45).

Traces 3-4 of 4 I‘ ‘ ’ N Mumber Fows MHumber Columris Show Fesults Show Residual

Figure 5-45: Select Fields Menu Option

The Choose Fields from Result Table dialog box displays (Figure 5-46).
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Available Fields Chosen

Sensor Location
Sensor Type
Sensor Info
Feplicate Group

Dissoc. Lo,
Cone. [nbd]
Fesponze
KD [M)
kon(1/hsz)
kan Emor
kdiz(1/3]
kdis Errar

[ (] 8 ] [ Cancel ]

Figure 5-46: Choose Fields from Result Table

2. Inthe Available Fields column, select the desired fields, click > to move the fields to the
Chosen column, then click OK.

The information displayed in the individual view will update based on the new selec-
tions (Figure 5-47).
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Figure 5-47: Individual View (Modified)
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Grouping Results for Viewing
To group results for viewing:

1. Select the Grouped option and click Options to display the Grouped View Options dia-
log box (Figure 5-48)
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Figure 5-48: Grouped View Options Dialog Box

2. From the drop-down lists, select up to three categories for grouping.
The following Grouped view options are available:
+ Group Graphs By—Select up to three categories for grouping the data across
three independent parameters.

+ Legend by—Select up to two categories to include in the graph legends
(Figure 5-49).

- Additional Graphs—Select other graphs to display with the analyzed (fitted)
data.

- Data Options—Click the Use "Included” Traces Only check box to graph only
the biosensors that are included in the analysis (marked with an “X" in the analy-
sis results table.

« Graph Size in Pixels—Options for graph size and the number of graphs to dis-
play per row.

« Graph Options—Options for graph labels and other graph display features.
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Figure 5-49: Fitting View—Grouped Option

Selecting Data for Viewing

The following options are available for selecting data for viewing:

- To view specific biosensor data, select the rows in the analysis results table.

« To select adjacent rows, hold down the Shift key while you click the first and last row
in the selection.

+ To select non-adjacent rows, hold down the Ctrl key while you click the rows of inter-
est. The Fitting view, Residual view, and graphs (X-Y, iso-affinity, and steady state) are
updated after each data selection.

After a kinetics analysis is completed, the default Fitting and Residual views display the data
for all biosensors and samples.
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Figure 5-50: Selecting Analysis Results for Viewing in the Fitting View and Residual View

Analysis Results Table

Each row in the Analysis Results table displays the results for one set of association/dissoci-
ation data. By default, the Fitting and Residual views include all of the results in the table.

Kinetic analysis results:

+ Index—Numbered order of the curves processed. The index is useful to sort back to
the original order. It is also useful in the graphing applications in the lower right win-
dow pane.

+ Include—"X" indicates data included in the analysis. If this field is blank, the data is
not included in the analysis.

« Color—The color of the biosensor binding curve in the Fitting and Residual view.
« Sensor Location—Location of the biosensor in the sensor tray map.
+ Sensor Type—The type of biosensor chemistry.

« Sensor Info—Information about the biosensor that was entered in the Octet System
Data Acquisition software.

- Baseline Loc.—Well location in the sample plate or reagent plate (Octet 384 instru-
ments only) in which the baseline was performed.

« Assoc. (Sample) Loc.—Sample well location in the sample plate.
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« Sample ID—The sample ID entered during assay setup.

+ Dissoc. Loc.— Well location in the sample plate or reagent plate (Octet 384 instru-
ments only) where the dissociation was performed.

« Conc (nM)—The molar concentration of the sample used in the association step. The
molar concentration is entered by the user or computed by the molarity calculator
during experiment setup.

+  Response—Response calculated from the time window entered in the Steady State
Analysis section.

« KD (M)—Affinity constant. For the 2:1 and 1:2 models, the Octet System Data Acqui-
sition software computes two Kp values.

+ kon (1/Ms)—Rate of association. For the 2:1 and 1:2 models, the Octet System Data
Acquisition software computes two k,, values.

. kon Error—Standard error of the rate of association.

« kdis (1/s)—Rate of dissociation. For the 2:1 and 1:2 models, the Octet System Data
Acquisition software computes two kg;s values.

- kdis Error—Standard error of the rate of dissociation.
«  Rmax—The maximum response determined from the fit of the binding data.

«  Rmax Error—The standard error of Rmax. For the 2:1 and 1:2 models, the Octet Sys-
tem Data Acquisition software computes two Rmax values.

+ kobs (1/s)—Observed binding rate. For the 2:1 and 1:2 models, the Octet System
Data Acquisition software computes two kg, values.

« km—The mass transport rate constant.
« km error—The standard error of the mass transport rate constant.

+ Reg—The calculated response at equilibrium that is determined from a fit of the
binding data.

+ Req/Rmax(%)—Ratio of Req to Rmax.

+  Full X2—A measure of the goodness of curve fitting (not directly related to a param-
eter estimate). It is the sum of squared deviations, where deviation is the difference
between the actual data point and the fitted curve. There is one value for each curve-
fit. Values close to zero indicate a good curve fit.

« Full R2—R2 is the coefficient of determination (COD). It is an estimate of the good-
ness of the curve fit and is not directly related to the estimate of a specific parameter.
Values close to 1.0 indicate a good curve fit.

+ Report point #1-10—Up to 10 report points can be added to the analysis results
table using the Report Points feature in the Analysis window. The column heading of
each report point is time value used to generate that report point. For example, if a
report point is generated at 100 seconds, the column heading is “X=100".
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+ SSGKp—The steady state group Ky value. Use this feature to quickly view the steady
state derived Kp values of groups defined within grouped view (not replicate
groups). The column is populated by opening Grouped view, selecting up to three
grouping parameter and activating Steady-State under additional graphs. The SSG
Kp value is reported for the set of data within each pane of the Grouped view. Repli-
cate grouping and global analysis are not used to determine this value.

+  SSG Rmax—The steady state group Rmax value. Use this feature to quickly view the
Rmax value of steady state data for a group defined within Grouped view (not repli-
cate groups). The column is populated by opening Grouped view, selecting up to
three grouping parameter and activating Steady-State under additional graphs. The
SSG Rmax value is reported for the set of data within each pane of the Grouped view.
Replicate grouping and global analysis are not used to determine this value.

+  SSGRA2—The steady state group RA2 value. Use this feature to quickly view the RA2
value of steady state data for a group defined within Grouped view (not replicate
groups). The column is populated by opening Grouped view, selecting up to three
grouping parameter and activating Steady-State under additional graphs. The SSG
RA2 value is reported for the set of data within each pane of the Grouped view. Rep-
licate grouping and global analysis are not used to determine this value.

+ Loading Well Location—Location of the sample well used during the load step of
the experiment.

+ Cycle—Number of biosensor regeneration cycles.

Working with the Analysis Results Table

To view a shortcut menu of display options (Figure 5-51), right-click the Analysis Results
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Figure 5-51: Analysis Results Table Shortcut Menu
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Analysis results table display options:

« Advanced Search—Searches the contents of the results table of the Analysis tab.
Multiple levels and operators are available. Searches may be combined (using AND/
OR operator) and saved (see Figure 5-52).

+ Set Color—Opens the color palette that enables you to choose a color for the
selected results (see Figure 5-53).

+ Set Color By Group—Color-codes the results according to the groups set in the
Grouped View Options dialog box (see Figure 5-48).

« Set Color By—Enables you to color-code results according to a user-selected cate-
gory from the analysis results table (see Figure 5-54).

« Include Wells—Removes the “X" in the Include column for the selected biosensors.
Re-run the analysis to include these biosensors in the analysis.

+ Exclude Wells—Adds an “X" in the Include column for the selected biosensors. Re-
run the analysis to exclude these biosensors from the analysis.

+ Size Columns by Title—Automatically sets the column width to fit the column title.
+ Size Columns by Data—Automatically sets the column width to fit the data.

« Select All Rows—Selects all biosensors in the table and displays the data in the Fit-
ting view and graph:s.

+ Invert Selection—Changes the wells status so that included wells become excluded
wells and excluded wells become included wells. You must re-run the analysis to
apply the inverted settings.

+ Set Column Order—Opens a dialog box that enables you to change the order of the
table columns.

» Parallel Sorting—Allows you to sort results in parallel based on specific sorting
parameters.

Searching Analysis Results

The complete contents of the Analysis tab—results table is searchable using the
Advanced Search tool. The search result is a highlighted set of table rows that meet the
specified search criteria. The set of rows selected before activation of the Advanced Search
dialog box may be combined with the results of the search using ALL, AND, and OR opera-
tors specified within the Advanced Search dialog box.
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Advanced Search Dialog

Add Level Search Options

@
Column Name Qperator Value o ezl

= Search All but keep curent
Sensor Location '] [Starts with '] - selection fmplies OR)

= Search only cument
= selection implied AND)

Saved Searchs

Selected Search

Search Details
[ Case Sensttive

[ Include Bxcluded Traces

[ Treat Empty Cells as a Match

Search Name:  MewSearch Save

[ ok | [ canca |

Figure 5-52: Advanced Search Dialog Box

Advanced Search options:

Column—The column of the results table searched.

Operator—The method of matching the search term with the searchable text.
Options include Starts with, Ends with, Contains, Does not contain, and Is empty.

Value—The search term for a single level.

Add Level—Adds one additional search level to the search. The AND operator
applies to all levels

Remove Level—Removes the selected search level.

Case Sensitive—Requires that the case of all characters (uppercase and lowercase)
of the search results match the search term.

Include Excluded Traces—Includes all data acquisition traces within the search
regardless of exclusion during analysis.

Treat Empty Cells as Match—Returns empty cells of the column as positive
matches, useful for searches in which cells were inadvertently left empty during
plate assignment or sample annotation.

Search Options

« Search All—Specifies all text within the Analysis table as searchable regardless
of the set of rows selected before activation of the Advanced Search dialog. The
search return is a highlighted set of rows in the table that match the search the
search criteria.

« Search all but keep current selection (implies OR)—Specifies all text in the
Analysis table as searchable regardless of the set of rows selected before open-
ing the Advanced Search dialog box.
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« Search only current selection (implies AND)—Specifies the text as the set of
rows selected before opening the Advanced Search dialog box.

Searching Contents of Results Table

To search the contents of the Results table:

1. Onthe Analysis tab, right-click a cell in the Results table, and select Advanced
Search > Edit Search.

Using the Column Name pull-down menu, select a column to search.
Using the Operator pull-down menu, assign an operator.
Enter the search term under Value.

If the search is case sensitive, select the Case Sensitive option.

o v M W N

Optional. Select the Include Excluded Traces option to include traces excluded from
analysis in the search.

7. Optional. Select the Treat Empty Cells as a Match option to include empty cells in the
search.

8. Optional. Click Add Level and repeat steps 2-4 to add additional levels to the search.

The set of rows selected in the table (when the Advanced Search dialog box was
opened) can be applied to the search using ALL, OR, and AND operators.

a. Select Search All to search the entire table (ALL operator).

b. Select Search All but keep current selection to search the entire table with reten-
tion of the selection present when the Advanced Search dialog box was opened
(OR operator).

c. Select Search only current selection to search only the rows selected when the
Advanced Search dialog box was opened (AND operator).

The search can be saved by specifying a name under Search Name and clicking Save.
The name of the saved search will appear in the Saved Searches list.

9. C(lick OK to execute the search.

Rows that contain cells meeting the search criteria will be highlighted.

Editing a Search
To edit a search:

1. On the Analysis tab, right-click any cell in the Results table, and select Advanced
Search > Edit Search.

2. Select a saved search from the Saved Searches list.
3. Click Load Search.
The parameters for the specified search are restored.

4, Edit the search (see steps 2-9 in “Searching Contents of Results Table” on page 136).
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The search can be saved by specifying a new name under Search Name and clicking
Save. The name of the saved search will appear in the Saved Searches list.

5. Click OK to execute the search.

Rows that contain cells meeting the search criteria will be highlighted.

Color-Coding Data
You can assign different colors to the binding curves as a follows:

« A particular color to user-selected results. This is useful when grouping for a global
fit.

« Color according to a results category.

Color-Coding User-Selected Results

To color-code user-selected results:
1. Select one or more rows in the analysis table (click the row header).

2. Right-click and select Set Color.
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Figure 5-53: Changing the Color of User-Selected Results

3. Inthe color palette that appears, select a basic color or create a custom color. To define
a custom color, click Define Custom Colors.

4. Click OKin the color palette.
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The selected color is applied to the binding curve and appears in the table.
Results can be color-coded by category to group them for a global fit (for example, colored
by compound), then fit using global fit by color. For the final display, the wells can be re-col-
ored without affecting the results.
Color-Coding Analysis Results by Category
To color-code analysis results by category:
1. Right-click the analysis results table and select Set Color By.
2. Make a selection from the shortcut menu (Figure 5-54).

In Figure 5-54’s example, category = sample concentration.
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Figure 5-54: Setting Data Color by Category
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Sorting Analysis Results

Sorting in Ascending or Descending Order
To sort results by any category (column header):
1. Click a column header.

The results are displayed in descending order. In Figure 5-55, the results were color-
coded by sample concentration, and then sorted.
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Figure 5-55: Color-Coded Analysis Results—Sorted by Color
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2. Click the column header again to sort the results in ascending order.

Sorting in Parallel Order

To perform parallel sorting:

1.

Right-click the Results table and select Parallel Sorting (Figure 5-56).

Plate C.. Sensor

Sample  Sample ... Type

Include Selected Rows

Exclude Selected Rows

Set Color ...
Set Color By Group
Set Color By

Size Columns by Title
Size Columns by Data
Size Columns by Both
Select All Rows

Invert Selection

Order Columns ...

Edit Sample Information ...

Parallel Sorting ... l}

Figure 5-56: Parallel Sorting Menu

2.

In the Parallel Sorting dialog box, select the desired sorting parameters and click OK
(Figure 5-57).

.

.
ol Parallel Sorting

S

Column Name Descending
Oty o
enor :
ety o
enor :

[ OKL}J [ cancel |

Figure 5-57: Parallel Sorting Dialog Box

_________

The Results Table will re-sort based on the parameters and order selected.
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WORKING WITH GRAPHS

The active analysis results are automatically presented in three graphical formats:
. XY

+  Iso-Affinity

 Steady State Analysis

X-Y Graphs

The X-Y graph is a scatter plot from user-selected analysis results (x and y-variables). Both
axes may be presented on either a logarithmic or linear scale.

|— Logarithmic scale option

#A Graph | |zodffinity | Steady State

% Cltog ¥ [conc ) v M Lo
Indes
30 -a e
Select the analysis result to plot
from the drop-down lists
o
(=]
=
3
\% 10 —
-
i ——— — maa
1] 002 004 006 ons 0l
Fesponse

Figure 5-58: X-Y Graph

An X-Y plotting tool has been added to the Results tab of quantitation analysis. Previously
available only in kinetics analysis, the X-Y plotting tool graphs several important parame-
ters, such as binding rate, R2, calculated concentration, and residual. The axes may be inde-
pendently selected to by logarithmic. In the example shown, the calculated concentration
is plotted versus the R2 (Figure 5-59).
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Figure 5-59: X-Y Plotting Tool

Iso-Affinity Graphs

The Iso-Affinity graph enables viewing of the continuum of kg;s and k,, values that gener-
ate a single value of Kp, providing a convenient way to view both kinetic and affinity data.
The value of the affinity constant, Kp, is the ratio of the association rate k,,, and dissociation
rate ky;s. A single value of Ky can, therefore, be obtained from varying values of k,, and kg;s;
for example, a Kp value of 1 pM can be the result of ky;;=1x10-3 1/S and k,,=1x10+3 1/Ms
or kgjs=1x10-2 1/S and k,,=1x10+4 1/Ms.

Each Iso-Affinity plot has two red lines that correspond to a single Kp value. The position of
the Kp lines is determined by taking the average of all K values and plotting one redline 10
fold lower than the average and one red line 10 fold higher than the average.

%Y Graph | Iso-Affinity | Steady State |

|zo-Affinity Graph
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Figure 5-60: [so-Affinity graph—X axis = kg, Y -axis = ky
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Steady State Analysis Graphs

The Steady State Analysis graph (Figure 5-61) displays the results from the steady state
analysis (see “Steady State Analysis Graphs” on page 144). The graph plots the response or
Req vs. concentration and the curve fit.
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Figure 5-61: Steady State Analysis Graph

DATA EXPORT OPTIONS

The analysis results can be exported (.txt or .csv) or copied to the system clipboard. Infor-
mation from the Data Selection, Processing, or Analysis windows can be selected to gener-
ate custom reports (.xIs).
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Figure 5-62: Data Export Options in the Analysis Window
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The data export options include:

« Export Fitting Results—Saves the binding data and analysis results for each biosen-
sor to a separate text file (.txt).

« Export Table to .csv File—Saves the results table to a .csv file that can be opened in
a spreadsheet application.

« Copy Table to Clipboard—Saves the binding data and analysis results for the
selected biosensors to the system clipboard.

MASKING DATA

The Mask Data feature lets you make a copy of your data folder with all proprietary info
such as sample ID, sample info, sensor type and sensor info hidden, or ‘masked’ in both the
fmf and .frd files.

NOTE: The Mask Data feature is not available in Octet Data Analysis 21 CFR
Part 11 software.

To do this:
1. In the Data Selection Tab, right click on an experiment in the folder tree.

2. Select Mask Data (Figure 5-63).

Data Selection Results

Bl Loaded Data 012¢

=11 012615_Froposed Cali Open Explorer ..
Remove Run
Mask Data...

Figure 5-63: Selecting Mask Data Option.

A copy of your data folder can then be saved in the desired location.
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GENERATING A REPORT

NOTES:

a Generating reports for large data sets may take a few minutes. For faster
report generation, minimize the number of items selected for the report. In
particular, the sensor summary for a large data set can be time-consuming.

In Octet Data Analysis 21 CFR Part 11 software versions 8.2 and higher, the
Summary Worksheet tab of exported reports will now also include the soft-
ware name, version and the export date and time.

To generate a report:

1. On the menu bar File > Save Report. Alternatively you can click Save Report in the
Data Export section of the Analysis tab (Figure 5-64).

2. Inthe displayed dialog box, select the information to include in the report.

3. Confirm the default location to which the file will be saved or specify a different loca-
tion.

4. Click Export.

In Octet Data Analysis software versions 8.2 and higher, once the report is exported, the
contents of the exported xls file are locked and cannot be changed.
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Figure 5-64: Report Selection Form

Changing the Column Order in a Saved Report

You can customize the columns and their order in a saved report. These customized report

settings are also saved as the default for future reports.

1. In the Data Export section of the Analysis tab, click Save Report > Select and Order
Columns > OK (Figure 5-64).

2. The Select And Order Columns dialog box displays (Figure 5-65). Select and order the
columns, then click OK.
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o5l Select And Order Columns u
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R2 Sensor Type |
Information

ype

Replicate Group
BR Avg
ER SD
BRCV
Conc. Avg

Of Cancel

Figure 5-65: Select And Order Columns Dialog Box

3. Inthe Report Selection Form dialog box (Figure 5-64), click Export. The Results tab will
now display the selected columns and the desired column order.

Experiment Summary Options

To use the available experiment summary options, select the following from the Data Selec-
tion window () tab):

+ Steps data table
+ Assay steps data table
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Figure 5-66: Report Data Types—Experiment Summary Options

Processing Options

To use the available processing options, select the following from the Processing window
(i tab):

Raw and aligned data
Sensor tray image
Sample plate image
Processed results
Sensor summary
Sensor tray data table
Sample plate data table
Report points

>

NOTE: When working with large data sets, including the sensor summary in a
report significantly increases the time required to generate the report.
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Figure 5-67: Report Data Types—Processing Options—Raw Data and Aligned Data

Sensor tray images Sample plate data images
4% ForteBio Data Analysis 7.0 - Kinetics - hig ProA Kinetics [ESRE=Ex
File Help
Data Selection Processing

Step 1: Data Selection Sensor Tray #1 ‘Sample Plate Map 110420
©) Raw Data View

Sensor Selection

Sensors to be Analyzed
Al-F1)

Reference Wiels
Paralll Reference Sensors
Double Reference

Average Reference Sensors

Step 3

Time Range sec):
From: 0.1 To: 2938

4
A
B
[of
D
E
F
G
H

)
]

Step 4 [¥] Inter-step Comection 8= Ligand Sensor (= Empty
Alignto Dissociation
Hignto Baseine

B Select Ligand Sensor(s) for Data Analysis

Step 5 Process
v Wl Sesor Ser oy Wel el Wel Sanple Descpion M
Number Location L Type Info Ll MNumber  Location Type 1] escription
A1 | Ligand Sensor | SA (Steptaviin) 110420_001 rd e % | B Sample Associaton | TX Knetics Bufer
S‘BPPfuii::?:’i‘u’M 2 B1 | Ligand Sensor | SA (Streptavidin) 110420_002frd 2 ot S ssociation | TX Kinetics Buffer
Sormr Surmary 3 | 1 |ugand Sensor | SA (Sreptavidi) 110420_003frd 2 e S e
Report Poirts 4 | D1 |[Ligand Sensor | SA (Sreptavidin) 110420_0045d 2 o B R Y
5 | El |LiandSen d
Siep 7 Save Results pd Sy |SA GRSk 30 | F4 |ReferenceWel| Assocition | 1X Kinstios Buffer
——n 6 F1_|Ligand Sensor | SA (Sireptavidin) 110420_0061rd P e e—— wx o
Sve Tocessed Ues 7 & [ e 110420_0075d erencs ssodton S
0 M1 Ligond Sereer 1020008 2 H4  Refersnce Wel | Association | 1X Kinetics Buffer
9 A2 |Lgand Sensor 110420_009frd B Eoe femein  EES I
10 | B2 |ugand Sensor T10420_010frd u | B Sample Associabon | TX Kinetcs Bufer
11 | C2 |Ligand Sensor 10420_0115d 3 Associaton | X inetics Bufer |
2 | D2 |Lgsnd Sensor 1104200126 A e - i s
Sensor tray data table Sample plate data table

Figure 5-68: Report Data Types—Processing Options—Sensor Tray and Sample Tray Information
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Figure 5-69: Report Data Types—Processing Options—Processed Data
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Figure 5-70: Types of Report Data Included by the Processing Options—Sensor Summaries
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Association-Dissociation Results
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Figure 5-71: Report Data Types—Processing Options—Report Point Analysis

Analysis Options

To use the available analysis options, select the following from the Analysis window (

tab):

+ Kinetics analysis

+ Iso-Affinity analysis

- Steady State analysis
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Figure 5-72: Report Data Types—Analysis Options—Kinetics Analysis Results
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Figure 5-73: Report Data Types—Processing Options—Iso-Affinity and Steady State Analysis Graphs

EPITOPE BINNING

The goal of a typical epitope binning or cross-blocking experiment is to identify antibodies
which bind to different or identical epitopes on the antigen. Antibodies are tested two at a
time for competitive binding to one antigen. By competing antibodies against one another
in a pairwise and combinatorial format, antibodies with distinct blocking behaviors can be
discriminated and assigned to “bins". The end result is matrix of pairwise binders and block-
ers.
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Epitope binning experiments are run as kinetic experiments with many repeating steps in
the Octet Data Acquisition software. After an experiment is complete, start a data analysis
session. The steps to analyze the binning data include:

Table 5-1: Octet Data Analysis Steps for Epitope Binning Assays

Octet Software Functions

Data Analysis 1. Load and open the experiment data.
2. Confirm experiment parameters and select biosensors in Data
Selection.

3. Click Process Epitope Binning in Tab 2.

4. View and analyze graphical and tabular results in Tab 4 (Bin-
ning).

5. Export the results and generate a report.

The Epitope Binning data analysis feature provides easier visualization of larger data sets
that use biosensor regeneration. Results are placed in a 2-D matrix that allows further cross-
blocking data analysis. Typical epitope binning or cross-blocking analysis focuses on com-
paring cycles of repeating Association steps, with monitoring of baselines or Dissociation
steps for binding stability.

Start a Data Analysis Session
1. Click the desktop Octet Data Analysis software icon to start a data analysis session.

2. Select a data file and view the experiment summary in Tab 1 (Data Selection).

e NOTE: More details on opening data files can be found “Working with Experi-
ments” on page 80.

@ NOTE: The Sample plate and the Reagent plate are now referred to as “Plate 1”
and “Plate 2" in the software.

Processing Epitope Binning Data
1. Click Tab 2 (Processing).
2. Click the Process Epitope Binning button and open Tab 4 (Epitope Binning):
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% ForteBio Data Analysis 8.0 - Kinetics ¢

File  Help

Data Selection Processing
1632 epitope binning_set 1

Step 1: Data Selection
@ Raw Data View
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Sensors to be Analyzed:

F1 i

Process Epitope 'ing

Figure 5-74: Process Epitope Binning Data Button

Tab 4 (Binning) has three sections: Binning Parameters and Step Calculations (left),
Graph of overlaid traces (upper right), and Table of averaged sensor and cycle data
(bottom right):

Data Selection Processing | () Analysis| ) Binning
mab072313 - 32¢64 Cross-comp Plte182-1 |
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— | Vs

Binned Data <2572 1902
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< Z ] 5
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Figure 5-75: Tab 4 (Binning)

Graph of Overlaid Traces. The software will automatically search for repeating sequences
of baseline, loading and/or association steps and overlay them in a graph:
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Figure 5-76: Graph of Overlaid Traces

The selected assay step icon is highlighted above the graph, in bold red-dashes on the
graph itself and displayed as its Experiment Step in the upper left.

To change display options using the buttons above the graph:
Align traces to start of selected step

Remove trace alignment
Y

Show all traces

Align traces to start of each step

Binning Parameters. Includes the total number of steps found in the experiment, the
number of cycles of repeating steps, and the number of steps found in one cycle:

Binning Parameters
Steps in experiment: 152
Cycles found: 16

Steps in cycle: 12

Cycle Search Parameters
Steps to Skip: 0 =

Cycle Steps To Display
Display From: -
Display To:

Figure 5-77: Binning Parameters
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Steps to Skip. This is useful in assays where a number of initial assay steps are followed by a
set of repetitive cycles. When comparing repeating association steps in a binning experi-
ment, the Steps to Skip option allows the user to ignore steps that do not need to be over-

laid for visualization of the binning results.

Cycle Steps to Display. The Cycle Steps to Display allows you to reduce the steps displayed

on the graph view, such as any regeneration steps.

Adjust the Steps to Skip and/or Cycle Steps to Display to properly view the overlaid traces:

Experiment Step: 7 Type: LOADING - (

Binned Data

nm
v

05 -

100 150 200 280 300 350
Time (sec)

Figure 5-78: Overlay of Traces with Steps to Skip Removed and Cycle Steps Displayed

Step Calculations. Includes commands used to select assay steps for building the Step Cal-
culation table and calculating parameters for the epitope binning matrix:

Step Calculations

———1 = o 1 ——
|l == =]

Step  Type Awvg. Time (s) Fagy

7 LOADING 836 =

9 ASS0C 20.96 -5

1 DISASSOC 12.00 -5

Figure 5-79: Step Calculations

Add selected step to Step Calculation table
[+
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Edit selected step

E Remove selected step from Step Calculation table

Clear Step Calculation table
o

Add a step for calculating the epitope binning matrix by selecting a step in the graph and
clicking the Add Step Calculation Parameters button. This opens the Step Calculation
Parameters box:

Step Calculation Parameters

Experiment Step: 7 Step Type:  LOADING
This Step Contains
@ Other () First Antibody () Second Antibody

Step Maximum Binding Calculation

Step Duration {seconds):
89.60

Segmenrt of curve to average when calculating end point madmum:

O 100 5| seconds

Binding maximum is measured relative to the signal at the start of the step.

Fast Offrate Threshold

O [50 H«

Flags traces that have a faster than average offrate.
Low Signal Threshold
U 50 B %
Compare To: @ Othertraces in the same sensor.
() Othertraces in the same cycle.
I Flags traces that have a lowerthan average signal. I
Matrix Mormalization

I [ Caleulate ratio of Second Antibody maximum to this step’s maximum

Cox ] (e ) |

L —

Figure 5-80: Step Calculation Parameters Box

To calculate the epitope binning matrix:

1. Select what this step contains: First Antibody, Second Antibody or None (e.g. Baseline
or Antigen).

2. Change the default time window for determining the average nm shift at the end of the
step.

3. Add weak binding and low response flags (flagged in the Traces tab):

- Weak Binding %: flags traces that have dropped based on the % dissociation
from the start of the step.
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- Low Response %: flags traces that have not risen relative to the average nm
shift of the step.
4. Normalize the second antibody step data by clicking the Use this step to normalize
the second antibody check box.

5. Click OK.
6. Repeat the previous steps to build the Step Calculations table.

Creating the Matrix. Once the Step Calculations table is complete with at least the First
Antibody and Second Antibody, a matrix can be generated by clicking the Create Matrix
button:

Matrix

First Artibody: ~ Step § ASSOC
Second Antibody: Step 11 DISASSOC
Color Threshold:  0.0810

U 6 %

Amange Rows and Columns

Export to CSV File m

Figure 5-81: Create Matrix Button

The matrix created on the Matrix tab is the nm shift, or normalized data, of the First Anti-
body against the nm shift, or normalized data, of the Second Antibody competitively bind-
ing to the antigen:

| Traces | Average by Sensor | Average by Cycles | Matrx
AB# mab-1 mab-17 mab-33 mab-49 mab-2 mab-18 mab-34 mab-50 mab-3 mab-19 mab-35
mab-1 |OGERE 04242 04031 0.3605 03307 03195 JOZEEE 03079 04020 03220 03393

mab-2 [ODEST 04834 04737 OG0 03924 0.3275 JODiSE T fanasa e 0.as10 0.4064
mabr3 [DOSEEI 04854 0.4695 [DOI0BI 03771 0.2961 DTS2 (OO 0.3515 03504
mabd [DOSESI 0.4663 0.4261 |25 (025000 0.35% 03017 (D27 03156 [D00BENI 03331
mab-5 [Dm872" | 05566 05160 05522 05467 04148 05516 05711 04913 05357
mabf [0mE7e T 0.4803 04596 04505 04629 04341 [EBEZEN 05012 04357 04154 04927
mab-7 1008300 05240 04708 04833 04761 05114 0.3%67 05256 5111 04503 05138
mat-2 [0osss | 05160 0.4652 04721 04768 04924 0.3910 05101 05118 0.43%6 0.4280

4 n | »

Figure 5-82: Matrix Tab

Matrix Parameters Summary. The steps associated with the First Antibody and Second
Antibody are displayed, along with commands for Color Threshold and Arranging Rows and
Columns:
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Matrix

First Artibody: ~ Step § ASSOC
Second Antibody: Step 11 DISASSOC
Color Threshold:  0.5038

U 50 %

Amange Rows and Columns

Export to CSV File

Figure 5-83: Matrix Parameters Summary

1. Move the slider to change the threshold for changing color on the matrix.

2. Click the Arrange Rows and Columns button to sort and match columns and rows:

Arrange Rows and Columns

»

Row Headers Column Headers
mab-1 mab-1
mab-2 mab-2
mab-3 mab-3
mab-4 mab-4
mab-6 mab-6
mab-8 mab-8

mab-17 m
mab-33
mab-49
mab-18
mab-34
mab-50 I
mab-19
mab-35
mab-51
i mab-20
mab-36
[ mab-52
mab-21
il mab-37

mab-53 I
f mab-22

b 20
4 1 A REN 1 | » I

m

[ Amange Rows to Match Columns ] [ Amange Columns to Match Rows J

(o) o

Figure 5-84: Arrange Rows and Columns Box

+ Rows and columns can be sorted alphabetically by clicking on the headers:
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Arrange Rows and Columns
p—
V. N F 4 N
Ich Headers’ ‘ lCqumn Headers' Il
mab-2 mab-2
mab-3 mab-3
mab-4 mab-4 L
mab-6 mab-6
mab-8 mab-8
mab-17 - I

Figure 5-85: Alpha Row and Column Sorting

+ Hold the Ctrl key to click and select multiple entries.
« Scroll through entries faster by holding down the Up or Down buttons.
3. Click OK.

Matrix data can be copied by right-clicking on the matrix, selecting Copy and pasting into
another program. Data can be exported by clicking the Export to CSV File button.

+ Results Table. Shows the trace data averaged for sensor and cycle:

Traces | Average by Sensor | Average by Cycles |

Trace Sensor Color Cycle Step 7 Plate Step 7 Sample Loc Step 7 Step Type Step 7 Sample ID Step 7 Nm Shift Step 7 Flag Step 9 Plate Step 9 Samp
1 s 1 A17 LOADING Antigen_His 03970 1 Al m
2 s M2 1 Al7 LOADING Antigen_His 03721 1 Al

3 s M 1 Al7 LOADING Antigen_His 0.3588 1 Al

4 It N 1 A17 LOADING Antigen_His 0.34%0 1 Al

5 A9 B s 1 Al7 LOADING Artigen_His 0.3404 1 B

[ A9 B ¢ 1 Al7 LOADING Artigen_His 03310 1 B

7 A9 | K 1 Al7 LOADING Artigen_His 03357 1 Bl

8 A9 H : 1 Al7 LOADING Artigen_His 03257 1 B

3 A9 B s 1 a17 LOADING Antigen_His 03272 1 a2

0 A9 o a17 LOADING Antigen_His 03355 1 a2

1 A v 1 Al7 LOADING Antigen_His 03377 1 a2

12 A9 Bl A17 LOADING Antigen_His 03331 1 Az

oA M A17 LOADING Antigen_His 03208 1 B2 -
4 I, ] [

Figure 5-86: Results Table

« Average By drop down list: lets you choose the method for averaging trace infor-

mation:
. '
Average By p D“ | E
Sensor 100 150 200 250 300 350 400
Cycle Time (s}
;£9_|é ;p— b @m Average by Sample ID Step § | Average By Sensor | Average By Cycle |
el S 1] . AB# meb-1 meb2 meb3 meb-4 meb-5 mab 6 mab7 meb& |
Color Thresheld:  0.0210 mab-1 [GERI 03307 04020 03905 05183 0.4028 03783 04503 |
¥ = mab-2 0.0897 0665 [G6EEE 03321 05758 0.3578 04820 05439 |
= mab-3 0.0938 00108 0021 03380 05665 0.3584 0.4954 05532 |
mab-4 0.0939 0.2500 03156 (006280 05345 03184 0.4537 05259 ]
mab5 0.0872 05522 05711 04767 [OGTE 04716 ‘o088
mab6 0.0876 0.4629 0.4397 02841 0.4750 [OETZEN 04674 0.5084 |
a7 ot oem 0s oow  ODDEEN onz  DoANNbEEI
e mab 8 00959 04768 05118 LEIEI 1 R
|l [ ]
Export to C5V File =

Figure 5-87: Average By Drop Down List
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« Traces tab: contains individual cycle data for each sensor:

Binned Data
16 —
e L
c I
08 -~
0 ——
100 150 200 250 300 350 400 450 500 550 600
Time (sec)
T hvmage S v Gy
Trace Sensor Color Cycle Step 7 Flate Step 7 Sample Loc Step 7 Step Type Step 7 Sample 1D Step 7 Nm Shift Step 7 Flag Step § Plate Step § Samp *
A3 1 AT LOADING Arttigen_His 0.3570 1 Al
A3 1 AT LOADING Arttigen_His 03731 1 Al
A3 1 AT LOADING Arttigen_His 0.3588 1 Al
A3 1 A7 LOADING Artigen_His DM&D 1 M
A3 A7 LOADING M\geﬂ His 1
-__— LOADING 050 I N T
A3 LOADING M\geﬂ His 0.3357 1 Bl
A3 LOADING Artigen_His 0.3257 1 B1
A3 LOADING Artigen_His 03272 1 A2
A3 LOADING Artigen_His 0.3355 1 A2
A3 LOADING Artigen_His 03377 1 A2
A3 LOADING Artigen_His 0331 1 A2
A3 LOADING Arttigen_His 0.3308 1 B2 2
D

Figure 5-88: Traces Tab

+ Average by Sensor tab: contains sensor information with average nm shift for each
cycle across individual sensors:

Binned Data
16 —
c L
3 B
08 -
D ﬁ/
100 150 200 250 300 350 400 450 500 550 600
Time (sec)

Toose ey S | Moty Goesl
Tece Sensor Color Cyde Step7Flate  Step 7 Sample Loc Step 7 Step Type Step 7 Sample 1D Step 7 Nm Shift Step7Fag  StepGPlate  Step 9 Samp *
1 A3 1 A17 LOADING Antigen_His 03970 1 Al [
2 A3 1 Al7 LOADING Antigen_His 03731 1 Al
3 A3 1 A17 LOADING Artigen_His 03588 1 Al
4 As 1 mT LOADING Antigen_His u:usn 1 m
5 B LOADING Armgen His 1
_-__ LOADING D 331 D I R TR
7 LOADING Antigen_His 1
H Aﬂ 1 m? LOADING Antigen_His u 3257 1 31
9 A9 1 a7 LOADING Antigen_His 03272 1 I+
0 A9 1 a7 LOADING Antigen_His 03355 1 I+
n A9 1 A7 LOADING Antigen_His 03377 1 A2
12 A3 1 A17 LOADING Antigen_His 03331 1 A2
13 A3 1 A17 LOADING Antigen_His 03308 1 B2 -
4 3

Figure 5-89: Average by Sensor Tab

Octet System Data Analsyis User Guide




Epitope Binning page 163

Average by Cycles tab: contains cycle information with average nm shift and stan-
dard deviation across individual cycles:

nm

Binned Data

100 150 200 250 300 350 400 450 500 550 600
Time (sec)

Traces | Average by Sensor | Average by Cycles

Cycle Sensors  Step 7 Plate Step 7 Step Type Step 7 Sample Loc Step 7 Sample ID Step 7 Nm Shift Step 7 Nm Shift Std Dev Step 9 Plate Step 9 Step

1 LOADING A17CITEITGI7I17 . Antigen_His 0.3810 00042 1 ASS0C

2 LOADING A7CITEITGI7117 . Antigen_His 0.3593 0.0050 1 ASSOC

3 LOADING A7CIFEITGI7117 ... Antigen_His 0.3461 0.0047 1 ASSOC

4 LOADING A7CIFEITGI7 117 ... Antigen_His D3331 DDIMS T ASSOC

5 LOADING A17CITEITG17 117 ... Antigen_His ASSOC  |=

___
A3BI 1 LOADING A1TCITEITGIFI17 . Antigen_His 03245 0.0051 ASSOC

3 A3BI 1 LOADING A17CITEITGI7I17 . Antigen_His 03215 00053 1 ASS0C

9 A3BI 1 LOADING AITCITEITGI7I17 . Antigen_His 0.3204 0.0050 1 ASS0C

o ASBS.. 1 LOADING A7CIFEITGI7117 ... Antigen_His 03174 0.0052 1 ASSOC

n ASBS .. 1 LOADING A7CIFEITGI7 117 ... Antigen_His 0.3140 0.0050 1 ASSOC

12 ASBS.. 1 LOADING ATCITEITGI7 17 ... Antigen_His 0.3106 0.0051 1 ASS0C

13 A3B9.. 1 LOADING ATCIFEITGITNT .. Antigen_His 0.3094 0.0051 1 ASSOC

4 [} ] b

Figure 5-90: Average by Cycles Tab
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+ Matrix tab: contains the nm shift or normalized binding data for antibody 1 and
antibody 2 binding to the antigen:

Traces | Average by Sensor | Average by Cycles | Matrix

AB# mab-1 mab-17 mab-33 mab-4% mab-2 mab-18 mab-34 mab-50 mab-3 mab-1% mab-35
mab-1 OGS0 04342 0.4031 03605 0.3307 03135 [02808 1 0307 0.4020 03220 03293
mak-2 [00857 T 04834 04737 0.4639 |00 03924 03275 |GISEN (OO0 0.3510 0.4064
mab-3 [00538 T 04854 0.46% 04534 [OTI0ER 0.371 0.2961 [00152 5 [mo2f 0.3515 03904
mab-4 [00539 0 04663 0.4261 |25200 02500 0.359% 03017 [E275a 0316 |00 o.3931

mab-5 [ooa72" | 0.5566 05160 04978 05522 0.5467 04148 05516 05711 04913 05357
mab-6 Jaiba7e Y 04809 0459 04505 04629 04341 [EE 05012 04957 04164 04927
mab-7 Ja0s30 Y 05240 04709 04833 04761 05114 03967 05256 0511 04603 05136
mab-8 00858 05160 04632 04721 04768 04384 03310 05101 05118 04336 04880
4 [ L3

Figure 5-91: Matrix Tab
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AUTOMATION INTERFACE OVERVIEW

The Octet System Data Acquisition software provides support for an automation interface
using a COM port (RS-232) or a Transmission Control Protocol/Internet Protocol (TCP/IP)
socket/port (Figure A-1).

a5l Options X
Automation
TCP-IP
Port: 20001 = 7] Localhost
[ Serial (R5232)
Port: |1
oK | [ Cancel

Figure A-1: Options for Automation

An example application for testing the automation interface (AutomationClient.exe) is
included in the applications and Dynamic Link Libraries (DLLs) installed with the Octet Sys-
tem Data Acquisition software. The file is located in the C:\Program Files\ForteBio\Data-
Analysis directory.

NOTES: The automation interface can be used with Octet384 systems only.
The examples that follow are illustrated using a TCP/IP connection, but the
serial port connection behaves identically.

DESIGN OF THE AUTOMATION INTERFACE

The automation interface is designed to be as universal as possible, making no assump-
tions about the communication medium or the language of the client application connect-
ing to the Octet System Data Acquisition software.

The following guidelines apply:
+ All commands and responses are ASCII strings, one per line.
+ Alllines are terminated with both carriage-return and line-feed characters ("\r\n").

« Each command starts with the name of the command and may then be followed by
required and optional parameters.

« Each parameter starts with a switch definition (a la dos/unix command line) followed
by the parameter itself, which allows parameters to be sent in any order.

«  The command or response is terminated with a new line (CR/LF) sequence.

« Parameters containing embedded spaces need to be enclosed in double quotes.
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Automation Interface Control Setup

Before the Octet System Data Acquisition software can be controlled using an automation
interface, the correct automation options must be set. To do this, go to File > Options and
select the appropriate port in the Automation box (Figure A-1).

e NOTE: The Octet System Data Acquisition software can be controlled via the
Automation interface through a serial port (RS-232) or a TCP/IP socket.

s NOTE: The Localhost option can be useful in developing the automation cli-
ent on the same computer that runs the Octet System Data Acquisition soft-
ware.

NOTE: Pall ForteBio recommends that the Data File repositories be set using

a shared folders addressed by "UNC" folder names so that the internal path used
by the Data Analysis application corresponds to the external path used to
access/retrieve the data files recorded during the experiment. Alternatively,
the path returned by the GetRuninfo command to access the data files from
another computer on the LAN.

Analysis Automation API
//

R R RS SRS SR SRS SRS S S S SR SRR SR SRR R R R RS SRS SRR RE RS SRR EEEEE R EEEEREEEEEEESEEE
//

// Copyright (c) 2011 ForteBio.

// All rights reserved.

//

//

khkkhkhkhhkhkkhhkdhhkhdhhkhkdhhdhhkhdhhhdhhkhhkhdhdhhdhhkhhdhhhdhhdhhhkhhdhkhdhdhkdhrdhkhdhddhrdhkhrdrdhddxk
// HEADER: AutomationAPI.h

// PURPOSE: Defines the commands supported by the automation API.

// AUTHOR: BHI Nov 2008

//

#ifndef INC ANALYSIS AUTOMATIONAPI H

#define INC_ANALYSIS AUTOMATIONAPI H

// NOTES:

// * The automation interface is string based. Commands and responses are

// strings, one per line.
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// * Each command starts with the name of the command and may then be

// followed by required and

// optional parameters.

// * Each parameter starts with a switch definition (a la dos/unix command
// line) followed by the

// parameter itself. This allows parameters to be sent in any order.

// * The command or response is terminated with a new line (CR/LF)
sequence.

// * Parameters containing embedded spaces must be enclosed in double
// quotes.
// * Response items containing embedded spaces will be enclosed in double

// quotes.

// Version of thew API described in this header file.

const char AUT API VERSION[] = "1.0";

// Status return values

const char AUT OK[] = "OK";
const char AUT RUNNING [] = "Running";
const char AUT_ ERRORI[] = "ERROR";
const char AUT BUSY[] = "Busy";

const char AUT_ STOPPED ] "Stopped"; // Stopped by user.

const char AUT EOL/(] = "\r\n";

// Parameter switches for the LOAD command

const char AUT SWITCH DATASET = 'd';

// Parameter switches for the ANALYZE command
const char AUT_SWITCH_PARAMS = 'p';
const char AUT SWITCH XMLINFO = 'x';

// COMMAND API

const char AUT_CMD_VERSION[] = "Version";

// Returns the version of the app being automated, and the API version.
// Args: (none)

// Response: App product version (e.g. "6.3.1.12 1.0\r\n")

const char AUT_CMD_LOAD[] = "Load";
// Loads an experiment

// Args:

Octet System Data Analsyis User Guide



Design of the Automation Interface page 169

// -d <paths> Path to experiment data files
// Response:

// "OK\I\I’I"
// "Error: <reasons\r\n"
const char AUT CMD ANALYZE[] = "Analyze";

// Runs an analysis

// Args:
// -p <paths> Path to parameters (INI file)
// -x <path> Path to XML information file (optional, can be multiple

XML info files)

// Response:

// n OK\ I'\l’l n
// "Error: <reasons>\r\n"
const char AUT CMD STATUS[] = "Status";

// Returns status: OK=ready, Busy=running, Error=Action was terminated by
an error.

// Busy is followed by descriptive information on the progress of the

)

experiment (% complete)
// Args: (none)

// Response:

//  "OK\r\n"

//  "Busy\r\n"

// "Running (nn%) \r\n"
// "Error: <reasons\r\n"

#endif // INC_ANALYSIS AUTOMATIONAPI H
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INSTALLING THE DATA ACQUISITION 21 CFR PART 11 SOFTWARE

NOTE: Version 8.2 of Data Acquisition and Data Analysis 21 CFR Part 11 soft-

e ware require a new database schema and version 8.2 of the GxP Server mod-
ule. The new database schema is installed and configured during the version
8.2 software installation. Version 8.2 software will automatically check the
version of the GxP Server module in use and display a message if it is incom-
patible.

To install the Data Acquisition 21 CFR Part 11 software:
1. Insert the software CFR CD into your CD drive.

« If the Autoplay dialog box displays, choose to open the CD to view files.

+ If the Autoplay dialog box does not display, navigate to the CD using Windows
Explorer.

Optical drives are typically found under the D:\ or E:\ drive.

2. Double-click DataAcquisition-CFR.exe to launch the installation wizard (see
Figure B-1).

i Data Acquisition 7.0 Setup EI_IéJ

Welcome to the Data Acquisition 7.0
Setup Wizard
(for 21 CFR part 11)

This wizard will guide you through the installation of Data
Acquisition 7.0,

It iz recommended that you dose all other applications
before starting Setup. This will make it possible to update
relevant system files without having to reboot your
computer,

Click Next to continue,

[ Mext = ] [ Cancel ]

Figure B-1: Data Acquisition (for 21 CFR Part 11) Software Setup Wizard

3. Click Next to display the Choose Install Location dialog box (Figure B-2).
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. Data Acquisition 7.0 Setup

(=] ]

Choose Install Location
Choose the folder in which to install Data Acquisition 7.0.

Setup will install Data Acquisition 7.0 in the following folder. To install in a different folder,
dick Browse and select another folder. Click Next to continue.

Destination Folder

C:\Program Files\ForteBio\7\DataAcguisiion7 0 0 89'

Browse...

Space required: 66.3MB
Space available: 177.2GB

- ForteBio, Inc, - wew, Forkebio,com

[ < Back ][ Mext = J [ Cancel

Figure B-2: Choose Install Location Dialog Box

The default location for the software on the local machine is C:\Program

Files\ForteBio\DataAcquisition.

Click Next to accept this path location.

The Choose Start Menu Folder dialog box displays (Figure B-3).

i Data Acquisition 7.0 Setup

=] (e

Choose Start Menu Folder
Choose a Start Menu folder for the Data Acquisition 7.0 shortcuts,

Select the Start Menu folder in which you would like to create the program's shortcuts, You
can also enter a name to create a new folder.

orteBio \ForteBio

2BrightSparks

7-Zip

Accessories

ACT! by Sage Premium
Administrative Tools
Bonjour Print Services
Corel DVD MovieFactory Lenovo Edition
DivX Plus

Dropbox

FileZilla FTP Client
FileZilla Server
ForteBio

[am | »

- ForteBio, Inc, - wew, Forkebio,com

Install Cancel

[ <eei |

Figure B-3: Choose Start Menu Folder Dialog Box

The default Start Menu folder is ForteBio.
Click Install.

The installation wizard takes a few seconds to install.

When the installation is complete, the installation wizard displays the Completing the
Data Acquisition Setup Wizard dialog box (Figure B-4).
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i Data Acquisition 7.0 Setup =

Completing the Data Acquisition 7.0
Setup Wizard

Data Acquisition 7.0 has been installed on your computer.

Click Finish to dose this wizard.

Figure B-4: Completing the Data Analysis Setup

6. Click Finish to complete the installation.

INSTALLING THE DATA ANALYSIS 21 CFR PART 11 SOFTWARE

NOTE: Version 8.2 of Data Acquisition and Data Analysis 21 CFR Part 11 soft-

e ware require a new database schema and version 8.2 of the GxP Server mod-
ule. The new database schema is installed and configured during the version
8.2 software installation. Version 8.2 software will automatically check the
version of the GxP Server module in use and display a message if it is incom-
patible.

To install the Data Analysis 21 CFR Part 11 software:
1. Insert the software CD into your CD drive.
2. Navigate to the window listing the files located on the installation CD.

3. Double-click DataAnalysis-CFR.exe to launch the installation wizard (see Figure B-5).
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i Data Analysis 7.0 Setup l = ot S

Welcome to the Data Analysis 7.0
Setup Wizard
(for 21 CFR part 11)

This wizard will guide you through the installation of Data
Analysis 7.0,

It iz recommended that you dose all other applications
before starting Setup. This will make it possible to update
relevant system files without having to reboot your
computer,

Click Next to continue,

[ Mext = ] [ Cancel ]

Figure B-5: Data Analysis (for 21 CFR Part 11) Software Setup Wizard

4. Click Next to display the Choose Install Location dialog box (Figure B-6).

i Data Analysis 7.0 Setup | = 2
Choose Install Location
Choose the folder in which to install Data Analysis 7.0,

Setup will install Data Analysis 7.0 in the following folder. To install in a different folder, dick
Browse and select another folder. Click Next to continue.

Destination Folder

C:\Program Files\ForteBio\7\DataAnalysis7_0_0_29Y

Space required: 57.4MB
Space available: 177.2GB

[ < Back ][ MNext = ] [ Cancel

Figure B-6: Choose Install Location Dialog Box

The default location for the software on the local machine is C:\Program
Files\ForteBio\DataAnalysis.

5. Click Next to accept this path location.
The Choose Start Menu Folder dialog box displays (Figure B-7).
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i Data Analysis 7.0 Setup R=NRCN_ < |

Choose Start Menu Folder
Choose a Start Menu folder for the Data Analysis 7.0 shortcuts,

Select the Start Menu folder in which you would like to create the program's shortcuts, You
can also enter a name to create a new folder.

orteBio

2BrightSparks

7-Zip

Accessories

ACT! by Sage Premium
Administrative Tools
Bonjour Print Services
Corel DVD MovieFactory Lenovo Edition
DivX Plus

Dropbox

FileZilla FTP Client
FileZilla Server
ForteBio

m|»

- ForteBio, Inc, - wew, Forkebio,com

[ < Back ][ Install J [ Cancel

Figure B-7: Choose Start Menu Folder Dialog Box

The default Start Menu folder is ForteBio.
6. Click Install.

The installation wizard takes a few seconds to install (Figure B-8).

i Data Analysis 7.0 Setup = e 5

Installing

Please wait while Data Analysis 7.0 is being installed.

Execute: "msiexec” /i "C:\Program Files\ForteBio\7\DataAnalysis7_0_0_29'Prerequisites\VC50

Qutput folder: C:\Program Files\ForteBio\7\DataAnalysis7_0_0_29'Prerequisites
Extract: WindowsInstaller KB893803-v2-%86.exe

Extract: VC30Runtime. msi

Extract: NetFx205P2_x86.exe.., 100%

..M5I 5.0 already installed 1!

..MET Framework 2.0 SP2 already installed 1

Execute: "msiexec” fi "C:\Program Files\ForteBio\7\DataAnalysis7_0_0_29'\Prerequisi. ..

- ForteBio, Inc, - wew, Forkebio,com

< Back Mext = Cancel

Figure B-8: Installation Progress

The installation wizard displays the Completing the Data Analysis Setup Wizard dialog
box (Figure B-9).
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i Data Analysis 7.0 Setup | =

Completing the Data Analysis 7.0
Setup Wizard

Data Analysis 7.0 has been installed on your computer,

Click Finish to dose this wizard.

Figure B-9: Completing the Data Analysis Setup

7. Click Finish to complete the installation.

INSTALLING THE FORTEBIO GXP SERVER MODULE

NOTE: It is highly recommended that the ForteBio GxP Server Module not be

e installed on the computer connected to the Octet instrument. Instead, it
should be configured on the administrator's computer that is connected to the
server. This allows the administrator to control the users who have accounts
and specific privileges in the 21 CFR Part 11 Data Acquisition software. Both
the Octet system computer and the computer with the ForteBio GxP Server
Module should be connected to the server.

The ForteBio GxP Server Module contains FBServer Config and FBServer Monitor (see
Figure B-10). User accounts should be made in the FBServer Config with the required per-
missions. It is highly recommended that at least two users have administrative access to the
FBServer Config. Once the accounts are made, FBServer Config is password protected so
only users with administrative rights can access it. FBServer Monitor may be copied to the
computer that is connected to the Octet instrument to monitor the audit trail (see
Figure B-10).
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I&’ . v Computer » Local Disk (C:) » Program Files (x86) » ForteBio » FBServerd.2

Organize « Open New folder

Y Favorites Mame Date modified Type Size
Bl Desktop @ FBServer 11/21/2014 5:57 PM  Application 1105 KB
4 Downloads B FBSer\rerConfig} 11/21/2014 5:58 PM  Application 3,015 KBl
=] Recent Places qE FBServerMonitor ) 11/21/2014 5:58 PM  Application 2474 KB
%% Dropbox E ForteBio 2/11/201510:19 AM  Internet Shortcut 1KB
[Z| Documents @ Globe 11/4/2014 11:57 AM  Icon 25KB
(& uninst 2/11/201510:19 AM  Application 92 KB
4 Libraries
3 Documents
J‘} Music
[ Pictures
B videos
. Computer

£, Local Disk (C3)
5# xeroxscans (\\camp-
® shared (\\camp-fsl.

?j MNetwork

Figure B-10: FBServer Config and FBServer Monitor on Local Disk in Windows Explorer.

The ForteBio GxP Server module can be installed and run from the following locations:

+  Recommended: A remote host computer networked to a machine where the Data
Acquisition or Data Analysis 21 CFR Part 11 software is installed

+ Alocal host computer where the Data Acquisition or Data Analysis 21 CFR Part 11
software is installed

Upon launching the Octet System Data Acquisition or Data Analysis CFR 11 software, you
are required to select the GxP Server module host location. If the GxP Server module is
installed in multiple locations, you can select any host server. The user session event record
will be saved only to the host location selected, making it possible to have records for the
same user in multiple locations.
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NOTES: For administrators only.

@ To ensure that all records are saved to one location, ForteBio recommends
that one administrator install a single copy of the Pall ForteBio GxP Server
module on the administrator's computer that is connected to the network. For
added security, the ForteBio GxP Server module should not be accessible to all
users.

Version 8.2 of Data Acquisition and Data Analysis 21 CFR Part 11 software
require version 8.2 of the GxP Server module. The software will automatically
check the version of the GxP Server module in use and display a message if it is
incompatible.

To install the ForteBio GxP Server software:
1. Navigate to the window listing the files located on the installation CD.
2. Double-click ForteBio GxP Server.exe to launch the installer.

3. If prompted with the Do you want the following program from an unknown publisher to
make changes to this computer? message, reply Yes.

The installation wizard should display (Figure B-11).

[i:%] ForteBio GxP Server 7.0 Setup = P

Welcome to the ForteBio GxP
Server 7.0 Setup Wizard

This wizard will guide you through the installation of ForteBio
GxP Server 7.0,

It iz recommended that you dose all other applications
before starting Setup. This will make it possible to update
relevant system files without having to reboot your
computer,

Click Next to continue,

[ MNext = ] [ Cancel

Figure B-11: ForteBio GxP Server Software Setup Wizard

4. Click Next to display the Choose Install Location dialog box (Figure B-12).
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7] ForteBio GxP Server 7.0 Setup E=nnEl <

Choose Install Location

Choose the folder in which to install ForteBio GxP Server 7.0.

Setup will install ForteBio GxP Server 7.0 in the following folder. To install in a different folder,
dick Browse and select another folder. Click Next to continue.

Destination Folder
C:\Program Files\ForteBio\7\CFR\FBServer 7

Space required: 17.3MB
Space available: 177.2GB

- ForteBio, Inc, - wew, Forkebio,com

[ < Back ][ Mext = J [ Cancel

Figure B-12: Choose Install Location

The default location for the software on the local machine is C:\Program
Files\ForteBio\DataAnalysis.

5. Click Next to accept this path location.
The Choose Start Menu Folder dialog box displays (Figure B-13).

3] ForteBio GxP Server 7.0 Setup [E=NacE x|
Choose Start Menu Folder
Choose a Start Menu folder for the ForteBio GxP Server 7.0 shortcuts,

Select the Start Menu folder in which you would like to create the program's shortcuts, You
can also enter a name to create a new folder.

orteBio

2BrightSparks

7-Zip

Accessories

ACT! by Sage Premium
Administrative Tools
Bonjour Print Services
Corel DVD MovieFactory Lenovo Edition
DivX Plus

Dropbox

FileZilla FTP Client
FileZilla Server
ForteBio

[am | »

- ForteBio, Inc, - wew, Forkebio,com

[ < Back ][ Install ] [ Cancel

Figure B-13: Choose Start Menu Folder Dialog Box

The default Start Menu folder is ForteBio.
6. Click Install.

The installation wizard takes a few seconds to install (Figure B-14).
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[i:%] ForteBio GxP Server 7.0 Setup =

Installing
Please wait while ForteBio GxP Server 7.0 is being installed.

Execute: C:\Program Files\ForteBio\7\CFR\FBServer 7\FBServer.exe 42 =
-

Create shortcut: C:\Userswms\AppData'Roaming \Microsoft\Windows\Start Menu'pr... =
Create shortcut: C:\Userswms\AppData'Roaming MicrosoftiWindows\Start Menu'Pr...
Create shortcut: C:\Userswms'\Desktop\ForteBio GxP Server.ink

Create shortcut: C:\Userswms\AppData'Roaming MicrosoftiWindows\Start Menu'Pr...
Create shortcut: C:\Userswms\Desktop'Restart Server.Ink

Qutput folder: C:\Program Files\ForteBio\7\CFR\FBServer 7

Create shortcut: C:\Userswms\AppData'Roaming MicrosoftiWindows\Start Menu'Pr...
Created uninstaller: C:\Program Files\ForteBio\ 7\CFR \FBServer Fiuninst. exe

Execute: C:\Program Files\ForteBio\7\CFR\FBServer 7\FBServer . exe -5

Execute: C:\Program Files\ForteBio\7\CFR\FBServer 7\FBServer.exe 42 = iy

m

Figure B-14: Installation Progress

The installation wizard displays the Completing the ForteBio GxP Server Setup Wizard
dialog box (Figure B-15).

[i:%] ForteBio GxP Server 7.0 Setup =

Completing the ForieBio GxP Server
7.0 Setup Wizard

ForteBio GxP Server 7.0 has been installed on your
computer,

Click Finish to dose this wizard.

Figure B-15: Completing the ForteBio GxP Server Software Setup

7. Click Finish to complete the installation.
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DATABASE BACKUP AND GXP SERVER MODULE UPGRADE

IMPORTANT: It is strongly recommended that you make a backup copy
0 of the existing database before installing and upgrading to GxP
FBServer Module v8.2.

To backup your database and then upgrade from GxP FBServer Module versions 7 or 8.0 to
version 8.2, follow the steps below. Once these steps are complete, the existing audit trail
database that stores audit logs will be upgraded to the version 8.2 schema.

Step 1: Backup the Version 8.0 Database

The database for the GxP FBServer Module is a file-based database. So to make a backup of
the database, all you need to do is make a copy of the database file and save it to an archival
location.

1. Log on to the computer that is hosting the GxP FBServer Module v7 or v8.0.

2. Open Windows® Explorer and browse to the program data folder (for example:
C:\ProgramData\ForteBio\FBServer)

3. Make a copy of the FBEventLog.db and FBServer.db files.

4. Save the copies to another location.

Step 2: Upgrade to GxP FBServer Module v8.2

1. From the Windows Start Menu, select All Programs. Scroll to the ForteBio FBServer
folder and click on the folder to expand.

2. Select Uninstall ForteBio GxP Server.

. ForteBio FBServer B
FBServerMonitor
IE' ForteBio GxP Server
0 ForteBio Website
m Restart Server
(= Uninstall ForteBio GxP Server8.0

3. Install GxP FBServer Module v8.2 per the instructions in “Installing the ForteBio GxP
Server Module” on page 177

When the GxP FBServer Module v8.2 software starts, it will automatically update the
audit trail database.

ADMINISTRATOR ACCOUNT SETUP

To set up the administrator account:

Octet System Data Analsyis User Guide



Administrator Account Setup page 183

1. Launch the Octet System Data Acquisition or Data Analysis software by double-clicking
the respective desktop icon; see Figure B-16.

. .
= «*®
a % e @
?‘[.. o®
Data Data Analysis
Acquisition (CFR11)
(CFR11)

Figure B-16: Data Acquisition or Data Analysis Software Desktop Icons

The Login dialog box displays (Figure B-17).

fortésio

server:

User:

Password:

Project: ’ (none)

Figure B-17: Login Dialog Box

2. Select a Server location by clicking ... (browse).

The Authentication Server dialog box displays (Figure B-18).

|

Connection to server:

Server address: localhost
[#] Localhost
Port: 20002 [= | Fnd | | Defaut |

Figure B-18: Authentication Server

3. Click Default to recall the default server settings of localhost and Port 2002.
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« Local host—If the local computer is to be used as the GxP Server module host,
click the Localhost check box. Change the Port number if needed.

«  Remote host on same subnet—If the GxP Server module is hosted on the same
subnet, deselect the Localhost check box and click Find. A list of potential GxP
Server module addresses will be listed. Choose the desired location from the list
and click OK.

Choose Server Address u

il

More than one server was found.
Please choose one.

192.168.1.78 (JRICHARDS
192.168.1.78 (JRICHARDS)

Figure B-19: Choose Server Address

- Remote host on another subnet— If the GxP Server module is hosted on a dif-
ferent subnet, deselect the Localhost check box. Enter the IP address of the
computer hosting the GxP Server module.

Connection to server:

Server address: 192.168.1.78
["] Localhost
Port: 20002 [ | Fnd | | Defaut |

Figure B-20: Authentication Server

When the GxP Server module host location has been selected or entered, click OK to
save changes and exit the Authentication Server dialog box. The GxP Server module
location will now be listed as the Server in the Login dialog box.

NOTE: Once the GxP Server module host location is selected, this location will
be used as the default selection for the administrator account. It does not need
to be reselected each time a new session is initiated.
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fortésio

Server: localhost: 20002

User:

Password:

Project: ’ (none)

Figure B-21: Login Dialog Box with Server Parameter Configured

4, Select Administrator from the User drop-down list (Figure B-21).
5. Leave the Password blank, set the Project to (none) and click OK (Figure B-22).

fortésio

Server: localhost: 20002

User: Administrator

Password:

Project: ’ (none)

Figure B-22: Login Dialog Box with Server, User, and Project Settings Configured

The Change Password dialog box displays; see Figure B-23.
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The password has not been set for this user.

New password: sesssssens
Confirm new password: sssssscsee
Password reminder: Default

Figure B-23: Change Password Dialog Box

6. Enter a New password and Password reminder (optional) and click OK.

The Octet System Data Acquisition or Data Analysis software launches and initiates an
administrator user session that will allow access to administration options.
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STARTING AN ADMINISTRATOR USER SESSION
Administrators initiate new user sessions the same way non-administrative users do.

1. Launch the Octet System Data Acquisition or Data Analysis software by double-clicking
the respective desktop icon; see Figure B-24.

" "N ]
a % e @
?‘[.. 0®
Data Data Analysis
Acquisition (CFR11)
(CFR11)

Figure B-24: Data Acquisition or Data Analysis Software Desktop Icons

The Login dialog box displays; see Figure B-25.
00 W
, ™
fortésio
e —

Server: localhost: 20002

User:

Password:

Project: ’ (none)

Figure B-25: Login Dialog Box

2. Confirm that the Server location is correct. If not, see “Administrator Account Setup” on
page 182.

3. Select Administrator from the User drop-down list (Figure B-26).
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fortésio

Server: localhost: 20002

User: Administrator

Password:

Project: ’ (none)

Figure B-26: Login Dialog Box with Server, User, and Project Settings Configured

4. Enter your Password. Click ? for a password reminder (Figure B-27) if necessary.

fortésio

localhost: 20002

Administrator

@ Reminder:

Employee number

Figure B-27: Password Reminder

5. Ifrequired, select a project from the Project drop-down list (Figure B-28).
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fortésio

Jﬁ

Server: localhost: 20002
User: Administrator

Password: eesesesse

Project:  [(none)

none
Antigen:Antibody screen

Cell Culture screen
Receptor: Ligand screen

Figure B-28: Login Dialog Box with Project Selections

6. Click OK.

The Octet System Data Acquisition or Data Analysis software launches and initiates the
administrator session. During the session, the administrator account and project
selected at login are displayed in the Data Acquisition software status bar.

e NOTE: Administrator and user sessions are automatically closed after a period
of inactivity set using the UserldleMin constant. Please see “Administrator
Constants” on page 201 for more information.
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ACCESSING ADMINISTRATOR OPTIONS

The 21 CFR Part 11 software Server Administration options allow administrators to mange
users, groups, projects and constants and view associated events.

These options can be accessed in the Octet System Data Acquisition and Data Analysis soft-
ware or by launching the ForteBio GxP Server module directly.

- Data Acquisition and Data Analysis software—Click Security > Server Adminis-
tration (Figure B-29).

Security | Window Help Security | Help

Verify Document... Verify Document ...

View Audit Trail View Audit Trail

Change Project Change Password ...
Change Password... Change Project »
Server Administration Server Administration
Lock Application... Lock Application ...
Logoff... Log Off ...

Data Acquisition Software Data Analysis Software

Figure B-29: Security > Server Administration Menu

« ForteBio GxP Server module on network location—Double-click the
FBServerConfig.exe file in the FBServer folder from the installed location
(Figure B-30).

File Edit View Tools Help

Organize ~ Include in library ~ Share with Burn New folder =~ 0 @

4 |. ForteBio * O Name Date modified Type Size

> | DataAcquisition? =
FBServerexe 12/3/20103:53PM  Application 2,966 KB

> | DataAnalysis7

FBServerConfig.exe 12/3/20103:53 PM  Application 7.821KB
| . FBServer7
.¢| FBServerMonitor.exe 12/3/2010 3:54 PM Application 6,809 KB
#+ ForteBio 2/10/2011 6:20 PM Internet Shortcut 1KB
0 Globe.ico 12/1/2010 4:21 PM Icon 25 KB
@ uninstexe 2/10/2011 6:20PM  Application 54 KB

Figure B-30: Installation Location

« ForteBio GxP Server module on a local host computer—Double-click the ForteBio
GxP Server desktop icon (Figure B-31).
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T
[ ] -
ey
ForteBio GxP
Server

Figure B-31: ForteBio GxP Server Desktop Icon

NOTES:

e When accessing the ForteBio GxP Server module directly, additional tools are
also provided to test server functionality. Please see “Accessing the ForteBio
GxP Server Module Directly” on page 206 for more information.

After the initial setup of the ForteBio GxP Server and the formation of user
accounts, the ForteBio GxP Server will be password protected and only admin-
istrator(s) can access it.

The ForteBio GxP Server Configuration window displays.

Administrator Tabs

Five tabs are available in the ForteBio GxP Server Configuration window:

+ Users—Allows user and password management and individual privileges selection.
+  Groups—Allows user group management and group privileges selection.

+ Projects—Allows project management and setup.

« Constants—Allows setup of GxP server parameters.

- Events—Displays event logs for individual user accounts, projects, or machines.

Click any of the tabs to view the respective information contained within the tab.

Tab View

Each tab displays a list of administrator entries and associated setting information that can
be sorted by clicking any of the column headers (Figure B-32).

Login Name  Ful Name Group Privieges Password Age  Info

GMoreno George Moreno  Guest run 00:11:23 External colaborator
RBrown Richard Brown  Supervisor review 00:12:32

JBlack John Black Developer change, plate, run 00:13:30

PSmith Paul Smith Lab User run 00:14:46

Administrator Administrator  Administrator  admin, review, change, plate 1 day 22:17:19 Default administrator user

Figure B-32: Tab View Example
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Tab Menu
Right-clicking an entry or a blank area in the tab displays the tab menu. Tab menu options

vary depending on the tab selected.

User Account Administration

The Users tab allows administrators to add and inactivate user accounts, as well as set and
change individual user account privileges and passwords.

Creating a New User Account

To create a new user account:

1. Right-click anywhere in the Users tab and select New User, or double-click in a blank
area; see Figure B-33.

Users | Groups | Projects | Constants | Events
Login Name  Ful Name Group Privieges Password Age  Info
Administrator Administrator  Administrator  admin, review, change, plate 1 day 22:06:08 Default administrator user
PsSmith Paul Smith Lab User run 00:03:35
JBlack John Black Developer change, plate, run 00:02:19
RBrown Richard Brown  Supervisor review 00:01:20
GMoreno George Moreno  Guest run 00:00:12 External collaborator

Figure B-33: New User Menu

The New User dialog box displays (Figure B-34).
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|

Login name:

Full name:

Information:

Password:

Confirm password:

Password reminder:

Group: [Supervisor

Supervisors can review data and events

Privieges: [] Administration - administers the user database

Review - reviews changes and events
[ change - can change methods and configuration values

[ plate - can change sample plate properties
[Clrun - can run experiments and analyses

[] Password does not expire

Figure B-34: New User Dialog Box

2. Assign Account Details. Enter the user’s Login name, Full name, Information
(optional), Password, and Password reminder (optional).

3. Assign a User Group. Select a user group from the Group drop-down list. The following
default group selections are available:

Administrator—Add, inactivate, and change user accounts and groups.
Supervisor—Review data and events.

Developer—Create, run, save, and export data.

Lab User—Only run experiments.

Guest—No explicit privileges; these must be assigned by the administrator.

If other user groups have been created by an administrator, they will also be available for
selection in the Group drop down box. For more information, please see “Creating a New
User Group” on page 198.

4. Assign Privileges. Each user account can be assigned specific privileges. The privileges
displayed initially will be those defined in the user group selected in the previous step.
Table B-1 outlines the privileges for the default user groups. If needed, change user
account privileges by selecting or deselecting the check boxes next to each privileges.

Administration—Can administer the user database.
Review—Can review changes and events.

Change—Can change methods and configuration values.
Plate—Can change sample plate properties.

Run—Can run experiments and analyses.
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Table B-1: Default user group privileges.

Privilege Administrator  Supervisor Developer Lab User  Guest
Administration o

Review v v

Change v e

Plate v v

Run e v

5. Options—Click the Password does not expire check box if desired. By default, this
check box is not selected. Clicking this option will let user account passwords expire at
the set PasswordTTL constant. For more information on setting constants, see “Admin-
istrator Constants” on page 201.

6. Click OK to save changes and exit.
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Viewing and Changing User Account Settings

To view and change user account settings:

1. On the Users tab, right-click the user account and select Edit User, or double-click the
user account.

The Edit User window displays (Figure B-35).

Login name: [RBrown|

Full name: Richard Brown

Information:

Group: ’ Supervisor

Supervisors can review data and events

Privieges: [] Administration - administers the user database
Review - reviews changes and events
[ change - can change methods and configuration values
[ plate - can change sample plate properties
[Clrun - can run experiments and analyses

[] Password does not expire

Figure B-35: Edit User Dialog Box

2. If needed, modify the user account settings. For more details on individual settings, see
“Creating a New User Account” on page 192.

3. Click OK to save changes and exit.

Inactivating User Accounts
To inactivate a user account:
1. On the Users tab, right-click the user account and select Inactivate User.

2. Click OK in the dialog box displayed.

6 NOTE: Users can only be inactivated, not deleted, from the GxP server.

Octet System Data Analsyis User Guide



page 196 Appendix B: 21 CFR Part 11 Software Administrator Options

Changing User Account Passwords
To change a user account password:
1. Onthe Users tab, right-click the user account and select Set Password.

The Change Password dialog box displays (Figure B-36).

Current password:

New password:
Confirm new password:

Password reminder:

Figure B-36: Change Password Dialog Box

2. Enter the New Password, confirm the new password, and provide a Password
reminder (optional).

3. Click OK to save changes and exit.

Changing the Administrator Password

To change the administrator password:

1. Initiate a new administrator user session.

2.  When the software launches, on the main menu, click Security > Change Password.

The Change Password window displays (Figure B-37).

Current password: ?
New password:
Confirm new password:

Password reminder:

Figure B-37: Change Password Dialog Box (Administrator)
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e NOTE: You can also access the Change Password dialog box by right-clicking
on the administrator account in the Users tab and selecting Set Password
from the tab menu.

3. Enter the Current password for your user account. Click ? for a password reminder.
4. Enter the New Password and Password reminder (optional).

5. Click OK to save changes and exit.

Group Administration

The Groups tab (Figure B-38) allows administrators to add and inactivate user groups as
well as set and change group privileges.

Users | Groups |Pr0jects | Constants | Events

Name Privieges Info

Administrator admin, review, change, plate Administrators can add/delete/edit users and groups
Supervisor  review Supervisors can review data and events

Developer  change, plate, run Developers can create, run, save and export data
Lab User run Lab Users can only run experiments

Guest (none) Guests have no explicit privieges

Figure B-38: ForteBio GxP Server Administration

When a user account is assigned to a user group, the privileges defined in the group are
also applied to the individual user account. The following default user groups are available
and the privileges assigned to each are shown Table B-2:

« Administrators—Can add, inactivate and change user accounts and groups

+ Supervisors—Can review data and events

- Developers—Can create, run, save and export data

+ Lab Users—Can only run experiments

+  Guests—Have no explicit privileges, these must be assigned by the administra-
tor
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Table B-2: Default User Group Privileges

Privilege Administrator  Supervisor Developer LabUser  Guest

Administration

Review v v

Change v e

Plate v v

Run e v

Creating a New User Group

To create a new user group:

1. Right-click anywhere in the Groups tab and select New Group or double-click in a
blank area.

The New Group window displays (Figure B-39).

Group name:

Information:

Privieges: [] Administration - administers the user database
] rReview - reviews changes and events

[ change - can change methods and configuration values
[ plate - can change sample plate properties
[CIRun - can run experiments and analyses

Figure B-39: New Group Dialog Box

2. Enter the Group name and Information (optional).

3. Privileges—Each group can be assigned specific privileges. Add group privileges by
selecting or deselecting the check boxes next to each privilege:
+ Administration—Can administer the user database
» Review—Can review changes and events
« Change—Can change methods and configuration values
+ Plate—Can change sample plate properties
+  Run—Can run experiments and analyses
4. Click OK to save changes and exit.
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Viewing and Changing Group Settings

To view and change group settings:

1. Right-click on the group and select Edit Group, or double click the group.
The Edit Group window displays (Figure B-40).

Group name:

Information: Developers can create, run, save and export data

Privieges: [] Administration - administers the user database
] rReview - reviews changes and events

Change - can change methods and configuration values
Plate - can change sample plate properties
Run - can run experiments and analyses

Figure B-40: Edit Group Dialog Box

2. If needed, modify the group settings. For more details on individual settings, see “Cre-
ating a New User Group” on page 198.

3. Click OK to save changes and exit.

Inactivating a User Group
To inactivate a user group:
1. Right-click the group and select Inactivate Group.

2. Click OK in the dialog box displayed.
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Project Administration

The Projects tab (Figure B-41) allows administrators to add and delete user projects. Proj-
ects are selected when a new user session is initiated in the Octet System Data Acquisition
or Data Analysis software, allowing all user, system and software events for a particular proj-
ect to be monitored.

Users |Gr0upa Projects | Constants | Events

Name Info

Receptor: Ligand screen  Affinity Screen
Antigen:Antibody screen Off-rate determination
Cell Culture screen Protein quantitation

Figure B-41: Projects

Creating a New Project
To create a new project:

1. Right-click anywhere in the Projects tab and select New Project, or double-click in a
blank area.

The New Project window displays (Figure B-42).

- . =

Project name:

Information:

Figure B-42: New Project

2. Enter the Project name and Information (optional).

3. Click OK to save changes and exit.
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Viewing and Changing Project Settings
To view and change project settings:
1. Right-click on the project and select Edit Project, or double-click on the project.

The Edit Project window displays (Figure B-43).

wro . =

Project name: Receptor: Ligand screen

Information: Affinity Screen

Figure B-43: Edit Project

2. If needed, modify the project settings.

3. Click OK to save changes and exit.

Deleting a Project

To delete a project;
1. Right-click the project and select Delete Project.
2. Click OK in the dialog box displayed.

Administrator Constants

The Constants tab allows administrators to set GxP Server module constant settings. These
constants are applied to all user accounts and sessions.

|U5ers |Gr0ups | Projects| Constants | Events

Name Value
CredentialsTTL 5
PasswordMinLength 0
PasswordSecure 0
PasswordTTL 180
UserIdleMin 15

Figure B-44: Constants Tab
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Available administrator constants and their associated value ranges are shown in Table B-3.

Table B-3: Administrator Constants

Constant Description Default Value Range
Value
CredentialsTTL The number of days that the 5 Minimum=0,
server settings are stored in the no maximum
cache. This allows the software to value

operate in case the server is tem-
porarily down.

PasswordMin- Minimum number of characters 0 Minimum=0,

Length that a password must contain. no maximum
value

PasswordSecure Level of password complexity. 0 0-1

Setting the constant to 0 has no
password restrictions. Setting the
constant to 1 requires passwords
to contain at least one alpha, one
numeric, and one punctuation

character.
PasswordTTL Amount of time that a password 180 Minimum=0,
is allowed to remain unchanged. no maximum
value
UserldleMin Idle time allowed during a user 15 Minimum=0,
session after which the session is no maximum
automatically closed. value
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Creating a New Constant
To create a new constant:

1. Right-click anywhere in the Constants tab and select New Constant, or double-click in
a blank area.

The New Constant window displays (Figure B-45).

Constant name:

Value:

Figure B-45: New Constant

2. Enter the Constant name and Value. Refer to Table B-3 for a list of available constants
and value ranges.

3. Click OK to save changes and exit.

Viewing and Changing Constants
To view and change constants:

1. Right-click the constant and select Edit Constant, or double-click the constant.

The Edit Constant dialog box displays (Figure B-46).

Constant name: UserIdieMin|

Value: 15

Figure B-46: Edit Constant Dialog Box

2. If needed, modify the constant settings. For more information on available constants
and their values, see Table B-3 on page 202.

3. Click OK to save changes and exit.
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Deleting a Constant
To delete a constant:

1. Right-click the constant and select Delete Constant.
2. Click OK in the dialog box displayed.

Event Log

The Events tab allows administrators to view all the user, system, and software event infor-
mation recorded by the Pall ForteBio GxP Server module.

NOTE: GxP Server module version 8.2 and higher will also display event infor-
mation recorded in BLItz Pro software for BLItz systems.

i h
1%/ ForteBio GxP Server Configuration - 8.2.0.1 [
Connection to dients:
e [T Localhost Port: 20002 5 foplyfiest

Support UDP ping for discovery Default

| Users I Groups I Projects I Constants | Events |

User: [(any} v] Project: [(any} v] Machine: [(any} v]
Date/Time Login Mame Project Machine Software Type Info
2014/059/25 10:11:35 tae WIN-S3NMIUKMEIN  Octet Analysis  User login tae
2014/059/25 10:11:38 tae WIN-S3NMIUKMEIN  Octet Analysis  Open experiment  C:iTestD!
2014/059/25 10:11:39 tae WIN-S3NMIUKMEIN  Octet Analysis  Close experiment  C:iTestD!
2014/09/25 10:11:40 tae WIN-S3MNIUKMEIN  Octet Analysis  Open experiment  C:{TestD

Figure B-47: Events Tab

Events are tracked for individual user accounts, projects and machines. By default, a histori-
cal log of all events recorded on the active Pall ForteBio GxP Server module displays:

- Date and Time - When the event occurred
+ Login Name - User name associated with the event
« Project - Name of project associated with the event

« Machine - Name of instrument used (includes both Octet and BLItz instruments for
GxP Server module versions 8.2 and higher)

- Software - Which software the event was logged in (available in GxP Server module
versions 8.2 and higher only, includes Octet Data Acquisition, Octet Data Analysis
and BLItz Pro software events)

« Type-Event type
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e NOTE: In Octet Data Analysis 21 CFR Part 11 software versions 8.2 and higher,
all events related to data analysis, processing and inclusion or exclusion of
data are now also logged in the Audit Trail.

+ Info - Any additional information recorded with the event

Viewing Events

To view events for a specific user account, project, or computer, click the User (Figure B-48),
Project, or Machine drop-down list, and select an entry:

User: [(any) 'J Project: ’(any) '] Machine: ’(any) ~

(any)
Date/ pdministrator

me  Project Machine Type Info
201 i At rator JRICHARDS User login
2011 PSmith rator JRICHARDS User logout
2011,RBrown rator JRICHARDS  User login
2011/02/07 16:20:31 Administrator JRICHARDS User login

2011/02/07 16:47:42 Administrator JRICHARDS User logout

Figure B-48: Viewing Events from the User Drop-Down List

NOTE: Selections can be made in either one or all of the User, Project, or
Machine drop-down lists.

The list then only displays events for the entries selected (Figure B-49).

User: ’JBlack '] Project: ’RECEDtOF'- Ligand scr '] Machine: ’(any) ']

Date/Time Login Name Project Machine Type Info
2011/02/13 20:39:33 JBlack Receptor: Ligand screen JRICHARDS User login
2011/02/13 20:39:37 JBlack Receptor: Ligand screen JRICHARDS User logout

Figure B-49: Selected Entries

In addition to the specific user, project, and machine selections, the following list options
are also available:

+ (any)—Displays all user, project, or machine events.

« (none)—Displays all user and machine events not associated with a specific project
(Project list only).
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ACCESSING THE FORTEBIO GXP SERVER MODULE DIRECTLY

Administrators can directly access the Pall ForteBio GxP Server module without initiating an
administrator user session. Direct access provides server testing options, as well as access to
all administrative functions discussed earlier in this section.

To access the Pall ForteBio GxP Server module directly:

- If the Pall ForteBio GxP Server module is installed on a network location—Double-
click the FBServerConfig.exe file in the FBServer folder from the installed location
(Figure B-50).

File Edit View Tools Help

Organize ~ Include in library = Share with = Burn New folder =~ 1 @
r
4 | ForteBio * O nName Date modified Type Size
> | DataAcquisition7 =
FBServer.exe 12/3/2010 353 PM  Application 2,966 KB

> | DataAnalysis7
5| FBServerConfig.exe 12/3/2010 3:53 PM  Application 7.821 KB

| . FBServer7
FBServerMonitor.exe 12/3/2010 3:54 PM  Application 6,909 KB
@+ FarteBio 2/10/2011 6:20 PM Internet Shortcut 1KB
e Globe.ico 12/1/2010 421 PM Icon 25 KB
& uninstexe 2/10/2011 6:20 PM  Application 54 KB

Figure B-50: ForteBio GxP Server Module Installed on a Network Location

- Ifthe GxP Server module is installed on a local host computer—Double-click the
ForteBio GxP Server desktop icon (Figure B-51).

T
[ ] -
ey
ForteBio GxP
Server

Figure B-51: Pall ForteBio GxP Server Desktop Icon

The ForteBio GxP Server Configuration window displays (Figure B-52).
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r ~
ForteBio GxP Server Configuration - 7.0.0.1_ u

Connection to clients:

E = [ Locahost Port: 20002 |- Gendle
Support UDP ping for discovery

Users ‘Groups | Projects | Constants | Events‘

Login Name  Full Name Group Privieges Password Age Info

Administrator Administrator  Administrator  admin, review, change, plate 4 days 00:47:57 Default administrator user
PSmith Paul Smith Lab User run 2 days 02:45:25

JBlack John Black Developer change, plate, run 1 day 04:34:45

RBrown Richard Brown Supervisor — review 2 days 01:43:06

Figure B-52: Pall ForteBio GxP Server Configuration Window

Use of the User, Groups, Projects, Constants, and Events tabs are described in “"Accessing
Administrator Options” on page 190.
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ForteBio GxP Server Module Testing

The Pall ForteBio GxP Server module can be tested to ensure it is accessible and functioning
properly? Wasn't sure about this functionality.

To test the Pall ForteBio GxP Server module:

1. Optional. In the Connections to Clients box (Figure B-53), make changes to the server
settings if necessary.

Connection to dients:

[[] Localhost Port: 20002 =
Support UDP ping for discovery

Figure B-53: Connection to Clients

2. Click Apply & Test.

If the Pall ForteBio GxP Server module is found and functioning properly, the following
message displays (Figure B-54):

FBServerConfig - M

!'\ Found server OK

Figure B-54: Message Confirmation of Found Server

To return to the originally configured Pall ForteBio GxP Server module settings, click
Default at any time.
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RESTARTING THE PALL FORTEBIO GXP SERVER MODULE

If the host location of the GxP Server module cannot be found during user login, or if you
are unable to log in with valid credentials, the Pall ForteBio GxP Server module may be
offline and must be restarted.

@ NOTE: ForteBio recommends contacting your IT department to confirm
whether or not network or firewall settings may have been changed. This may
also be preventing access to the Pall ForteBio GxP Server module.

To restart the ForteBio GxP Server module, choose one of the following two options:

- Ifthe Pall ForteBio GxP Server module is installed on a network location—Double-
click the FBServer.exe file in the FBServer folder from the installed location
(Figure B-55).

File Edit View Tools Help

Organize ¥ Include in library = Share with Burn New folder =~ [ e

-
4 ). ForteBio 4 O Name Date modified Type Size

> | DataAcquisition? =
FBServer.exe 12/3/20103:53PM  Application 2,966 KB

> | DataAnalysis7

FBServerConfig.exe 12/3/20103:53 PM  Application 7,821KB
| . FBServer/ =
FBServerMonitor.exe 12/3/20103:54 PM  Application 6,909 KB
#¢ ForteBio 2/10/2011 6:20 PM  Internet Shortcut 1KB
@ Globeico 12/1/20104:21 PM  Icon 25 KB
@ uninstexe 2/10/2011 6:20PM  Application 54 KB

Figure B-55: ForteBio GxP Server Module Installed on a Network Location

« Ifthe GxP Server module is installed on a local computer—Double-click the Restart
Server desktop icon (Figure B-56).

T
[ ] -
ey
Restart
Server

Figure B-56: Restart Server Desktop Icon

The Restart Server console display momentarily as the Pall ForteBio GxP Server module
restarts (Figure B-57).
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Restart Server SHEIE_X_
CMDLINE: Starting service

L /|

Figure B-57: Restart Server Console
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Index

Symbols

fmf files (method files) 80

Numerics

1 to 2 Bivalent Analyte Model 114
2to 1 (HL) Model 114

A

About ForteBio Data Analysis (menu) 18
accessing GxP Server module 206

Add Folders menu 71, 123

Add Level, Advanced Search option 135
Add to Table, Fitting view option 126

adding Replicate Group from the Sample
Plate Table (figure) 47

Additional Graphs, view option 129
administrator constants 202
administrator password, changing 196
Advanced Search dialog box (figure 135
Advanced Search options

Add Level 135

Case Sensitive 135

Column 135

Include Excluded Traces 135
listed 135

Operator 135

Remove Level 135

Search All 135

Search all but keep current selection
(implies OR) 135

Search only current selection (implies
AND) 136

Treat Empty Cells as Match 135

Value 135
Advanced Search tool 134
Advanced Search, display option 133, 134
Affinity constant 132
affinity constant KD 84
alert threshold value, editing 65
Align All Baselines alignment option 92
Align by Begin Point alignment option 92
Align by End Point alignment option 92

Align to Baseline, interstep correction
feature 104

Align to Dissociation, interstep correction
feature 104

Align X viewing option
quantitative analysis 49
aligning

the Y axis (figure) 104
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to association 103
alignment options

Align All Baselines 92

Align by Begin Point 92

Align by End Point 92

All Aligned to One Step 92

Show All Steps Aligned 92

All Aligned to One Step alignment option
92

analysis
excluding samples 41
including samples 41
options, listed 152
Analysis results table (figure) 118
Analysis results table display options
Advanced Search 133, 134
Exclude Wells 62, 134
Include Wells 62, 134
Invert Selection 62, 134
listed 61, 134
Select All Rows 62, 134
Set Color 62, 134
Set Color By 62, 134
Set Color By Group 62, 134
Size Columns by Data 62, 134
Size Columns by Title 62, 134

Analysis Results table shortcut menu
(figure) 133

analysis results, sorting by any category
140

analysis settings
saving 68
specifying 53
Analysis window (figure) 116

Analysis window with sample curve fitting
results (figure) 124

Analyze Data button 72
analyzed data
Binding Rate 61
BR AVG 60
BR CV 60
BR SD 60
Calc. Conc. 61
Concentration avg 60
Concentration CV 60
Concentration SD 60
dilution factor 60
flip 60
Group Type 61
information 60
kinetics analysis
Index (parameter) 131
Lot Number 60
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plate 60

guantitative analysis
Index (parameter) 60

r2 (COD) 61

Replicate Groups 60

Residual 61

Sample ID 61

sensor 60

Sensor Type 60

well concentration 60

Well Information 61

analyzing

binding data 84

binding data (kinetics) 84

binding data (quantitative) 52

entire time duration of selected step
115

equilibrium state data 120
experiments 38
processed kinetic data
curve fittng analysis 114
steady state analysis 119
applications, closing 16
Apply All, Report Point Analysis feature 111
Apply, Report Point Analysis feature 111

applying

reference subtraction during data
processing 98

sample alerts 66
standards alert 65
assigning
different colors to binding curves 137

Replicate Groups in the Sample Plate
Map 45

Replicate Groups in the Sample Plate
Table 47

Assoc. (Sample) Loc., kinetic analysis result
131

Association & dissociation, analysis option
114

Association only, analysis option 114
Association, analysis option 115
Audit Trail

described 31

listing events 32

selecting a project 8

sorting events 32

viewing 31
Auto Scale, Fitting view option 125
Autoplay dialog box 172

Average from, steady state kinetics analysis
option 120

Average Reference Sensors

reference subtraction method (figure)
103
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reference subtraction method,
described 102

Baseline Loc., kinetic analysis result 131
basic kinetics experiment 80
batch analysis, running 122
batch mode
kinetics analysis 120
quantitation analysis 68
batch mode options
kinetics 122
quantitative 71
Table Information, kinetics 123
Use one for all folders
kinetics 122
guantitation 71
Use the one in each folder
kinetics 122
guantitative 71
Use the original data folder 71
Use this folder 71
Well Information
kinetics 122
guantitation 71

batch process data sets with individual .ini
files 121

Binding 1 (nm shift) 112
Binding 2 (nm shift) 112
binding chart
copying 113
including toolbar and data grid 109
printing 113
shortcut menu (figure) 113

viewing in separate window (figure)
108

binding curve chart, opening in a separate
window 51

binding curves

after user-specified reference
subtraction method is used 106

after user-specified Y alignment 106
assigning different colors 137

association steps aligned at the same
time point 106

customizing appearance 51
displaying
all ligand biosensors 125
from each biosensor 125, 127
viewing
quantitative analysis 48
with no reference subtraction 106

binding data
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analyzing (kinetics) 84
analyzing (quantitative) 52
binding data, analyzing 84

Binding Rate Equation, processing
parameter 58

binding rate equations

initial slope 58

R equilibrium 59
Binding Rate, analyzed data 61
binding rates, calculated (figure) 95
binding signal

atTime 1112

atTime2 112
biosensor data, viewing specific 130
biosensor number 60
biosensor types, changing (figure) 97
biosensors

selecting (figure) 96

selecting and confirming to analyze
(figure) 105

selecting for analysis 83
biosensors, selecting 96
BR AVG, analyzed data 60
BR CV, analyzed data 60
BR SD, analyzed data 60
By Color, analysis option 115

By Sensor, analysis option 115

C

Calc. Conc., analyzed data 61
calculated binding rates (figure) 95
calculated response at equilibrium 132
calibration curves 73

Case Sensitive, Advanced Search option
135

Change Password dialog box (figure) 34
Change Password menu 17
Change Project menu 17
Change Well Type menu 97
changing
administrator password 196
biosensor type (figure) 97

color of user-selected results (figure)
137

constants 203

file type available for selection 29

group settings 199

project settings 201

projects during a user session 33

sample designations 85
quantitation analysis 40

sample designations (figure) 40, 85

step type (figure) 83

user account password 196

user account settings 195
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user password 34

Choose Install Location dialog box (figure)
173,175

Choose Start Menu Folder dialog box
(figure) 173,175,180

closing
all experiments 52, 88
application 16
experiment 52, 88
kinetics experiment (figure) 88

selected experiment (left) or all
experiments (right) in the
Quantitation or Kinetics folder
(figure) 52

closing a kinetics experiment (figure) 88
COD (coefficient of determination) 132
coefficient of determination 132
color of the biosensor binding curve 131
Color, kinetic analysis result 131
color-coded analysis results

enabling 62, 134

sorted by color (figure) 140
color-coding

data 137

results by category 138

user-selected results 137
Column, Advanced Search option 135

compliant experiments, generated 28

compliant features for 21 CFR Part 11 27
Conc. (nM), kinetic analysis result 132
Concentration (mM) 112
Concentration avg, analyzed data 60
Concentration CV, analyzed data 60
Concentration SD, analyzed data 60
confirming

biosensors to be analyzed (figure) 105

Reference Well is subtracted from the
sample wells (figure) 99

connecting Octet instrument to computer
14

Connections to Clients box 208
constants
administrator 202
changing 203
creating 203
deleting 204
viewing 203
Constants tab 201
contacting ForteBio technical support 12

contiguous biosensors, selecting (figure)
92

conventions, used in this guide 11

Copy Table to Clipboard, data export option
145

Copy to Clipboard menu 96
copying

Octet System Data Analsyis User Guide



page 217

binding chart 113

sample plate map 96

sensor tray map 96
creating

kinetic Settings_DataAnalysis.ini file
120

kinetic Settings_Tablelnfo.xml file 121
kinetic Settings_Welllnfo.xml file 121
new constant 203
new project 200
new user account 192
new user group 198
Settings_DataAnalysis.ini file 69
curve display, customizing 107
curve fitting analysis 84
curve fitting kinetics analysis options
Fitting-Global (Full) 115
Fitting-Local 115
Model 114

Rmax Unlinked option for Global Fitting
115

Steps to Analyze 114
Curve fitting, kinetic analysis type 114
custom reports 144
customizing

binding curve appearance 51

curve display 107

graph appearance 51
graph display 107
Cycle, kinetic analysis result 61, 133

D

data
excluding from analysis 117
exporting 72

Data Acquisition User Guide, opening
online version 18

Data Acquisition, icon 6
data analysis session, using 38, 80
Data Analysis User Guide (menu) 18
Data Analysis, icon 6, 76, 154
data color, setting by category 139
data export options
Copy Table to Clipboard 145
described 144
Export Fitting Results 145
Export Table to .csv File 145
in the Analysis window (figure) 144
listed 145
Data Options, view option 129
data processing 105
applying reference subtraction 98

reference subtraction methods 99
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Data Selection tab 42
Data Selection tab (figure) 38
Data Selection window

displaying experiment summary
information (figure) 82

editing sample information,
quantitative (figure) 43

example (figure) 69

loading an experiment, kinetics (figure)
81

loading an experiment, quantitative
(figure) 39

opening an experiment (figure) 39
viewing options (table) 49
data viewing options 130
DataAcquisition-CFR-7_0_0_x.exe 172
Define Custom Colors menu 137
defining
Replicate Groups 44
Delete Constant menu 204
deleting
constants 204
project 201
determining
binding rate 61
sample concentration 38

determining the GxP Server module host
location 8, 21, 172,174,179, 204

dilution factor 60

discontiguous biosensors, selecting (figure)
92

display options, viewing shortcut menu of
133

displaying
graphs organized into groups 125
license information 18

Octet System Data Acquisition software
properties 18

selected step data from a kinetic assay
(figure) 94

Dissoc. Loc., kinetic analysis result 132
Dissociation only, analysis option 114
Dissociation, analysis option 115

Do not use alerts, threshold value 65
Dose Response-4PL (Default 55

Dose Response-4PL (Weighted Y) 55
Dose Response-4PL (Weighted Y2) 55
Dose Response-5PL (Default 55

Dose Response-5PL (Unweighted) 55
Dose Response-5PL (Weighted Y) 55
Double Reference

reference subtraction method (figure)
102

reference subtraction method,
described 101
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E

Edit Group window 199
Edit Legends viewing options
quantitative analysis 50

Edit Sample Information dialog box (figure)
45

editing
asearch 136
alert threshold value 65
experiments 85

processing parameters in the Results
window (figure) 44

processing parameters, quantitative 43
standard concentration information 42
well information 42

Electrical hazard symbol 11

electronic signature of method (.fmf) and
data (frd) files 28

ending a user session 35
equilibrium response 84
equilibrium state data, analyzing 120

estimate of the goodness of the curve fit
132

Event Log (figure) 204

events
listed in the Audit Trail 32
sorting in Audit Trail 32

tracking 204
viewing 32, 205
Events tab 204
Events tab (figure) 9
Exclude Wells
display option 62, 134
menu 41
Exclude Wells for Analysis menu 98
excluding
data from analysis 117
sample from subsequent analyses 60

samples from analysis, kinetics (figure)
86

samples from analysis, quantitative 41

samples from analysis, quantitative
(figure) 41

wells from analysis, described 98

wells from the biosensor table (figure)
117

Exit (menu) 16
experiment method file 80
experiment method file, loading 16
experiment summary options 148
experiment, quantitation, described 38
experiments

closing all

kinetics 88
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quantitative 52
closing one
kinetics 88
quantitative 52
editing 85
loading for analysis, kinetics 80
loading for analysis, quantitative 38
Export Aligned Step (.csv files) menu 92
Export button 146

Export File, Report Point Analysis feature
111

Export Fitting Results, data export option
145

Export Table to .csv File, data export option
145

exporting raw data 92

F

FBServer.exe file 209

file type, changing 29

Fit Curves! button 117

Fitting view
grouped option (figure) 130
individual option (figure) 126
stacked option (figure) 125

Fitting view and Residual view, stacked
option (figure) 125

Fitting view options
Add to Table 126
Auto Scale 125
Full Scale 125
Grouped 125
Individual 125
listed 125
Options 125
Refresh 125
Remove All 126
Report Points 125
Stacked 125
Time (sec) 125
Use__Point Average 126
Y Axis Scaling 125
Fitting-Global (Full) options
By Color 115
By Sensor 115

Fitting-Global (Full), curve fitting kinetics
analysis option 115

Fitting-Local options
Full 115
Partial 115

Fitting-Local, curve fitting kinetics analysis
option 115

Flip Data viewing options

guantitative analsys 49
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flip, analyzed data 60

ForteBio GxP Server 7.0.exe 179

ForteBio GxP Server desktop icon 191
ForteBio GxP Server module, accessing 206
ForteBio GxP Server module, installing 178
ForteBio technical support, contacting 12
ForteBio Web Site (menu) 18

Full R2, kinetic analysis result 132

Full Scale, Fitting view option 125

Full X2, kinetic analysis result 132

Full, analysis option 115

Fuse symbol 11

G

generating a report 146
graph display, customizing 107
Graph Options, view option 129
Graph Size in Pixels, view option 129
graph, customizing appearance 51
graphical formats 142
Group Graphs By, view option 129
group settings, viewing 199
Group Type, analyzed data 61
Grouped View options

Additional Graphs 129

Data Options 129

Graph Options 129
Graph Size in Pixels 129
Groups Graphs By 129
Legend by 129

Grouped View Options dialog box (figure)
129

Grouped View viewing options,
quantitative analysis 49

Grouped, Fitting view option 125
grouping data

by color 115

by sensor 115
grouping results for viewing 129
GxP Server module

accessing 206

restarting 209

testing 208

H

Heat/hot symbol 11

Heterogeneous Ligand model 114

icons
Data Acquisition 6
Data Analysis 6, 76, 154
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Ignore error in files option 83

Ignore errors in files when loading viewing
option

quantitative analysis 49

Include Excluded Traces, Advanced Search
option 135

Include Wells

display option 62, 134

menu 41
Include, kinetic analysis result 131
including

sample in subsequent analyses 60

samples from analysis 41
Index (parameter)

working with analyzed data

quantitative analysis 60

Individual, Fitting view option 125
information, analyzed data 60
Initial Slope equation 58

Input times after beginning of Association
Step 111

installing

Data Acquisition 7.0 21 CFR Part 11
software 172

Data Analysis 21 7.0 CFR Part 11
software 174

ForteBio GxP Server 179

ForteBio GxP Server module 178

interstep correction features

Align to Baseline 104

Align to Dissociation 104
Invert Selection, display option 62, 134
Iso-Affinity graph

described 143

Xand Y axis (figure) 143

K

KD (M), kinetic analysis result 132
kdis (1/s), kinetic analysis result 132
kdis Error, kinetic analysis result 132
kinetic analysis results

Assoc. (Sample) Loc. 131

Baseline Loc. 131

Color 131

Conc (nM). 132

Cycle 61,133

Dissoc. Loc. 132

FullR2 132

Full X2 132

Include 131

Index (parameter)

working with analyzed data

kinetics analysis 131
KD (M) 132
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kdis (1/s) 132

kdis Error 132

km 132

km error 132

kobs (1/s) 132

kon (1/Ms) 132

kon Error 132

Loading Well Location 133
Report point #1-10 132
Reg/Rmax (%) 132
Response 132

Rmax 132

Rmax Error 132
SampleID. 132

Sensor Info 131

Sensor Location 131
Sensor Type 131
SSGKD 133

table, listed 131

kinetic analysis types

Curve fitting 114
Steady state analysis 114

processing 95

kinetic Settings_DataAnalysis.ini file,
creating 120

kinetic Settings_Tablelnfo.xml file, creating
121

kinetic Settings_Wellinfo.xml file, creating
121

kinetics analysis mode, returning to 95
kinetics analysis results 124
Kinetics Batch Mode (menu) 16

Kinetics Batch Mode—Quantitation Batch
Mode dialog box (figure) 122

kinetics experiment

closing 88

starting 80
km error, kinetic analysis result 132
km, kinetic analysis result 132
Known Conc. 61
kobs (1/s), kinetic analysis result 132
kon (1/Ms), kinetic analysis result 132

kon Error, kinetic analysis result 132

L

kinetic assay, displaying selected step
(figure) 94 launching Octet System Data Acquisition

kinetic constants 84 software 14

kinetic data Legend by, view option 129

analyzing 114 license information, displaying 18
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ligand biosensor location 111
ligand biosensors, defined 95
Linear Point to Point 55
list options 205
Loaded Data Directory Tree 39
Loaded Data directory tree 80
loading
experiment for analysis 80
experiment method file 16

Loading Well Location, kinetic analysis
result 133

location

of the biosensor in the sensor tray map
131

of the sample well used during the load
step of the experiment 133

Lock Application menu 17
locking a user session 34
Logoff menu 17

Lot Number, analyzed data 60

Low concentration threshold, processing
parameters

Quantitative Analysis 43

M

Mass Transport 114

mass transport rate constant 132

matching search term with searchable text
135

mathematical model, generates fitted view
114

Max Residual, threshold value 65

measure of the goodness of curve fitting
132

menu bar, Octet System Data Acquisition
software 15

menu commands, listed 16
method files
generated 28
opening 80
Min Sample r2, threshold value 65
Model options
1to1114
1 to 2 Bivalent Analyte Model 114
2to 1 (HL) Model 114
Mass Transport 114

Model, curve fitting kinetics analysis option
114

modified parameters, saving
quantitative analysis 43

molar concentration of the sample used in
the association step 132

multiple kinetic data sets, processing 120

multiple quantitation data sets, processing

68
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N

New Group window 198

New Project window 200
non-equivalent surface capacity 115
non-specific binding of sample 100

number of biosensor regeneration cycles
61,133

numbered order of the curves processed
131

(0

observed binding rate 132
Octet instrument labels 11

Octet instrument to computer, connecting
14

Octet System Data Acquisition software
launching 14
main toolbar 15

Octet system, described 6

opening

binding curve chart in a separate
window

guantitative 51
Kinetics Batch Mode 16
online Data Acquisition User Guide 18

Quantitation Batch Mode 16

web browser 18
Operator, Advanced Search option 135
Options (menu) 16
options for viewing results 107

Options, Fitting view option 125

P

Parallel Reference Sensors
reference subtraction method
(figure) 101
described 100
Partial, analysis option 115
plate number 60

preparing samples for quantitation or
kinetics experiments 6

printing binding chart 113
Process Data! button 105
processed data

in the sensor summary view (figure)
110

saving 112
processing

data 105

kinetic data 95

options, listed 149

processing parameters
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editing 43

editing in the Results window (figure)
44

Quantitative Analysis
Low concentration threshold 43
Read time 43
Zero concentration threshold 43
Processing window
described 95
Raw Data view selected (figure) 90

Raw Data view, displaying data from a
single selected biosensor (figure) 91

Raw Data view, quantitating a selected
step (figure) 93

project administration 200
project settings
changing 201
viewing 201
projects
changing during a user session 33
creating new 200
deleting 201
Projects tab 200

properties, for Octet System software,
displaying 18

Q

Quantatition Batch Mode, opening 16
Quantitate Selected Step menu 92
quantitating raw data
for a selected step (figure) 93
from a selected step, described 92

Quantitation Batch Mode dialog box
(figure) 71

Quantitation Batch Mode menu 70
quantitation experiment, described 38
quantitation results report, saving 73

quantitation results reports, exporting data
72

Quantitation window, displaying selected
step data from a kinetic assay (figure) 94

R

R equilibrium
binding rate equation 59

steady state kinetics analysis option
119

r2 (COD), analyzed data 61
r2 of the curve fit 61

rate of association 132
rate of dissociation 132

ratio of Req to Rmax 132
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raw data
exporting 72, 92
saving 72
viewing 89
Raw Data view 89
Read time, processing parameters
Quantitative Analysis 43
reference biosensors
defined 95
specifying 96
reference buffer wells, defined 95

Reference subtraction average of methods
(figure) 54

Reference Subtraction Average of viewing
option

quantitative analysis 49
reference subtraction methods

Average Reference Sensors 102

Double Reference 101

Double Reference (figure) 102

for data processing 99

Parallel Reference Sensor (figure) 101

Parallel Reference Sensors 100

Reference Wells 99

Reference Wells (figure) 100
Reference Subtraction option 49

Reference Subtraction options

quantitative analysis
All 49
Column 49
Row 49

reference subtraction, applying during data
processing 98

Reference Well menu 97

Reference Wells
confirming subtraction (figure) 99
reference subtraction method 99

reference subtraction method (figure)
100

specifying (figure) 98
Refresh, Fitting view option 125
Remove All, Fitting view option 126

Remove Level, Advanced Search option
135

removing all kinetics experiments from
processing (figure) 89

Replicate Groups
adding from the Sample Plate Table 47
analyzed data 60
assigning in the Sample Plate Map 45
assigning in the Sample Plate Table 47
defining 44

Replicate Groups displayed
in Sample Plate Map (figure) 46
in Sample Plate Table (figure) 47

Octet System Data Analsyis User Guide



page 228

replicates 55
report data types

analysis options, kinetics analysis
results (figure) 153

Experiment Summary options (figure)
149

Processing options
processed data (figure) 151

raw data and aligned data (figure)
150

Report Point analysis (figure) 152

sensor tray and sample tray infor-
mation (figure) 150

Report point #1-10, kinetic analysis result
132

Report Point Analysis features
Apply 111
Apply All 111
Export File 111
in the Analysis window 110

Input times after beginning of
Association Step 111

listed 111

Use 20 point average 111
Report Point Analysis table 110
Report Points

Add to Table 126

Fitting view option 125

Remove All 126

Time (sec) 125

Use__Point Average 126
Report Points view

described 110

processed results (figure) 111
Report Selection form (figure) 147
reports

generating 146

saving 16
Reg/Rmax(%), kinetic analysis result 132
Residual view

individual option (figure) 126

stacked option (figure) 125
Residual, analyzed data 61

response calculated from the time window
entered in the Steady State Analysis
section 132

response maximum, calculating 115
Response, kinetic analysis result 132

Response, steady state kinetics analysis
option 119

Restart Server console (figure) 210

Restart Server desktop icon (figure) 209
restarting ForteBio GxP Server module 209
results

color-coding by category 138
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grouping 129

table, described 61

viewing options 107
Results table

searching contents 136
Results window

for a quantitation experiment (figure)

59

showing standards sample alerts
(figure) 66

with calculated binding rates (figure)

95
returning
to kinetics analysis mode 95

to the originally configured ForteBio
GxP Server module settings 208

Rmax

defined 115

kinetic analysis result 132
Rmax Error, kinetic analysis result 132
Rmax unlinked 115

Rmax Unlinked option for Global Fitting,
curve fitting kinetics analysis option 115

running
batch kinetics analysis 122
batch quantitative analysis 70

S

Sample Alert
described 66
threshold value 65
sample alerts, applying 66
sample concentration
computed from the standard curve 61
defined 112
determining 38
sample designations
changing
kinetics analysis 85
quantatitative analysis 40
sampleID 111
sample ID entered during assay setup 132
Sample ID, analyzed data 61
Sample ID, kinetic analysis result 132
sample location 111
sample plate map
copying 96
defined 61
sample tray map, using 96

sample well location in the sample plate
131

Save All Method Files (menu) 16

Save Analysis Settings menu 70
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Save Data Analysis Parameters button—
Analysis window (figure) 119

Save Report menu 146
Save Results options 113
saving
all reports 16
analysis results

for each biosensor to a separate
text file 145

for selected biosensors to system
clipboard 145

analysis settings 68
binding data

for each biosensor to a separate
text file 145

for selected biosensors to system
clipboard 145

processed data 112

processing parameters 112

quantitation results report 73

raw data 72, 112

results 112

results options 113

results table to a .csv file 145

standards data 68
Savitzky-Golay filtering 105
scatter plot 142

Search all but keep current selection
(implies OR), Advanced Search option
135

Search All, Advanced Search option 135

Search only current selection (implies AND),
Advanced Search option 136

search result, defined 134
search term for a single level 135
search, editinga 136
searching contents of the Results table 136
Security menu 17
Security menu commands, listed 17
Select All Rows, display option 62, 134
selecting
adjacent rows, for viewing data 130

analysis results for viewing in the
Fitting view and Residual view
(figure) 131

biosensors 96
biosensors for analysis (figure) 84
biosensors for the analysis 83

biosensors in the Processing window
(figure) 96

biosensors to be analyzed (figure) 105

contiguous and discontiguous
biosensors in the Sensor location list
(figure) 92

experiments and run the batch analysis
122
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experiments and running the batch
analysis 70

experiments for batch analysis (figure)
72

non-adjacent rows or wells
quantitative analysis 48

non-adjacent rows, for viewing data
130

project in the Audit Trail 8

sample wells or rows to display in the
binding curve graph

quantitative analysis (figure) 48
server location 22
standard curve equation 55
Sensor Info, kinetic analysis result 131
Sensor Location, kinetic analysis result 131
sensor summaries (figure) 151
Sensor Summary view
defined 109
displayed (figure) 110
features 109
sensor tray map
copying 96
using 96
Sensor Tray tab 83
Sensor Type
analyzed data 60

kinetic analysis result 131

sensor, analyzed data 60
Sensors to be Analyzed box 98
Server Administration menu 17
server location, selecting 22
Set Color By Group, display option 62, 134
Set Color By, display option 62, 134
Set Color menu 137
Set Color, display option 62, 134
Set Well Data dialog box (figure) 45
setting

data color by category 139

setting up administrator account,
administrator account, setting up 182

Settings_DataAnalysis.ini file, creating 69
Settings_DataAnalysis.xml file 120
Settings_Welllnfo.xml 120
Settings_Welllnfo.xml file 71

shortcut menu of display options, viewing
133

Show All Steps Aligned alignment option
92

Show All Traces viewing options
guantitative analsys 49

Size Columns by Data, display option 62,
134

Size Columns by Title, display option 62,
134

sorting
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analysis results by any category 140
Audit Trail events 32

results table entries in ascending order
62

results table entries in descending
order 62, 141

specifying

analysis settings 53

reference biosensors 96

Reference Wells (figure) 98
SSG KD, kinetic analysis result 133
Stacked, Fitting view option 125

standard concentration information,
editing 42

standard curve equation, selecting 55
standard error of Rmax 132

standard error of the mass transport rate
constant 132

standard error of the rate of association 132

standard error of the rate of dissociation
132

standards alert, applying 65
standards data, saving 68
starting
basic kinetics experiment 80
user session 25
steady state analysis 84
Steady State Analysis graph

described 144
displayed (figure) 144

Steady state analysis, kinetic analysis type
114

steady state kinetics analysis options 119
Average from 120
R equilibrium 119
Response 119

Steps to Analyze, curve fitting kinetics
analysis option 114

Subtraction check box 98
sum of squared deviations 132
symbols
electrical hazard 11
fuse 11
heat/hot 11
system artifacts 100
system drift 99

T
Table Information, batch mode option,
kinetics 123
technical support, contacting 12
testing, ForteBio GxP Server module 208
threshold values
Do not use alerts 65

Max Residual 65
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Min Sample r2 65
Sample Alert 65
Time (sec), Fitting view option 125
Time 1 (sec) 112
Time 2 (sec) 112
time range

of the association step data to analyze
115

of the dissociation step data to analyze
115

time, at which the first binding
measurement is acquired 112

toggling sample analysis in the Results
window 41, 85

Treat Empty Cells as Match, Advanced
Search option 135

types of report data included by the
Processing options (figure) 153

U

Unweighted) 55

Use "Included” Traces Only check box 129

Use 20 point average 111

Use Entire Step Times, analysis option 115

Use one for all folders, batch mode option
kinetics 122

guantitation 71

Use the one in each folder, batch mode
option

kinetics 122
quantitative 71

Use the original data folder, batch mode
option 71

Use this folder, batch mode option 71

Use__Point Average, Fitting view option
126

user account
creating 192
user account password, changing 196
user account settings
changing 195
viewing 195
user group
creating new 198
user password, changing 34
user session
changing projects during 33
ending 35
locking 34
starting 25

user-selected results, changing color
(figure) 137

user-specified
ligand biosensor information 111

notes, about the wells 61
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standard concentration 61
using

data analysis session 38

sample tray map 96

sensor tray map 96

Vv

Value, Advanced Search option 135

Verify Digital Signature dialog box (figure)
28

Verify Document menu 17
View Audit Trail menu 17
viewing
Audit Trail 31
binding curves
quantitative analysis 48
constants 203

events for a specific project or
computer 7, 32

events for a specific user account,
project or computer 205

group settings 199

project settings 201

raw data 89

results, options 107

shortcut menu of display options 133

specific biosensor data 130

user account settings 195
viewing options
in the Data Selection window (table) 49
quantitative analysis
Align X 49
Edit Legends 50
Flip Data 49
Grouped View 49

Ignore errors in files when loading

49

in the Data Selection window (ta-
ble) 49

Reference Subtraction Average of
49

Show All Traces 49
selecting data 130

W

web browser, opening 18

Weighted Y2) 55

well concentration 60

well designation 61

Well Information
analyzed data 61
batch mode option

kinetics 122

quantitation 71
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editing 42
well location
in the sample plate 60

in the sample plate or reagent plate
132

wells, excluding from analysis 98

Window of Interest (From Start of Step),
analysis option 115

X

X-Y graph
described 142
displayed (figure) 142

Y

Y Axis Scaling
Auto Scale 125
Fitting view option 125
Full Scale 125

Y axis, aligning (figure) 104

y 4

Zero concentration threshold, processing
parameters

Quantitative Analysis 43
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